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Chapter 1. Introduction

Overview of Sterling Warehouse Management System
The Sterling Warehouse Management System helps you manage operations in
mid-sized Finished Goods distribution centers (DCs). Shipments may be shipped to
consumers, retailers or distributors, or mom- and pop- stores.

To aid warehouse managers who are responsible for tracking inventory, and
inbound, outbound, and other operations in the warehouse, Sterling Warehouse
Management System provides the capability to generate many reports. Access to
these reports is controlled, based on the group to which the user belongs.

The Sterling Warehouse Management System reports can also be used by
enterprise users for tracking inventory across nodes. These reports aid enterprise
users in better decision making by providing complete visibility to the inventory
across all the nodes.

Sterling Warehouse Management System integrates reports with the Application
Console user interface. The dynamic menus of this user interface enable you to
access reports from the appropriate consoles. The reports displayed in the menu
are based upon your user group. For example, you can view the Order Billing
Report and the Shipment Billing Report in your menu only if you belong to the
group representing warehouse managers. Data security is maintained in the reports
by allowing only users with appropriate permissions to access the information.

Once you navigate to the criteria screen of a specific report, you can enter the
criteria for generating the report into the criteria screen. Based upon this criteria,
Sterling Warehouse Management System displays the appropriate report.

Sterling Warehouse Management System also enables you to save reports as
favorites. These reports are available to you as links in the Favorites area of your
Home page. Click the link to a particular report to view the criteria screen for that
reports. Click Generate Report to view the report.

Integrating with Cognos 8 BI 8.4
Sterling Warehouse Management System integrates with Cognos 8 BI 8.4 to
generate reports. The report criteria is entered in the Application Console and
posted to the Cognos URL. This provides the flexibility to control the reports based
on your user group permissions.

Users

Users are set up in Sterling Warehouse Management System and need not be set
up separately in Cognos 8 BI 8.4.

Reports can be accessed by Sterling Warehouse Management System console users.
You can access only those reports for which your user groups have permission.

For more information about defining Users and User Groups, see the Selling and
Fulfillment Foundation: Application Platform Configuration Guide.

© Copyright IBM Corp. 2005, 2012 1



User Groups

User groups are a collection of users who perform similar tasks. For example, a
group of inventory supervisors might be put in an Inventory Supervisor user
group. Users can belong to multiple user groups. These user groups are assigned
permissions that applicable to all users in the user group.

Each organization has its own user groups. User groups can only contain users for
the same organization for which the user was created, except in the case of a user
group created by the Hub organization, which can contain users of any
organization.

For more information about defining Users and User Groups see the Sterling Selling
and Fulfillment Foundation: Application Platform Configuration Guide.

Dynamic Menus

Integrating with Cognos 8 BI 8.4 enables Sterling Warehouse Management System
to provide data to the user interface for generating reports. Dynamic menus enable
users to access reports from the appropriate consoles. The reports displayed in
these menus are based upon the user group to which the user belongs.

For example, let us consider the differences in the menu displayed to users
belonging to the group representing inventory supervisors and the menu displayed
to users belonging to the group representing shipping supervisors:
v Users belonging to the group representing shipping supervisors can view the

Alerts, Inventory, Outbound, Task, and Configuration options in their menu,
whereas users belonging to the group representing inventory supervisors can
view the Alerts, Inventory, Task, VAS, and Configuration options in their menu.

v Users belonging to the group representing shipping supervisors can, view all the
Outbound Reports under their Outbound menu, whereas users belonging to the
group representing inventory supervisors cannot even view the Outbound menu
option.
The following figure displays the menu bar that is available to users belonging
to the group representing shipping supervisors.
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The following figure displays the menu bar and Inventory reports that is
available to users belonging to the group representing inventory supervisors.

Figure 1. Outbound Menu Options for Shipping Supervisors
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v Users belonging to the group representing shipping supervisors can view only
the Dedicated Locations Report, Item Tag Number Report, and Participant List
Report under their Inventory menu, whereas users belonging to the group
representing inventory supervisors can view all the Inventory Reports under
their Inventory menu.
The following figure displays the Inventory reports that is available to users
belonging to the group representing shipping supervisors.

Permissions to User Groups
Permissions are assigned to user groups. These permissions apply to all users in
that user group. You can administer the permissions that a user group has
throughout the Application Consoles and Applications Manager applications.

You can allow or disallow permissions for the reports that are displayed to various
user groups. For example, Inventory supervisors may have access to all Inventory

Figure 2. Inventory Menu Options for Inventory Supervisors

Figure 3. Inventory Menu Options for Shipping Supervisors

4 Sterling Warehouse Management System: Reports Guide



Reports, but may not have access to Outbound Reports. Shipping Supervisors may
access all Outbound Reports, but may have only limited access to Inventory
Reports.

A user who belongs to multiple user groups retains the least restrictive set of
permissions defined by the groups to which they belong. For example, if a user
belongs to a user group that permits them to access the Inventory Reports and
they also belong to a user group that only permits them to access the Outbound
Reports, the user has access to both Inventory and Outbound Reports.

For more information about administering user group permissions, see the Sterling
Selling and Fulfillment Foundation: Application Platform Configuration Guide.

The following table specifies reports that the enterprise users can access.

Module
Report

Order

Container Volume Monthly Report

Order Cycle Time Report

On Time Shipment Report

Order Billing Summary Report

Shipment Billing Summary Report

Inventory

Inventory Balance Report

Item Inventory across Nodes Report

Node Inventory Valuation Report

Cycle Count Variance Daily Report

Cycle Count Variance Weekly Report

Cycle Count Variance Monthly Report

Participant List Report

Supply

Order Billing Summary Report
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Shipment Billing Summary Report

Reverse Logistics

Returns by Reason Code Report

The following table specifies reports that the various warehouse users can access.

Table 1. Reports for Warehouse User Groups

Module Report
Warehouse
Manager

Inbound
Supervisor

Inventory
Supervisor

Outbound
Supervisor

Inbound Dock to Stock
Cycle Time KPI
Report

Y Y N N

Await Material
Report

Y Y N N

Inbound Labor
Requirements
Report

Y Y N N

Item Attribute
Setup Report

Y Y N N

Receipt
Discrepancy
Report

Y Y N N

Receipt Detail
Report

Y Y N N

Receipt Summary
Report

Y Y N N

Shipment Billing
Summary Report

Y Y N N

Returns Returns by Reason
Code Report

Y Y N N

Inventory Inventory Aging
Report

Y N Y N

Inventory Audit
Report

Y N Y N

Inventory Balance
Report

Y N Y N

Inventory Hold
Report

Y N Y N

Node Inventory
Valuation Report

Y N Y N

Location Inventory
Detail Report

Y N Y N

Location Inventory
Summary Report

Y N Y N

Item Inventory
Report

Y N Y N

Container Not
Having Standard
Quantity Report

Y N Y N
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Table 1. Reports for Warehouse User Groups (continued)

Module Report
Warehouse
Manager

Inbound
Supervisor

Inventory
Supervisor

Outbound
Supervisor

Cycle Count
Variance Daily
Report

Y N Y N

Cycle Count
Variance Weekly
Report

Y N Y N

Cycle Count
Variance Monthly
Report

Y N Y N

Inventory Dedicated
Locations Usage
Report

Y Y Y Y

Dedicated
Locations Activity
Report

Y Y Y Y

Item Tag Number
Report

Y Y Y Y

Item Velocity
Report

Y N Y N

Location/SKU
Velocity Mismatch
Report

Y N Y N

Participants List
Report

Y Y Y Y

Space
Consolidation
Report

Y N Y N

Space Utilization
Report

Y N Y N

Empty Location
report

Y N Y N

VAS Work Orders
Report

Y N Y N

Outbound Container Volume
Monthly Report

Y N N Y

Order Cycle Time
KPI Report

Y N N Y

On Time Shipment
Report

Y N N Y

Daily Shipment
Report

Y N N Y

Generic Shipper
Report

Y N N Y

Same Day Pick
Pack Ship
Percentage Report

Y N N Y

Outbound Pack and Hold
Shipment Report

Y N N Y
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Table 1. Reports for Warehouse User Groups (continued)

Module Report
Warehouse
Manager

Inbound
Supervisor

Inventory
Supervisor

Outbound
Supervisor

Order Shipment
Report

Y N N Y

Outbound Labor
Requirements
Report

Y N N Y

Hot Inventory
Report

Y N N Y

Replenishment
Status Report

Y N Y Y

Parcel Manifest
Report

Y N N Y

BOL Total Weights
Report

Y N N Y

Shipment Billing
Summary Report

Y N Y Y

Shipment Fill Rate
Monthly Report

Y N Y Y

Shipment Shortage
Report

Y N N Y

Shipments Near /
Past Cancel Date

Y N N Y

Staging Locations
Report

Y N N Y

Tasks In-Progress
Shipment
Summary Report

Y Y Y Y

In-Progress
Container
Summary Report

Y Y Y Y

Warehouse Activity
Completion Report

Y Y Y Y

User Productivity
Daily Report

Y Y Y Y

User Productivity
Weekly Report

Y Y Y Y

User Productivity
Monthly Report

Y Y Y Y

Data Security
Users have restricted access to a specific set of enterprises based on the Data
Security Group to which they belong. Sterling Warehouse Management System
maintains data security in reports by allowing users to access enterprise-specific
information in reports only if they belong to the Data Security Group for that
enterprise.
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The following figure illustrates the Inventory Balance Report criteria screen for
user E1. User E1 is restricted to access information pertinent to enterprise E1 only.
Hence, user E1 is not provided with a drop-down list of enterprises from which to
search.

Also, because user E1 is restricted to access information pertinent to enterprise E1
only, even when user E1 selects Across Enterprises, the search results only display
information pertinent to enterprise E1.

The following figure illustrates the Inventory Balance Report criteria screen for
user dc1mgr. User dc1mgr is a node user who participates in enterprises DEFAULT
and E1. Hence, user dc1mgr is provided with a drop-down list of these enterprises
from which to choose the appropriate enterprise.

Also, because user dc1mgr is restricted to access information pertinent to
enterprises DEFAULT and E1, when user dc1mgr selects Across Enterprises, the
search results display information pertinent to both DEFAULT and E1.

Figure 4. Inventory Balance Report Criteria Screen for Enterprise Users Restricted to Enterprise E1
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For more information about defining Data Security Groups, see the Sterling Selling
and Fulfillment Foundation: Application Platform Configuration Guide.

Advantages of Cognos 8 BI 8.4
There are various advantages to integrating with Cognos 8 BI 8.4 for generating
reports. Some of these are:
v Lower costs—reduces maintenance due to complete report coverage and a

zero-footprint environment.
v Faster results—shortens reporting time due to seamless integration and adaptive

authoring.
v Improved decision making—reports and dashboards present data in

easily-understood formats.
v Adaptive authoring automatically adjusts report layout when objects are added,

moved, or removed.
v Ability to work with data using familiar business terms.
v Ability to use a variety of charts—crosstabs, bar or 3D bar, pie or doughnut, line,

gauge, funnel, scatter, dot density, waterfall, and so forth.
v Ability to create complex, multi-page layouts using different data sources.
v High performance data access across all sources.
v Complete connectivity regardless of environment.
v Open architecture that leverages XML, SOAP, and WSDL.
v Multiple export formats—Excel, Portable Document Format (PDF), Extensible

Markup Language (XML), Hypertext Markup Language (HTML), and Comma
Separated Value (CSV).

v Multilingual capabilities automatically deliver reports in the users' working
language.

v Ability to integrate seamlessly with the Selling and Fulfillment Foundation,
without the user having to log in to the application again.

Figure 5. Inventory Balance Report Criteria Screen for Node Users Participating in DEFAULT and E1
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Report Body Layout
The Sterling Warehouse Management System reports consist of various sections.
Depending upon the number of rows, reports may span across multiple pages. In
the case of multi-page reports, the header and criteria information appear on the
first page only and are not repeated on subsequent pages.

This topic describes the layout of a report in Sterling Warehouse Management
System.

Figure 6. Report Body Layout
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Figure 7. Detailed Report
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Report Header

The report header displays the date on which the report is generated, the time on
which the report is generated, and the report title.

The report header is printed only on the first page for each report and is not
repeated on the subsequent pages.

User Information

This area displays the information of the user.

The user information is printed only on the first page for each report, and is not
repeated on the subsequent pages.

Node User

In the case of a node user, this area displays the user ID, user name, warehouse ID,
and warehouse name.

Enterprise User

In the case of an enterprise user, this area displays the user ID, user name,
enterprise ID, and enterprise name.

Search Parameters

This area displays the search parameters entered by the user.

The search parameter is printed only on the first page for each report and is not
repeated on the subsequent pages.

Figure 8. User Information for Node User

Figure 9. User Information for Enterprise User
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Page Break Criteria

This area displays the criteria for the page break. Based upon this criteria, the
report is printed on a new page. For example, if the page break criteria is
enterprise, the report is printed on a new page for each new enterprise.

Note: The report displays only those enterprises that have some data.

The page break criteria is printed only once for each occurrence of the criteria and
is not repeated in the subsequent pages of the report for the same criteria. For
example, for enterprise E1, the page break criteria E1 is printed once at the top of
the table that contains the information for E1. If this table spans across multiple
pages, the page break criteria E1 is not printed on the subsequent pages. However,
if the information for enterprise E2 is also printed in the same report, the table
containing this information is printed on a new page and is preceded by the page
break criteria E2.

Report Data

This area displays the requested report information, in a tabular format.

In any column, if a value repeats consecutively for more than one row, the value is
printed only once and is not repeated for each of the successive rows in which the
column value is the same.

Group Totals

This area displays the totals for a group. For example, in the figure, this area
displays the totals for enterprise E1.

Summary Totals

This area displays a summary of the totals for all groups.

Links to Detailed Reports

These links enable you to view detailed reports. These links are typically present
for reports that contain summarized information. Click these links to view detailed
reports that provide more information about a particular aspect of the main report.

For example, in Figure 1–6, clicking the link in the No. of Outbound Orderlines
column displays the Outbound Order Lines Billing Detail Report (Figure 1–7),
which provides detailed information about the outbound orders and their order
lines.

Cognos 8 BI 8.4 Toolbar
This section describes the Cognos 8 BI 8.4 toolbar that appears in a Sterling
Warehouse Management System report.
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The Cognos 8 BI 8.4 toolbar that appears in a Sterling Warehouse Management
System report contains the following icons:
v View in HTML format

Click the View in HTML format icon to view the report in Hypertext
Markup Language format.
The Sterling Warehouse Management System reports are displayed in HTML
format by default.

v View in PDF format

Click the View in PDF format icon to view the report in Portable Document
Format.

Note: The Cognos Toolbar is displayed in the reports that are generated using

the Sterling Warehouse Management System. However, you can use only the
button in the toolbar.

Customize the Cognos 8 BI 8.4 Toolbar
The default Cognos 8 BI 8.4 toolbar provides multiple icons.

Figure 10. Cognos 8 BI 8.4 Toolbar
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About this task

You can customize the Cognos 8 BI 8.4 toolbar to hide icons that are currently
visible or to view icons that have been hidden.

Procedure
1. Open the file <YNW_ANALYTICS_HOME>/Custom/custom_system.xml

2. To hide the icon, uncomment the relevant instruction. To display the icon,
comment the relevant instruction. For example:

Results

v To hide the View in PDF format icon , uncomment the instruction
<RV_TOOLBAR_BUTTONS_PDF/>

v To view the Send Report as Email icon , comment the instruction
<RV_TOOLBAR_BUTTONS_Send />

Change the View Option for Drill-Through Reports
In the Sterling Warehouse Management System, it is not possible to navigate from
a drill-through report to the parent report.

About this task

However, Cognos enables you to configure the drill-through reports to open in a
new window when accessed through the Sterling Warehouse Management System.

Perform the following steps to open a drill-through report in a new window:

Procedure
1. Launch Report Studio from the Cognos console.
2. The Report Studio window is displayed with a list of reports. Click a report.

The corresponding report is displayed in the work area. Right-click the data
item in the report that you want to open in a new window and select
Drill-Through Definitions.

Figure 11. Default Cognos 8 BI 8.4 Toolbar
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3. In the Drill-Through Definitions window that is displayed, select the Open in
new window check box, and click Save.

Results

After this configuration is performed, it is possible to open a drill-through report
in a new window.

For detailed information about accessing the Cognos Console and performing the
subsequent steps, refer to ug_cr_rptstd.pdf.

Billing Activity Reporting Engine Reports
The Billing Activity Reporting Engine aids warehouse managers to view
information about the various activities performed in the warehouse.

Billing Activity Report is the billing activity reporting engine report provided with
the Sterling Warehouse Management System. The Billing Activity Report shows the
billable activities performed in the warehouse for an Enterprise, as captured by the
Billing Activity Reporting Engine.

Inbound Reports
Inbound reports provide visibility to receipts. These reports help receiving
supervisors to plan receipts and labor requirements for receipts, as well as to
manage discrepancies. The warehouse manager can also see information on
receipts that are expected shortly, so as to make the dock doors available for these
receipts.

For more information about inbound reports, see "Inbound Reports".

The inbound reports provided with Sterling Warehouse Management System are:
v Await Material Report

This report shows the summary of the items that are waiting for material. This
report helps the warehouse manager to identify items that are unavailable and
to prioritize inbound shipments that can reduce the awaiting items in this
report.

v Dock to Stock Cycle Time KPI Report
This report is used to measure the Dock to Stock cycle time on all inbound
shipments or receipts. Cycle time is defined as the time that elapses from the
start of the receipt to the time that Putaway is completed.

v Inbound Labor Requirements Report
This report is used to determine labor requirements for receiving activities. The
labor required is calculated based on the Standard Allowable Minutes defined.

v Item Attribute Setup Report
This report lists all items in the warehouse that do not have their attributes
completely defined. This report is useful to identify items that have incomplete
setup, as this information is required to execute warehouse operations.

v Receipt Discrepancy Report
This report is used to track the receipt discrepancy details between the expected
and received quantities for a particular day or date range. The report displays
the discrepancy as Short Receipt, Over Receipt, or Damaged.

v Receipt Detail Report
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This report lists the details of the shipments received for the selected shipment,
Purchase Order (PO), or date range. It provides details at the item and quantity
level.

v Receipt Summary Report
This report lists the receipts for the selected shipment, PO, or date range. It
provides summary receipt information at the shipment level.

v Shipment Billing Summary Report
This report displays the number of shipments and shipment lines shipped, and
the number of receipts and receipt lines received. This report also provides the
transaction details for the transactions in the details report.

v Vendor Non-Compliance Report
The Vendor Non-Compliance Report displays the non-compliant shipments
observed during the inbound process. This report helps the warehouse to
identify the vendors shipping non-compliant shipments.

Returns Reports
Returns reports help warehouse managers to view information about inventory
returns.

For more information about returns reports, see "Returns Reports".

Returns By Reason Code Report is the returns report provided with the Sterling
Warehouse Management System. This report lists all shipments based on the return
reason code entered during the return process. This report can also be generated
for specific selected reason codes.

Inventory Reports
Inventory reports help inventory supervisors to manage inventory, track the
movement of inventory within the warehouse, and get visibility on the different
categories of inventory, such as, inventory that are on hold. These reports can also
be used to categorize inventory based on cost.

Note: The Search consoles of all the reports under the Inventory menu display
inventory organizations in the Enterprise drop-down list.

For more information about inventory reports, see "Inventory Reports".

The inventory reports provided with Sterling Warehouse Management System are:
v Containers Not Having Standard Quantity Report

This report lists all cartons stored in the warehouse that have less than the
standard case or pallet quantity. This report can be used to identify
opportunities for consolidation.

v Cycle Count Variance Daily Report
This report provides the cycle count variance information, on a daily basis, for a
given date range.

v Cycle Count Variance Monthly Report
This report provides the cycle count variance information, on a monthly basis,
for a given date range.

v Cycle Count Variance Weekly Report
This report provides the cycle count variance information, on a weekly basis, for
a given date range.
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v Dedicated Locations Usage Report
This report provides visibility into locations that are dedicated to certain Stock
Keeping Units (SKUs). This usage report shows locations that have remained
unused in various time buckets.

v Dedicated Locations Activity Report
This report provides visibility into locations that are dedicated to certain Stock
Keeping Units (SKUs). The activity report categorizes the locations based on the
number of times the location is replenished.

v Empty Location Report
This report provides a list of empty locations in the warehouse. This report can
also be accessed as a sub-report of the Space Consolidation Report.

v Inventory Aging Report
This report provides the inventory age identified by its receipt date. In case the
receipt date information is lost, the inventory age cannot be ascertained and is
therefore classified as "Inventory with Unknown Age".

v Inventory Audit Report
This report is used to track inventory changes resulting from the execution of
tasks in the warehouse. This report can help in tracking changes to item or
location inventory, inventory changes done by a user, or a combination of these.

v Inventory Balance Report
This report is used to balance the opening and closing quantity of inventory for
an item within a date range.

v Inventory Hold Report
This report lists the item and location details for all items that are on hold due
to Quality Control activities, Count variances, and locations that are frozen for
Picking or Putaway.

v Item Inventory Across Nodes Report
This report is used to track the inventory of items across nodes for either all or
selected enterprises. The report can be generated only for those enterprises to
which the user has access.

v Item Inventory Report
This report lists the details of the item inventory at the node. You can drill down
to location level and container level reports from this report.

v Item Tag No. Report
This report lists all item transactions for the given tag number. The report
displays the transactions in three categories: Inbound, Inventory, and Outbound.

v Item Velocity Report
Due to changes in demand, seasonal variations, and product life cycle
characteristics, item velocity changes over time. This report captures the item
velocity, as measured by the number of shipments that the item features in
during the selected date range.

v Location/SKU Velocity Mismatch Report
This report matches the Location Velocity to the Item Velocity to identify
locations that have a mismatch. The warehouse can use this report to reorganize
item locations to optimize the utilization of locations.

v Node Inventory Valuation Report
This report lists the item, quantity, and valuation details for a node. This report
is useful in determining the inventory valuation in a node.

v Participant List Report
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This report lists the number of participants defined in the Selling and Fulfillment
Foundation Participant Model with role details.

v Space Consolidation Report
This report provides item-wise information about the location capacity
utilization. This helps in identifying space consolidation opportunities.

v Space Utilization Report
This report provides information on location capacity utilization in terms of
percentage.

v Location Inventory Detail Report
This report is used to track the inventory of items and locations in the
warehouse at the item, case, pallet, status, and other item attributes levels.

v Location Inventory Summary Report
This report is used to track the inventory of items and locations in the
warehouse at the item or location level.

VAS Reports
Value Added Services (VAS) reports help warehouse managers to view information
about work orders to perform Value Added Services on the inventory.

For more information about VAS reports, see "VAS Reports".

Work Order Report is the VAS report provided with the Sterling Warehouse
Management System. This report displays all the work orders for the node, in
different stages of completion. This report is used to review open work orders.

Outbound Reports
Outbound reports help shipping supervisors to see information on order billing
and shipment billing. These reports can also be used to get visibility to outbound
labor requirements, on-time shipments, and so on.

For more information about outbound reports, see "Outbound Reports".

The outbound reports provided with Sterling Warehouse Management System are:
v BOL Total Weights Report

This report lists the number of cartons or pallets, and the total weight details
against each Bill Of Lading (BOL). This report lists all details for BOLs shipped
for the selected carrier or date range.

v Container Volume Monthly Report
This report shows the number of containers shipped each month. For the current
month, it only shows the total number of cartons shipped till date.

v Daily Shipment Report
This report provides high-level visibility into shipment activity in the
warehouse, on a daily basis, for a specified date range. This report provides
daily information on new shipments awaiting shipping on the day, shipments
shipped on the day, shipment pending from previous days, and shipments
carried over to the next day.

v Generic Shipper Report
This report gives details of shipments that are either to be shipped or were
shipped using each carrier that the warehouse uses. The warehouse can use this
report to understand the carrier usage patterns.

v Hot Inventory Report
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This report helps to identify the inbound shipments that should be unloaded
based on the hot items in the trailer or container. These items are on backorder
for the warehouse, and available in the expected shipments.

v On Time Shipment Report
This report captures the number of shipments shipped at the scheduled time. It
also categorizes the delayed shipments into buckets of delays by one, two, or
more days.

v Order Billing Summary Report
This report lists the transaction details for all types of orders handled by the
warehouse. This report helps to track metrics, such as the number of orders or
order lines shipped or received.

v Order Cycle Time KPI Report
This report is used to measure the turnaround cycle time on all outbound
shipments or orders. Cycle time is defined as the time that elapses from when
an order is released to a warehouse until the time it is shipped.

v Order Shipment Report
This report shows the details of shipments against orders. It also shows the
quantity ordered and shipped at the item level.

v Outbound Labor Requirements Report
This report is used to determine the labor requirements for waves or shipments
that are to be picked, packed, and shipped on a future date. This report is useful
to plan resource requirements for outbound activities.

v Pack and Hold Shipment Report
This report lists all shipments that are currently in the ‘pack and hold’ status,
along with their location and shipper details. This report is useful to the
warehouse supervisor to review pack and hold shipments.

v Parcel Manifest Report
This report lists the Parcel manifest details in terms of shipment details, number
of containers, weight, and other details for the selected manifest number or
carrier and service.

v Replenishment Status Report
This report helps the monitoring of replenishment activities in the warehouse.
The report provides information about the replenishment status and highlights
shortages or overages of replenishment quantities.

v Same Day Pick Pack Ship Percentage Report
This report gives a measure of the number of shipments picked, packed, and
shipped on the same day. The criterion for any shipment to be counted is that
the pick date is the same as the actual ship date.

v Shipment Billing Summary Report
This report displays the number of shipments and shipment lines shipped, and
the number of receipts and receipt lines received. This report also lists the
transaction details for the transactions in the details report.

v Shipment Fill Rate Monthly Report
This report shows the percentage of complete shipments shipped by the
warehouse. The percentage is calculated as the ratio of the complete shipments
shipped to the total number of shipments shipped by the node.

v Shipments Near or Past Cancel Date Report
This report lists unshipped shipments that are near or past the selected order
cancel date range. This report is useful to track the shipments that are due and
manage resources to generate the same.
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v Shipment Shortage Report
This report lists all shipments that have item shortages and aids warehouse
managers in managing exceptions.

v Staging Locations Report
Warehouses have limited staging locations. Therefore, they can become a
bottleneck if not managed properly. This report provides a means to identify
locations that might be occupying space by having shipments that are either not
loaded or awaiting containers.

Task Reports
Task reports help warehouse managers to view information about the various tasks
performed in the warehouse.

For more information about task reports, see Chapter 7, "Task Reports".

The task reports provided with Sterling Warehouse Management System are:
v In-Progress Container Summary Report

This report shows the current status of the pick-pack-ship process. The default
container dashboard view shows two graphs: Number of containers by statuses
and Number of Containers by Carriers.

v In-Progress Shipment Summary Report
This report shows the current status of the pick-pack-ship process. The default
dashboard view shows these two graphs: Number of Shipments and Cartons
Across All Carriers, and Number of Shipments and Cartons by Carrier.

v User Productivity Daily Report
This report provides user productivity information, on a daily basis, for a given
date range.

v User Productivity Weekly Report
This report provides user productivity information, on a weekly basis, for a
given date range.

v User Productivity Monthly Report
This report provides user productivity information, on a monthly basis, for a
given date range.

v Warehouse Activity Completion Report
This report provides a summary of the various warehouse tasks that are in
"Completed" status. The numbers change as more tasks enter the "Completed"
status. The user can also select only a specific set of task types to populate the
activity report.

Print the Sterling Warehouse Management System Reports
To print the Sterling Warehouse Management System reports:

About this task

Procedure
1. Generate the report you want to print.

2. Click to view the report in Portable Document Format (PDF).

3. Click in the PDF view to print the report.
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Chapter 2. Inbound Reports

Await Material Report
The Await Material Report shows the summary of the items that are waiting for
material. This report helps the warehouse to identify items that are unavailable
and to prioritize inbound shipments that can reduce the awaiting items in this
report.

Intended Audience

Warehouse managers and inbound supervisors use this report to identify the
inbound shipments that needs to be received. The user can also see the total
requirements for a SKU or see the material requirements for each individual
shipment.

Generate an Await Material Report
To generate the Await Material Report:

About this task

Procedure
1. Navigate to Inbound > Await Material Report. The Await Material Report

criteria screen appears. For more information about the Await Material Report
criteria screen, see "Await Material Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The Await
Material Report appears. For more information about the Await Material
Report, Shipment layout, see "Await Material Report, Shipment Details" and for
more information about Await Material Report, Item Details layout, see "Await
Material Report, Item Details".

Await Material Report Criteria
The Await Material Report criteria screen enables you to enter the criteria for
which the Await Material Report generates.
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Table 2. Await Material Report Criteria Screen

Field Description Default Value Mandatory

Document Type Select the document type for
which the report is generated.

For this report, the document
types displayed are Transfer
Order and Sales Order.

Sales Order. Yes

Node The node for which the report
is generated.

Current node of
the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.
Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates. Note: It is
mandatory to select any one
of the radio buttons to execute
the report.

Selected. No

Report Level -
Shipment Details

Choose this to view the Await
Material Report, Shipment
Details which reports the
details of the shipments for a
specific item, within a specific
enterprise.

Not Selected. No

Figure 12. Await Material Report Criteria Screen
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Table 2. Await Material Report Criteria Screen (continued)

Field Description Default Value Mandatory

Report Level -
Item Details

Choose this to view the Await
Material Report, Item Details
which reports the details of
the items, within a specific
enterprise.

Selected. No

Expected Ship
Date

Enter the start date and the
end date for which the report
is generated.

You can also click the icons
to choose the date range.

The current date. Yes

Await Material Report, Shipment Details
This report gives a detailed information about the shipments requested on a
particular ship date.

Report Layout

This section describes the report layout of the Await Material Report, Shipment
details.
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Field Description

Ship Date

Figure 13. Await Material Report, Shipment Details
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The date on which the shipment is shipped.

Shipment No.

The number assigned to a specific shipment.

Seller

The organization from where the items are shipped.

Buyer

The organization to which the items are shipped.

Item ID

The identifier assigned to the item.

Item Description

The description of the item.

PC

The product class to which the item belongs.

UOM

The unit of measure for the item.

Ordered Quantity

The quantity ordered.

Shortage Quantity

The quantity in shortage for that order.

The Await Material Report for Shipment Details appears in portrait layout.

Group and Sort Criteria

The Await Material Report for Shipment Details is grouped by Enterprise Code,
Ship Date, Shipment No., Buyer, and Item ID.

Enterprise Code, Shipment No., and Item ID are sorted in ascending order. The
Expected Ship Date is sorted in descending order.

Page Break Criteria

For each new enterprise, the report starts in a new table on another page. The
name of the enterprise is printed at the top of the table.

Additional Setup Required

There is no additional setup required to generate this report.

Await Material Report, Item Details
This report gives a detailed information about the items within a particular
shipment.
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Report Layout

This section describes the report layout of the Await Material Report, Item Details.
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Field Description

Item ID

Figure 14. Await Material Report, Item Details
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The identifier assigned to the item.

Click this to view the Await Material Report, Shipment Details, which
gives details of all shipments.

Item Description

The description of the item.

PC

The product class to which the item belongs.

UOM

The unit of measure for the item.

Shortage Quantity

The quantity in shortage for that order.

The Await Material Item Details Report appears in portrait layout.

Group and Sort Criteria

The Await Material Item Details Report is grouped by Enterprise code and Item
ID.

Enterprise code and Item ID are sorted in ascending order.

Page Break Criteria

For each new enterprise, the report starts in a new table on another page. The
name of the enterprise is printed at the top of the table.

Additional Setup Required

There is no additional setup required to generate this report.

Delivery Dock Schedule Report
The Delivery Dock Schedule Report provides visibility into appointments taken for
one or more receiving dock locations, for a range of dates.

Intended Audience

Warehouse managers and inbound supervisors use this report to keep track of
dock appointments.

Generate a Delivery Dock Schedule Report
About this task

To generate the Delivery Dock Schedule Report:

Procedure
1. Navigate to Inbound > Delivery Dock Schedule Report. The Dock Schedule

Report criteria screen displays. For more information about the Dock Schedule
Report criteria screen, see "Dock Schedule Report Criteria".
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2. Enter the criteria and click Generate Report to generate the report. The Dock
Schedule Report displays. For more information about the Dock Schedule
Report layout, see "Dock Schedule Report Layout".

Dock Schedule Report Criteria
The Dock Schedule Report criteria screen enables you to enter the criteria for
which the Dock Schedule Report generates.

For field value descriptions, see the following table.

Table 3. Dock Schedule Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report is
generated.

The current node of
the user.

Yes

Carrier Select the name of the carrier for
which the report is generated.

None. No

Docks You can generate reports for a
range of dock locations.

From Enter the initial dock location.

You can also click to select
the dock location.

None. No

To Enter the final dock location.

You can also click to select
the dock location.

None. No

Figure 15. Dock Schedule Report Criteria Screen
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Table 3. Dock Schedule Report Criteria Screen (continued)

Field Description Default Value Mandatory

Appointment
Date

Enter the start date and the end
date for which the report is
generated.

You can also click the
icon to choose the date range.

The current date. Yes.

Appointment
Type - Inbound
Delivery

Choose this option to view the
report for inbound deliveries.

Selected, if you are
entering the search
criteria for the
Delivery Dock
Schedule Report.

Not Selected, if you
are entering the
search criteria for the
Dock Pickup Schedule
Report.

No

Appointment
Type -
Outbound
Pickup

Choose this option to view the
report for outbound pickups.

Selected, if you are
entering the search
criteria for the Dock
Pickup Schedule
Report.

Not Selected, if you
are entering the
search criteria for the
Delivery Dock
Schedule Report.

No

Appointment
Type - Both

Choose this option to view the
report for both inbound
deliveries and outbound pickups.

Not selected. No

Group and Sort Criteria

The Dock Schedule Report is grouped by Location and Date.

The Location, Date, and Time Slot are sorted in ascending order.

Page Break Criteria

For each dock location, the report starts in a new table on another page. The name
of the dock location is printed at the top of the table.

Additional Setup Required

There is no additional setup required to generate the Delivery Dock Schedule
Report.
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Dock Schedule Report Layout
This section describes the layout of the Dock Schedule Report.

Dock Schedule Report

Field Description

Date

The appointment date for which the report is generated.

Time Slot

The time slot for which a dock appointment is taken.

Appointment No

The appointment number of the appointment.

Appointment Type

The type of appointment.

Carrier

The carrier used for the shipment or load.

Trailer No

The trailer number for the shipment or load.

PRO No

The PRO number assigned by the carrier to track the shipment.

The PRO number is used if an LTL carrier hauls the shipment.

Figure 16. Dock Schedule Report

Chapter 2. Inbound Reports 33



BOL No

The Bill of Lading number associated with the load.

Load No

The load number for the expected load.

The load number does not appear in the report if the appointments are
taken for order number or shipment number.

Shipment No

The shipment number for the expected shipment.

The shipment number does not appear in the report if the appointments
are taken for the load number.

Order No

The order number for the expected order.

The shipment number does not appear in the report if the appointments
are taken for the load number.

Dock to Stock Cycle Time KPI Report
The Dock to Stock Cycle Time KPI Report is used to measure the Dock to Stock
cycle time on all inbound shipments or receipts. Cycle Time is defined as the time
that elapses from the start of a receipt to the time that Putaway completes.

Intended Audience

Warehouse managers and inbound supervisors use the Dock to Stock Cycle Time
KPI Report to track the performance of inbound activities. The report is generated
at the end of the day.

Generate the Dock to Stock Cycle Time KPI Report
About this task

To generate the Dock to Stock Cycle Time KPI Report:

Procedure
1. Navigate to Inbound > Dock to Stock Cycle Time KPI Report. The Dock to

Stock Cycle Time KPI Report criteria screen appears. For more information
about the Dock to Stock Cycle Time KPI Report criteria screen, see "Dock to
Stock Cycle Time KPI Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The Dock to
Stock Cycle Time KPI Report appears. For more information about the Dock to
Stock Cycle Time KPI Report layout, see "Dock to Stock Cycle Time KPI Report
Layout".

Dock to Stock Cycle Time KPI Report Criteria
The Dock to Stock Cycle Time KPI Report criteria screen enables you to enter the
criteria for which the Dock to Stock Cycle Time KPI Report generates.
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Table 4. Dock to Stock Cycle Time KPI Report Criteria Screen

Field Description Default Value Mandatory

Document Type Select the document type for
which the report is generated.

For this report, the document
types displayed are Blind
Return, Blind Order, Transfer
Order, and Purchase Order.

Purchase Order. Yes

Node The node for which the report
is generated.

Current node of
the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Receipt Date Enter the start date and the
end date for which the report
is generated.

You can click the
icons to choose the date
range.

The current date. Yes

Figure 17. Dock to Stock Cycle Time KPI Report Criteria Screen
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Table 4. Dock to Stock Cycle Time KPI Report Criteria Screen (continued)

Field Description Default Value Mandatory

Putaway Cycle
Time (in Hrs)

Enter the time elapsed from
when the receipt starts to the
time Putaway completes.

4 Yes

Dock to Stock Cycle Time KPI Report Layout
This section describes the layout of the Dock to Stock Cycle Time KPI Report.
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Field Description

Receipt Date

Figure 18. Dock to Stock Cycle Time KPI Report
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The date on which the inbound shipment is received.

Total Shipments

The total count of the inbound shipments for which the receipt is
generated.

Click this to view the Shipments Detail Report For Total Shipments, which
shows the list of all inbound shipments.

Putaway in X Hrs

The number of shipments put away in less than cycle time. Here, X Hrs
indicates the cycle time.

Click this to view the Shipments Detail Report For Putaway in X Hrs,
which shows the list of shipments for Putaway in X Hrs.

Putaway in 2X Hrs

The number of shipments put away in more than cycle time and less than
twice the cycle time. Here, X Hrs indicates the cycle time.

Click this to view the Shipments Detail Report For Putaway in 2X Hrs,
which shows the list of shipments for Putaway in 2X Hrs.

Putaway Beyond 2X Hrs

Number of shipments put away in more than twice the cycle time. Here X
Hrs indicates cycle time.

Click this to view the Shipments Detail Report For Putaway Beyond 2X
Hrs, which shows the list of shipments for Putaway Beyond 2X Hrs.

Field Description

Receipt Date, Enterprise Code

The date on which the inbound shipment is received.

This is grouped by enterprise code.

No. of Shipments

The total count of the inbound shipments for which the receipt is
generated.

Regions of this color indicate the total number of shipments for a
particular date.

Regions of this color indicate the number of shipments putaway in less
than cycle time for the specified date.

Regions of this color indicate the number of shipments putaway in more
than cycle time and less than twice the cycle time for a particular date.

Regions of this color indicate the number of shipments putaway in more
than twice the cycle time for a particular date.
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The Dock to Stock Cycle Time KPI Report appears in portrait layout.

Group and Sort Criteria

The Dock to Stock Cycle Time KPI Report is grouped by Enterprise Code and
Receipt Date.

The Enterprise Code is sorted in ascending order and Receipt Date is sorted in
descending order.

Page Break Criteria

For each new enterprise, the report starts in a new table on another page. The
name of the enterprise is printed at the top of the table.

Additional Setup Required

To obtain the data required for the Dock to Stock Cycle Time KPI Report, schedule
the PUTAWAY_COMPLETE agent to execute at the end of each day.

The PUTAWAY_COMPLETE agent mines the data required for the Dock to Stock
Cycle Time KPI Report from the Receiving Details and Putaway Tasks transactions.

Shipments Detail Report For Total Shipments
The Shipments Detail Report for total shipments provides a list of all the inbound
shipments and their details.

Note: The value of Time Interval indicates the time taken to put away inbound
shipments.

For Shipments Detail Report for Total Shipments, the value of Time Interval is All.

Report Layout

This section describes the layout of the Shipments Detail Report.
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Field Description

Shipment No.

Figure 19. Shipments Detail Report
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The identifier number of the shipment received.

Seller

The organization from where the items are shipped.

Receipt No.

The receipt number of the shipment.

Receipt Date

The date on which the shipment is received.

Time Taken for Putaway

The putaway time of the shipment.

The Shipments Detail Report appears in portrait layout.

Group and Sort Criteria

The Shipments Detail Report is grouped by Shipment Number.

The Shipment Number is sorted in ascending order.

Page Break Criteria

The Shipments Detail Report has no page break criteria.

Shipments Detail Report For Putaway in X Hrs
The Shipments Detail Report for putaway in X hrs gives the list of all the inbound
shipments putaway in less than cycle time.

Note: The value of Time Interval indicates the time taken to putaway inbound
shipments.

For Shipments Detail Report for Putaway in X Hrs, the value of Time Interval is
considered for Putaway In Cycle Time.

The fields, layout, group and sort criteria, and page break criteria of this report are
similar to the Shipments Detail Report For Total Shipments.

Shipments Detail Report For Putaway in 2X Hrs
The Shipments Detail Report for putaway in 2X hrs gives the list of all the
inbound shipments putaway in less than twice the cycle time.

Note: The value of Time Interval indicates the time taken to putaway inbound
shipments.

For Shipments Detail Report for Putaway in 2X Hrs, the value of Time Interval is
considered for Putaway InTwiceCycleTime.

Shipments Detail Report For Putaway Beyond 2X Hrs
The Shipments Detail Report for putaway in 2X hrs gives the list of all the
inbound shipments putaway beyond twice the cycle time.
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Note: The value of Time Interval indicates the time taken to putaway inbound
shipments.

For Shipments Detail Report for Putaway Beyond 2X Hrs, the value of Time
Interval is considered for putaway BeyondTwiceCycleTime.

Inbound Labor Requirements Report
The Inbound Labor Requirements Report is used to determine labor requirements
for receiving activities. The labor required is calculated based on the Standard
Allowable Minutes defined.

Intended Audience

Warehouse managers and inbound supervisors use this report to plan resource
requirements for receiving and putaway. This report also helps them to decide
whether to reduce shipments, move people from other operations, or add more
shipments when resources are available.

Generate an Inbound Labor Requirements Report
To generate the Inbound Labor Requirements Report:

About this task

Procedure
1. Navigate to Inbound > Inbound Labor Requirements Report. The Inbound

Labor Requirements Report criteria screen appears.
2. Enter the criteria and click Generate Report to generate the report. The Inbound

Labor Requirements Report appears.

Inbound Labor Requirements Report Criteria
The Inbound Labor Requirements Report criteria screen enables you to enter the
criteria for which the Inbound Labor Requirements Report generates.

Figure 20. Inbound Labor Requirements Report Criteria Screen
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Table 5. Inbound Labor Requirements Criteria Screen

Field Description Default Value Mandatory

Document Type Select the document type for
which the report is generated.

For this report, the document
types displayed are Blind
Return, Blind Order, Transfer
order and Purchase Order.

Purchase Order. Yes

Node The node for which the report
is generated.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Date Range Enter the start date and the
end date for which the report
is generated.

You can also click the Date
Range icons to choose the
date range.

The current date. Yes

Group and Sort Criteria

The Inbound Labor Requirements is grouped by the Expected Delivery Date.

Expected Delivery Date is sorted in descending order.

Page Break Criteria

For each new enterprise, the report starts in a new table on another page. The
name of the enterprise is printed at the top of the table.

Inbound Labor Requirements Report Layout
This section describes the report layout of the Inbound Labor Requirements Report.
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Field Description

Expected Delivery Date

Figure 21. Inbound Labor Requirements Report
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The date on which the delivery of the shipment is expected.

No. of Shipments

Total number of shipments expected on a particular date.

No. of Shipment Lines

Total number of shipment lines for all the expected shipments.

No. of Units

Total number of units expected for all shipments on a particular date.

No. of Cases

Total number of cases expected for all shipments on a particular date.

Person Hours Reqd

The person hours required for delivering all shipments, with expected
delivery date listed against the person hours.

Person Hours Reqd is calculated as follows:

Person Hours Reqd = [(No. of Shipments * SAM Per Productivity Batch)
+ (No. of Shipment Lines * SAM per Item) + (No. of Units * SAM per
Unit) + (No. of Cases * SAM per Case)] / 60

The Inbound Labor Requirements Report appears in portrait layout.

Set Up Inbound Labor Productivity Type
To compute the Person Hours Required, the Inbound Labor Requirements Report
depends upon the values set up in the INBOUND_LABOR productivity type.

About this task

To set up the INBOUND_LABOR productivity type:

Procedure
1. Launch the Applications Manager.
2. Navigate to Applications > Warehouse Management.
3. From the tree in the application rules side panel, choose Task Management >

Productivity > Productivity Types. The Productivity Types window appears.
4. In the Productivity Types window select INBOUND_LABOR. The Productivity

Type Details window appears.
The Sterling Warehouse Management System Reference Implementation
provides SAM values as displayed in the following figure.
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5. In the SAM Definition tab, for fields that do not contain zero values, enter the
appropriate SAM values. These values are used to compute the Person Hours
Required.

6. Click the Save icon.

Item Attribute Setup Report
The Item Attribute Setup Report lists all items in the warehouse with incompletely
defined attributes. This report is useful to identify items that have incomplete set
up.This information is required to execute warehouse operations.

Intended Audience

Warehouse managers and inbound supervisors use this report to proactively set up
item data to carry out item transactions in the warehouse. The report is generated
manually.

Figure 22. Productivity Type Details Window, Inbound Labor
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Generate the Item Attribute Setup Report
About this task

To generate the Item Attribute Setup Report:

Procedure
1. Navigate to Inbound > Item Attribute Setup Report. The Item Attribute Setup

Report criteria screen appears.
2. Enter the criteria and click Generate Report to generate the report. The Item

Attribute Setup Report appears.

Item Attribute Setup Report Criteria
The Item Attribute Setup Report criteria screen enables you to enter the criteria for
which the Item Attribute Setup Report generates.

Figure 23. Item Attribute Setup Report Criteria Screen
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Table 6. Item Attribute Setup Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report
is generated.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Product Line Select the product line
corresponding to the items in
the warehouse.

Click the Add icon to enter
more product lines. These
product lines are taken into
consideration while
generating the report.

Click the Delete icon to
remove a specific product
line.

Blank. No

Show All Items Choose this to view the Item
Attribute Setup Report, All
Items, which displays all
items that may or may not
exist in the warehouse
currently.

Selected. No

Show Items in
Inventory

Choose this to view the Item
Attribute Setup Report, Only
Items In Inventory, which
displays all the items existing
in the warehouse.

Not Selected. No

Show Items in
PO/Shipment

Choose this to view the Item
Attribute Setup Report, Only
Items In PO/Shipment, which
displays all the items in the
purchase order or shipment.

Not Selected. No

Show Items in
Inventory and
PO/Shipment

Choose this to view the Item
Attribute Setup Report, Items
In Inventory and
PO/Shipment, which displays
all items in the warehouse
and in the PO or Shipment.

Not Selected. No
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Item Attribute Setup Report, All Items
This report provides a list of all items with incompletely defined attributes,
including those items that may not exist in the warehouse.

Note: The value of Show indicates whether the report is for All Items.

For the Item Attribute Setup Report for Show All Items, the value of Show is All
Items.

Report Layout

This section describes the layout of the Item Attribute Setup Report, All Items.
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Field Description

Enterprise

Figure 24. Item Attribute Setup Report, All Items
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The enterprise to which the shipment belongs.

Item ID

The identifier assigned to the item.

Item Description

The description of the item.

UOM

The unit of measure for the item.

Length

The length of the item.

Width

The width of the item.

Height

The height of the item.

Weight

The weight of the item.

Hazmat Class

The hazardous material to which the item belongs.

Is Dedicated

This indicates if the item has a dedicated location.

The Item Attribute Setup Report appears in portrait layout.

Group and Sort Criteria

The Item Attribute Setup Report, All Items is grouped by Enterprise Code and
Item ID.

The Enterprise Code and Item ID are sorted in ascending order.

Page Break Criteria

The Item Attribute Setup Report, All Items has no page break criteria.

Additional Setup Required

There is no additional setup required to generate this report.

Item Attribute Setup Report, Only Items In Inventory
This report provides a list of all the items existing in the warehouse with
incompletely defined attributes.

Note: The value of Show indicates whether the report is for Only Items In
Inventory.

For Item Attribute Setup Report for Show Items in Inventory, the value of Show is
Items in Inventory.
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The fields, layout, group and sort criteria and page break criteria of this report are
similar to the “Item Attribute Setup Report, All Items” on page 49.

Item Attribute Setup Report, Only Items In PO/Shipment
This provides a list of all the items with incompletely defined attributes in the
purchase order or shipment.

Note: The value of Show indicates whether the report is for Only Items in
PO/Shipment.

For Item Attribute Setup Report for Show Items in PO/Shipment, the value of
Show is Items in PO/Shipment.

The fields, layout, group and sort criteria and page break criteria of this report are
similar to the “Item Attribute Setup Report, All Items” on page 49.

Item Attribute Setup Report, Items In Inventory and
PO/Shipment

This provides a list of all the items with incompletely defined attributes in the
warehouse, and purchase order or shipment.

Note: The value of Show indicates whether the report is for Items in Inventory
and PO/Shipment.

For Item Attribute Setup Report for Show Items in Inventory and PO/Shipment,
the value of Show is Items in Inventory and PO/Shipment.

The fields, layout, group and sort criteria and page break criteria of this report are
similar to the “Item Attribute Setup Report, All Items” on page 49.

Receipt Discrepancy Report
The Receipt Discrepancy Report is used to track the receipt discrepancy details
between the expected and received quantities, lot number, and serial number. The
receipt discrepancy can be tracked for a particular day or date range. The report
displays the discrepancy as Short Receipt, Over Receipt, or Damaged.

Intended Audience

Warehouse managers and inbound supervisors use the Receipt Discrepancy Report
to reconcile the discrepancies in the quantity of shipment received. To access this
report, the inbound supervisor or warehouse manager must belong to the data
security group representing inbound supervisor or warehouse manager.

Note: The Receipt Discrepancy Report is generated only for shipments with
orders.

This report lists receipts that are in "Receipt in progress" or "Received" status.
Receipts that are in "Receipt started" status are not listed in this report.

Generate a Receipt Discrepancy Report
About this task

To generate the Receipt Discrepancy Report:
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Procedure
1. Navigate to Inbound > Receipt Discrepancy Report. The Receipt Discrepancy

Report criteria screen appears.
2. Enter the criteria and click Generate Report to generate the report. The Receipt

Discrepancy Report appears.

Receipt Discrepancy Report Criteria
The Receipt Discrepancy Report criteria screen enables you to enter the criteria for
which the Receipt Discrepancy Report generates.

Table 7. Receipt Discrepancy Report Criteria Screen

Field Description Default Value Mandatory

Document Type Select the document type for
which the report is generated.

For this report, the document
types displayed are Blind
Return, Blind Order, Transfer
Order, and Purchase Order.

Purchase Order. Yes

Node The node for which the report
is generated.

The current node
of the user.

Yes

Figure 25. Receipt Discrepancy Report Criteria Screen
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Table 7. Receipt Discrepancy Report Criteria Screen (continued)

Field Description Default Value Mandatory

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Receipt Date Enter the start date and the
end date for which the report
is generated.

You can also click the Date
Range icons to choose the
date range.

The current date. Yes

Seller Enter the seller organization
for which the report is
generated.

You can also click the Search
icon to select the seller
organization.

Blank. No

Discrepancy Level
- Quantity

Check this box to view the
quantity discrepancy in the
Receipt Discrepancy Report.

Selected. No

Discrepancy Level
- Lot No.

Check this box to view the lot
number discrepancy in the
Receipt Discrepancy Report.

Selected. No

Discrepancy Level
- Serial No.

Check this box to view the
serial number discrepancy in
the Receipt Discrepancy
Report.

Selected. No

Note: To generate the report. the user must select atleast one of the options in the
Discrepancy Level.

Group and Sort Criteria

The Receipt Discrepancy Report is grouped by Enterprise Code, Receipt Date, and
item ID.

The Enterprise Code is sorted in ascending order, and Receipt Date is sorted in
descending order.
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Page Break Criteria

For each new enterprise, the report starts in a new table on another page. The
name of the enterprise is printed at the top of the table.

Additional Setup Required

To obtain the quantity discrepancy data in the report, run the
RecordReceivingDiscrepancy API.
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Receipt Discrepancy Report Layout
This section describes the layout of the Receipt Discrepancy Report

Figure 26. Receipt Discrepancy Report, Quantity Discrepancy
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Field Description

Receipt Date

The date on which the inbound shipment is received.

Receipt No.

The receipt number of the shipment.

Item ID

The identifier of the item received.

Item Description

The description of the item received.

PC

The product class to which the item received belongs.

UOM

The unit of measure for the item received.

Discrepancy Type

The type of discrepancy in the receipt.

Expected

The expected quantity of the item.

Actual

The actual quantity of the item received.

Buyer

The organization to which the items are shipped.

Seller

The organization from where the items are shipped.
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Field Description

Receipt Date

Figure 27. Receipt Discrepancy Report, Lot No. Discrepancy

58 Sterling Warehouse Management System: Reports Guide



The date on which the inbound shipment is received.

Receipt No.

The receipt number of the shipment.

Item ID

The identifier of the item received.

Item Description

The description of the item received.

PC

The product class to which the item received belongs.

UOM

The unit of measure for the item received.

Expected Lot No.

The expected lot number of the item.

Received Lot No.

The actual lot number of the item received.

Buyer

The organization to which the items are shipped.

Seller

The organization from where the items are shipped.

Chapter 2. Inbound Reports 59



Field Description

Receipt Date

Figure 28. Receipt Discrepancy Report, Serial No. Discrepancy
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The date on which the inbound shipment is received.

Receipt No.

The receipt number of the shipment.

Item ID

The identifier of the item received.

Item Description

The description of the item received.

PC

The product class to which the item received belongs.

UOM

The unit of measure for the item received.

Expected Serial No.

The expected serial number of the item.

Received Serial No.

The actual serial number of the item received.

Buyer

The organization to which the items are shipped.

Seller

The organization from where the items are shipped.

The Receipt Discrepancy Report appears in portrait layout.

Receipt Detail Report
The Receipt Detail Report lists the details of the shipments received for the
selected shipment, PO, or date range. It provides details at the item and quantity
level.

Intended Audience

Warehouse managers and inbound supervisors use the Receiving Detail Report to
track the performance of inbound activities. The report is accessed by email, on a
subscription basis.

Note: This report lists receipts that are closed.

Generate a Receipt Detail Report
About this task

To generate the Receipt Detail Report:

Procedure
1. Navigate to Inbound > Receipt Detail Report. The Receipt Detail Report criteria

screen appears.
2. Enter the criteria and click Generate Report to generate the report. The Receipt

Detail Report appears.
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Receipt Detail Report Criteria
The Receipt Detail Report criteria screen enables you to enter the criteria for which
the Receipt Detail Report generates.

Table 8. Receipt Detail Report Criteria Screen

Field Description Default Value Mandatory

Document Type Select the document type for
which the report is generated.

Purchase Order. Yes

Node The node for which the report
is generated.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Figure 29. Receipt Detail Report Criteria Screen
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Table 8. Receipt Detail Report Criteria Screen (continued)

Field Description Default Value Mandatory

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Receipt Date Enter the start date and the
end date for which the report
is generated.

You can also click the Date
Range icons to choose the
date range.

The current date. Yes

Shipment # Enter the shipment number
for which the report is
generated.

You can also click the Search
icon to select the shipment
number.

Blank. No

Order # Enter the order number for
which the report is generated.

You can also click the Search
icon to select the order
number.

Blank. No

Seller Enter the seller organization
for which the report is
generated.

You can also click the Search
icon to select the seller
organization.

Blank. No

Buyer Enter the buyer organization
for which the report is
generated.

You can also click the Search
icon to select the buyer
organization.

Blank. No

Carrier Enter the carrier organization
for which the report is
generated.

You can also click the Search
iconto select the carrier
organization.

Blank. No

Group and Sort Criteria

The Receipt Detail Report is grouped by Enterprise Code, Receipt Date, Receipt
No., Order No., and Shipment No.
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The Receipt Date, and Receipt No. are sorted in descending order, and Enterprise
Code, Order No. and Shipment No. are sorted in ascending order.

Page Break Criteria

For each new enterprise, the report starts in a new table on another page. The
name of the enterprise is printed at the top of the table.

Additional Setup Required

There is no additional setup required to generate this report.
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Receipt Detail Report Layout
This section describes the layout of the Receipt Detail Report.

Figure 30. Receipt Detail Report
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Field Description

Receipt Date

The date on which the inbound shipment is received.

Receipt No.

The receipt number of the shipment.

Shipment No.

The shipment number of the shipment received.

Seller

The organization from where the items are shipped.

Buyer

The organization to which the items are shipped.

Order No.

The order number of the shipment.

Item ID

The identifier assigned to the item received.

Item Description

The description of the item received.

PC

The product class to which the item received belongs.

UOM

The unit of measure for the item received.

Quantity

The quantity of the item received.

The Receipt Detail Report appears in portrait layout.

Receipt Summary Report
The Receipt Summary Report lists the receipts for the selected shipment, PO, or
date range as well as summary receipt information at the shipment level.

Intended Audience

Warehouse managers and inbound supervisors use the Receipt Summary Report to
track the performance of inbound activities. The report is accessed by email, on
subscription.

Note: This report lists receipts that are closed.

Generate a Receipt Summary Report
About this task

To generate the Receipt Summary Report:
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Procedure
1. Navigate to Inbound > Receipt Summary Report. The Receipt Summary Report

criteria screen appears.
2. Enter the criteria and click Generate Report to generate the report. The Receipt

Summary Report appears.

Receipt Summary Report Criteria
The Receipt Summary Report criteria screen enables you to enter the criteria for
which the Receipt Summary Report generates.

Table 9. Receipt Summary Report Criteria Screen

Field Description Default Value Mandatory

Document Type Select the document type for
which the report is generated.

Purchase Order. Yes

Node The node for which the report
is generated.

The current node
of the user.

Yes

Figure 31. Receipt Summary Report Criteria Screen
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Table 9. Receipt Summary Report Criteria Screen (continued)

Field Description Default Value Mandatory

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Receipt Date Enter the start date and the
end date for which the report
is generated.

You can also click the Date
Range icons to choose the
date range.

The current date. Yes

Shipment# Enter the shipment number
for which the report is
generated.

You can also click the Search
icon to select the shipment
number.

Blank. No

Order# Enter the order number for
which the report is generated.

You can also click the Search
icon to select the order
number.

Blank. No

Seller Enter the name of the seller
organization.

You can also click the Search
icon to select the seller
organization.

Blank. No

Buyer Enter the buyer organization
for which the report is
generated.

You can also click the Search
icon to select the buyer
organization.

Blank. No

Carrier Enter the name of the carrier.

You can also click the Search
icon to select the carrier.

Blank. No

68 Sterling Warehouse Management System: Reports Guide



Group and Sort Criteria

The Receipt Summary Report is grouped by Enterprise Code, Shipment No.,
Receipt Date, and Receipt No.

The Enterprise Code and Receipt No. are sorted in ascending order and Receipt
Date and Shipment No. are sorted in descending order.

Page Break Criteria

For each new enterprise, the report starts in a new table on another page. The
name of the enterprise is printed at the top of the table.

Additional Setup Required

There is no additional setup required to generate this report.
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Receipt Summary Report Layout
This section describes the layout of the Receipt Summary Report.

Figure 32. Receipt Summary Report
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Field Description

Shipment No.

The shipment number of the shipment received.

Click this to view the Receipt Detail Report, which lists the details of the
shipments received.

Receipt Date

The date on which the shipment is received.

Receipt No.

The receipt number of the shipment.

Order No.

The order number of the shipment.

Carrier/Service

The carrier or service used for the shipment.

Seller

The organization from where the items are shipped.

Buyer

The organization to which the items are shipped.

The Receipt Summary Report appears in portrait layout.

Shipment Billing Summary Report
The Shipment Billing Summary Report displays the number of shipments and
shipment lines shipped, and the number of receipts and receipt lines received. This
report also lists the transaction details for the transactions in the details report.

Warehouse managers and inbound supervisors, as well as enterprise users, use the
Shipment Billing summary Report to track the transactions made for a particular
date range.

To generate the Shipment Billing Summary Report, navigate to Inbound >
Shipment Billing Summary Report. The Shipment Billing Summary Report criteria
screen appears.

Vendor Non-Compliance Report
The Vendor Non-Compliance Report displays the non-compliant shipments
observed during the inbound process. This report helps the warehouse to identify
the vendors shipping non-compliant shipments.

Intended Audience

Warehouse managers and enterprise users use this report to identify shipments
that do not meet compliance requirements.
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Generate a Vendor Non-Compliance Report
About this task

To generate the Vendor Non-Compliance Report:

Procedure
1. Navigate to Inbound > Non Compliance Report. The Non Compliance Report

criteria screen appears.
2. Enter the criteria and click Generate Report to generate the report. The Vendor

Non-Compliance Report appears.

Vendor Non-Compliance Report Criteria
The Vendor Non-Compliance Report criteria screen enables you to enter the criteria
for which the Vendor Non-Compliance Report generates.

Table 10. Non-Compliance Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report
is generated.

Current® node of
the user.

Yes

Figure 33. Non-Compliance Report Criteria Screen
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Table 10. Non-Compliance Report Criteria Screen (continued)

Field Description Default Value Mandatory

Enterprise Select the enterprise name
from the drop-down list.

The current
enterprise of the
user appears as
the user’s default
enterprise.

Yes

Discrepancy Level Select any one of these levels
as the discrepancy level:

v Shipment Level

v Item Level

v Load Level

It is mandatory to select a
discrepancy level.

Shipment Level Choose this to view the
number of shipments in
discrepancy, at the shipment
level.

Selected. No

Item Level Choose this to view the
number of shipments in
discrepancy, at the item level.

Not Selected. No

Load Level Choose this to view the
number of shipments in
discrepancy, at the load level.

Not Selected. No

Discrepancy Code Indicates the nature of
discrepancy.

Check the appropriate
discrepancy code from this
list.

Based on the discrepancy
level and discrepancy code
selected, the number of
shipments that are in
discrepancy are displayed in
the report.

Not Selected. No

Report Generation
Level - Seller

Select this to view the Vendor
Non-Compliance Report,
Seller, which provides a
detailed summary of the
non-compliant shipments
shipped by the vendor in a
particular date range.

Selected. No

Report Generation
Level - Carrier

Select this to view the Vendor
Non-Compliance Report,
Carrier, which provides a
detailed summary of the
non-compliant shipments
delivered by the carrier in a
particular date range.

Not Selected. No
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Table 10. Non-Compliance Report Criteria Screen (continued)

Field Description Default Value Mandatory

Date Range Enter the start date and the
end date for which the report
is generated

You can also click the Date
Range icon to choose the
date.

The current date. Yes

Group and Sort Criteria

The Vendor Non-Compliance Report for Seller and Carrier has no group or sort
criteria.

Page Break Criteria

The Vendor Non-Compliance Report for Seller and Carrier has no page break
criteria.

Additional Setup Required

There is no additional setup required to generate this report.

Vendor Non-Compliance Report, Seller
This section describes the report layout of the Vendor Non-Compliance Report for
Seller.
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Field Description

Vendor

Figure 34. Vendor Non-Compliance Report, Seller
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Indicates the name of the Vendor.

Total # of Shipments

Indicates the total number of shipments shipped by the vendor.

# of Non Compliant Shipments

Indicates the total number of non-compliant shipments shipped by the
vendor.

# of Compliant Shipments

Indicates the total number of compliant shipments shipped by the vendor.

% Compliance

Indicates the total percentage of compliance.

The Vendor Non-Compliance Report for Seller appears in portrait layout.

Vendor Non-Compliance Report, Carrier
This section describes the report layout of the Vendor Non-Compliance Report for
Carrier.
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Field Description

Carrier

Indicates the name of the carrier.

Figure 35. Vendor Non-Compliance Report, Carrier
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Total # of Shipments

Indicates the total number of shipments delivered by the carrier.

# of Non Compliant Shipments

Indicates the total number of non-compliant shipments delivered by the
carrier.

# of Compliant Shipments

Indicates the total number of compliant shipments delivered by the carrier.

% Compliance

Indicates the total percentage of compliance.

The Vendor Non-Compliance Carrier Report appears in portrait layout.
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Chapter 3. Returns Reports

Returns By Reason Code Report
The Returns By Reason Code Report lists all shipments based on the return reason
code entered during return creation. The report can also be viewed for only
selected reason codes.

Intended Audience

Warehouse managers and inbound supervisors, as well as enterprise users use the
Returns By Reason Code Report to verify the returns and also to check the reason
for the large number of returns.

Generate a Returns by Reason Code Report
About this task

To generate Returns by Reason Code Report:

Procedure
1. Navigate to Returns > Returns By Reason Code Report. The Returns By Reason

Code Report criteria screen appears. For more information about the Returns
By Reason Code Report criteria screen, see "Returns By Reason Code Report
Criteria".

2. Enter the criteria and click Generate Report to generate the report. The Returns
By Reason Code Report appears. For more information about the Returns By
Reason Code Report layout, see "Returns By Reason Code Report Layout".

Returns By Reason Code Report Criteria
The Returns By Reason Code Report criteria screen enables you to enter the criteria
for which the Returns By Reason Code Report generates.
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Table 11. Returns By Reason Code Report Criteria Screen

Field Description Default Value Mandatory

Document Type The document type for which
the report is generated.

Return order. Yes

Enterprise Chose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Node The node for which the report
is generated.

If you are an enterprise user,
select the appropriate node
from the drop-down list. For
other users, the current node
of the user appears.

The current node
of the user.

Yes

Figure 36. Returns By Reason Code Report Criteria Screen
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Table 11. Returns By Reason Code Report Criteria Screen (continued)

Field Description Default Value Mandatory

Ship Date Enter the start date and the
end date for which the report
is generated.

You can also click the and

icons to choose the date
range and time.

For Date: The
current date.

For Time: 00:00:00
and 23:59:59.

Yes

Reason Code Select the reason code
captured while creating return
order.

Blank. No

Product Line Select the product line
corresponding to the item on
the return shipment.

Blank. No

Group and Sort Criteria

The Returns By Reason Code Report is grouped by Enterprise Code, Return
Reason, Node, Date, Shipment No. and Group Total (Return Reason Code).

The Return Reason is sorted in descending order, and Enterprise Code, Date,
Shipment No. and Group Total (Return Reason Code) are sorted in ascending
order.

Page Break Criteria

For each new enterprise, the report starts in a new table on another page. The
name of the enterprise is printed at the top of the table.

Additional Setup Required

There is no additional setup required to generate this report.
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Returns By Reason Code Report Layout
This section describes the report layout of the Returns By Reason Code Report.

Fields Description

Return Reason

Figure 37. Returns By Reason Code Report
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This corresponds to the reason why the item is returned.

Node

The node to which the item is returned.

Date

The date of dispatch of the shipment to the user.

Shipment No.

The shipment number of the shipment captured at the time of return order
creation.

Ship From

The customer identifier of the customer who returned the item.

Item ID

The item identifier of the item in the shipment.

Item Description

The description of the item.

PC

The product class to which the item belongs.

UOM

The unit of measure of the item.

Quantity

The quantity of the items in one shipment.

Group Total For Return Reason Code

The total number of shipments returned for a particular enterprise with a
particular reason code.

For example, E1 is the enterprise with return Reason Code Damaged.

Group Total For Enterprise

The total number of shipments summarized by enterprise.

For example, E1 is such an enterprise.

The Returns By Reason Code Report appears in portrait layout.
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Chapter 4. Inventory Reports

Containers Not Having Standard Quantity Report
The Containers Not Having Standard Quantity Report lists all cartons stored in the
warehouse that have less than a case or pallet quantity. This report can be used to
identify opportunities for consolidation.

Intended Audience

Warehouse managers and inventory supervisors use this report to check and see if
the actual quantity in the cases are less or more than the standard quantity. It also
helps to identify the opportunities for consolidation. To access this report, the user
must belong to the data security group representing warehouse managers and
inventory supervisors.

Generate a Containers Not Having Standard Quantity Report
About this task

To generate the Containers Not Having Standard Quantity Report:

Procedure
1. Navigate to Inventory > Container Not Having Std. Qty. Report. The

Containers Not Having Standard Quantity Report criteria screen appears. For
more information about the Containers Not Having Standard Quantity Report
criteria screen, see "Containers Not Having Standard Quantity Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The
Containers Not Having Standard Quantity Report appears.

Containers Not Having Standard Quantity Report Criteria
The Containers Not Having Standard Quantity Report criteria screen enables you
to enter the criteria for which the Containers Not Having Standard Quantity
Report generates.

© Copyright IBM Corp. 2005, 2012 85



Table 12. Containers Not Having Standard Quantity Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report
is generated.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Zone Enter the identifier of the
zone for which the report is
generated.

You can also click to
choose the zone.

Blank. No

Container Type -
Case

Check this box to generate the
report for cases having
quantity less than or more
than the standard quantity.

Selected. Yes

Figure 38. Container Not Having Std. Qty. Report Criteria Screen
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Table 12. Containers Not Having Standard Quantity Report Criteria Screen (continued)

Field Description Default Value Mandatory

Container Type -
Pallet

Check this box to generate the
report for pallets having
quantity less than or more
than the standard quantity.

Selected. Yes

Container Having
more than
case/pallet
quantity

Check this box to view the
Containers Having More Than
Standard Quantity Report,
which enables you to view
containers with more than the
standard quantity.

Selected. Yes

Container Having
less than
case/pallet
quantity

Check this box to view the
Containers Having Less Than
Standard Quantity Report,
which enables you to view
containers with less than the
standard quantity.

Selected. Yes

Note: To generate the report, the user must select one of the options in the
Container Type and the Container Having area.

Select both the options in the Container Having area to view a combined report.
This report enables you to view containers with more than the standard quantity
as well as containers with less than the standard quantity, for each enterprise.

Group and Sort Criteria

The Containers Not Having Standard Quantity Report is grouped by Enterprise
Code, Zone ID, and Item ID.

Enterprise Code, Zone ID, and Item ID are sorted in ascending order.

Page Break Criteria

The Containers Not Having Standard Quantity Report has no page break criteria.

Additional Setup Required

There is no additional setup required to generate this report.

Containers Having More Than Standard Quantity Report
Layout

The Containers Having More than Standard Quantity Report enables you to view
containers that contain more than the standard quantity.
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Field Description

Zone ID

A unique description of the zone where the item is placed.

Figure 39. Containers Having More Than Standard Quantity Report
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Item ID

The identifier of the item in the container.

Item Description

The description of an item.

PC

The product class of the item in the container.

UOM

The unit of measure for the item.

Location ID

The identifier of the location where the item is placed within a particular
zone.

Container Type

The type of container where the item is present.

Container ID

A unique description of the container where the item is present.

Actual Quantity

The actual quantity of the item in the container.

Standard Quantity

The standard quantity of the item in the container.

The Containers Having More Than Standard Quantity Report appears in portrait
layout.

Containers Having Less Than Standard Quantity Report
The Containers Having Less than Standard Quantity Report enables you to view
containers that contain less than the standard quantity.
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Field Description

Zone ID

A unique description of the zone where the item is placed.

Figure 40. Containers Having Less Than Standard Quantity Report
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Item ID

The identifier of the item in the container.

Item Description

The description of an item.

PC

The product class of the item in the container.

UOM

The unit of measure for the item.

Location ID

The identifier of the location where the item is placed within a particular
zone.

Container Type

The type of container where the item is present.

Container ID

A unique description of the container where the item is present.

Actual Quantity

The actual quantity of the item in the container.

Standard Quantity

The standard quantity of the item in the container.

The Containers Having Less Than Standard Quantity Report appears in portrait
layout.

Cycle Count Variance Daily Report
The Cycle Count Variance Daily Report provides cycle count variance information
on a daily basis for a given date range.

Intended Audience

Warehouse managers, inventory supervisors, and as well as the enterprise users
use this report to monitor inventory accuracies with indicators like percentage
variance, variance value in Nodes’ locale currency at an item location level.

Generate a Cycle Count Variance Daily Report
About this task

To generate the Cycle Count Variance Daily Report:

Procedure
1. Navigate to Inventory > Cycle Count Variance Daily Report. The Cycle Count

Variance Daily Report criteria screen appears. For more information about the
Cycle Count Variance Daily Report criteria screen see "Cycle Count Variance
Daily Report Criteria".
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2. Enter the criteria and click Generate Report. The Cycle Count Variance Daily
Report appears. For more information about the Cycle Count Variance Daily
Report layout, see "Cycle Count Variance Daily Report Layout".

Cycle Count Variance Daily Report Criteria
The Cycle Count Variance Daily Report criteria screen enables you to enter the
criteria for which the Cycle Count Variance Daily Report generates.

Table 13. Cycle Count Variance Daily Report Criteria Screen

Field Description Default Value Mandatory

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Chose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

.
Figure 41. Cycle Count Variance Daily Criteria Screen
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Table 13. Cycle Count Variance Daily Report Criteria Screen (continued)

Field Description Default Value Mandatory

Node The node for which the report
is generated.

If you are an enterprise user,
select the appropriate node
from the drop-down list. For
other users, the current node
of the user appears.

The current node
of the user.

Yes

Date Range Enter the start date and the
end date for which the report
is generated.

You can also click the
icons to choose the date
range.

The current date. Yes

Zone Enter the identifier of the
zone for which the report is
generated.

You can also click to
choose the zone.

The current zone
of the user.

Yes

Velocity Code Select the Velocity Code from
the drop-down menu.

Blank. No

Product Line Select the product line from
the drop-down menu.

Blank. No

Group and Sort Criteria

The Cycle Count Variance Daily Report is grouped by Date, Enterprise Code, Item
ID, and UOM.

The Date and Enterprise Code are sorted in ascending order. Within a specific
Date, the Item ID is sorted in ascending order and within a specific Item ID, the
UOM is sorted in ascending order.

Page Break criteria

The Cycle Count Variance Daily Report has no page break criteria.

Additional Setup Required

There is no additional setup required to generate this report.
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Cycle Count Variance Daily Report Layout
This section describes the layout of the Cycle Count Variance Daily Report.

Figure 42. Cycle Count Variance Daily Report
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Field Description

Node

The node for which the report is generated.

Date

The date on which the counting task takes place.

Item ID

The identifier of the item.

Item Description

The description of the item.

PC

The product class to which the item belongs.

UOM

The unit of measure for the item.

Location ID

The identifier of the location where the item is placed.

Container Type

The type of container in which the item is placed.

Container No.

The container identifier of the shipment in which the item is placed.

System Quantity

The quantity of the item as recorded in the system.

Count Quantity

The actual quantity counted by the user.

Variance Quantity

The difference between the System Quantity and the Count Quantity.

Absolute Variance Quantity

The absolute of variance quantity.

Even when the Variance Quantity is negative, the Absolute Variance
Quantity is considered to be positive.

% Variance

If System Quantity is zero than % Variance is 100.

If System Quantity is not zero than % Variance is calculated as follows:

% Variance = (Absolute Variance Quantity / System Quantity) x 100.

Accuracy

If Count Quantity is zero than Accuracy is zero.

If Count Quantity is not zero than Accuracy is calculated as follows:

Accuracy = (Count Quantity / System Quantity) x 100.

Variance Value
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The product of the unit cost of the item and the absolute variance quantity.

Variance Currency

The currency of Variance Value.

Report Totals: The report total displays the summary of Location IDs, System
Quantities, Count Quantities, Variance Quantities, and the Variance Values
considering all the items.

The Cycle Count Variance Daily Report appears in portrait layout.

Cycle Count Variance Monthly Report
The Cycle Count Variance Daily Report provides cycle count variance information
on a monthly basis for a given date range.

Intended Audience

Warehouse managers, inventory supervisors, and enterprise users use this report to
monitor inventory accuracies with indicators like percentage variance, variance
value in Nodes’ locale currency at an item location level.

Generate a Cycle Count Variance Monthly Report
About this task

To generate the Cycle count Variance Monthly Report:

Procedure
1. Navigate to Inventory > Cycle Count Variance Monthly Report.The Cycle

Count Variance Monthly Report criteria screen appears. For more information
about the Cycle Count Variance Monthly Report criteria screen, see "Cycle
Count Variance Monthly Report Criteria".

2. Enter the criteria and click Generate Report. The Cycle Count Variance Monthly
Report screen appears. For more information about the Cycle Count Variance
Monthly Report layout, see "Cycle Count Variance Monthly Report Layout".

Cycle Count Variance Monthly Report Criteria
The Cycle Count Variance Monthly Report criteria screen enables you to enter the
criteria for which the Cycle Count Variance Monthly Report generates.
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Table 14. Cycle Count Variance Monthly Report Criteria Screen

Field Description Default Value Mandatory

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Node The node for which the report
is generated.

If you are an enterprise user,
select the appropriate node
from the drop-down list. For
other users, the current node
of the user appears.

The current node
of the user.

Yes

Date Range Enter the start date and the
end date for which the report
is generated.

You can also click the
icons to choose the date
range.

The previous
month’s date and
current date.

Yes

Figure 43. Cycle Count Variable Monthly Report Criteria Screen
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Table 14. Cycle Count Variance Monthly Report Criteria Screen (continued)

Field Description Default Value Mandatory

Zone Enter the identifier of the
zone for which the report is
generated.

You can also click to
choose the zone.

Blank. No

Velocity Code Select the velocity code from
the drop-down menu.

Blank. No

Product Line Select the product line from
the drop-down menu.

Blank. No

Group and Sort Criteria

The Cycle Count Variance Monthly Report has no group criteria or sort criteria.

Page Break Criteria

The Cycle Count Variance Monthly Report has no page break criteria.

Additional Setup Required

There is no additional setup required to generate this report.
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Cycle Count Variance Monthly Report Layout
This section describes the report of the Cycle Count Variance Monthly Report.

Figure 44. Cycle Count Variance Monthly Report
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Field Description

Node

The node for which the report is generated.

Month Begins On

The date on which the count task begins.

Month Ends On

The date on which the month ends along with the count task.

Locations Counted

The number of locations for which the count task was performed.

Locations With Variance

The locations which showed variance.

System Quantity

The quantity defined with the Selling and Fulfillment Foundation.

Count Quantity

The actual quantity counted by the user.

Variance Quantity

The difference between the system quantity and the count quantity.

Absolute Variance Quantity

The sum of absolute of variance quantity.

Even when the Variance Quantity is negative, the Absolute Variance
Quantity is considered to be positive.

% Variance

If System Quantity is zero than Variance percentage is 100.

If System Quantity is not zero than Variance percentage is calculated as
follows:

Variance percentage = (Absolute Variance Quantity / System Quantity)
x 100.

Accuracy

If Count Quantity is zero than Accuracy is 0.

If Count Quantity is not zero than Accuracy is calculated as follows:

Accuracy = (Count Quantity / System Quantity) x 100.

Variance Value

The product of unit cost of the item and the absolute variance quantity.

Variance Currency

The currency of Variance Value.

The Cycle Count Variance Monthly Report appears in portrait layout.
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Cycle Count Variance Weekly Report
The Cycle Count Variance Weekly Report provides cycle count variance
information on a weekly basis for a given date range.

Intended Audience

Warehouse managers, inventory supervisors, and enterprise users use this report to
monitor inventory accuracies with indicators like percentage variance, variance
value in Nodes’ locale currency at an item location level.

Generate a Cycle Count Variance Weekly Report
About this task

To generate the Cycle Count Variance Weekly Report:

Procedure
1. Navigate to Inventory > Cycle Count Variance Weekly Report. The Cycle Count

Variance Weekly Report criteria screen appears. For more information about the
Cycle Count Variance Weekly Report criteria screen, see "Cycle Count Variance
Weekly Report Criteria".

2. Enter criteria and click Generate Report. The Cycle Count Variance Weekly
Report Screen appears. For more information about the Cycle Count Variance
Weekly Report layout, see "Cycle Count Variance Weekly Report Layout".

Cycle Count Variance Weekly Report Criteria
The Cycle Count Variance Weekly Report criteria screen enables you to enter the
criteria for which the Cycle Count Variance Weekly Report generates.

Figure 45. Cycle Count Variance Weekly Criteria Screen
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Table 15. Cycle Count Variance Weekly Criteria Screen

Field Description Default Value Mandatory

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Node The node for which the report
is generated.

If you are an enterprise user,
select the appropriate node
from the drop-down list. For
other users, the current node
of the user appears.

The current node
of the user.

Yes

Date Range Enter the start date and the
end date for which the report
is generated.

You can also click the
icons to choose the date
range.

The previous
week’s date and
current date.

Yes

Zone Enter the identifier of the
zone for which the report is
generated.

You can also click to
choose the zone.

Blank. Yes

Velocity Code Select the velocity code from
the drop-down menu.

Blank. No

Product Line Select the product line from
the drop-down menu.

Blank. No

Group and Sort criteria

The Cycle Count Variance Weekly Report has no group criteria or sort criteria.

Page Break criteria

The Cycle Count Variance Weekly Report has no page break criteria.

Additional Setup Required

There is no additional setup required to generate this report.

102 Sterling Warehouse Management System: Reports Guide



Cycle Count Variance Weekly Report Layout
This section describes the layout of the Cycle Count Variance Weekly Report.

Figure 46. Cycle Count Variance Weekly Report
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Field Description

Node

The node for which the report is generated.

Week Begins On

The date on which the count task begins.

Week Ends On

The date on which the week ends along with the count task.

Locations Counted

The number of locations for which the count task was performed.

Locations With Variance

The locations which showed variance.

System Quantity

The quantity defined with the Selling and Fulfillment Foundation.

Count Quantity

The actual quantity counted by the user.

Variance Quantity

The difference between the system quantity and the count quantity.

Absolute Variance Quantity

The sum of absolute of variance quantity.

Even when the Variance Quantity is negative, the Absolute Variance
Quantity is considered to be positive.

% Variance

If System Quantity is zero than Variance percentage is 100.

If System Quantity is not zero than Variance percentage is calculated as
follows:

Variance percentage = (Absolute Variance Quantity / System Quantity)
x 100.

Accuracy

If Count Quantity is zero than Accuracy is 0.

If Count Quantity is not zero than Accuracy is calculated as follows:

Accuracy = (Count Quantity / System Quantity) x 100.

Variance Value

The product of the unit cost of the item and the absolute variance quantity.

Variance Currency

The currency of Variance Value.

The Cycle Count Variance Weekly Report appears in portrait layout.
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Dedicated Locations Usage Report
The Dedicated Locations Usage Report provides visibility into locations that are
dedicated for certain Stock Keeping Units (SKUs). The usage report shows the
locations that have remained unused in different time buckets.

Intended Audience

Warehouse managers and inventory supervisors use this report to track the
number of locations that are left unused. To access this report, the user must
belong to the data security group representing warehouse managers and inventory
supervisors.

Generate a Dedicated Locations Usage Report
About this task

To generate the Dedicated Locations Usage Report:

Procedure
1. Navigate to Inventory > Dedicated Locations Usage Report. The Dedicated

Locations Usage Report criteria screen appears. For more information about the
Dedicated Locations Usage Report criteria screen, see "Dedicated Locations
Usage Report Criteria".

2. Enter the criteria and click Generate Report. The Dedicated Locations Usage
Report Screen appears. For more information about the Dedicated Locations
Usage Report layout, see "Dedicated Locations Usage Report Layout".

Dedicated Locations Usage Report Criteria
The Dedicated Locations Usage Report criteria screen enables you to enter the
criteria for which the Dedicated Locations Usage Report generates.

Table 16. Dedicated Locations Usage Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report
is generated.

The current node
of the user.

Yes

Figure 47. Dedicated Locations Usage Report Criteria Screen
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Table 16. Dedicated Locations Usage Report Criteria Screen (continued)

Field Description Default Value Mandatory

Zone Enter the zone for which the
report is generated.

You can also click to
choose the zone.

Click to enter more zones.
These zones are taken into
consideration while
generating the report.

Click to remove a specific
zone.

Blank. No

Group and Sort Criteria

The Dedicated Locations Usage Report is grouped by Zone ID.

The Zone ID is sorted in descending order.

Page Break Criteria

The Dedicated Locations Usage Report has no page break criteria.

Additional Setup Required

There is no additional setup required to generate this report.

Dedicated Locations Usage Report Layout
This section describes the layout of the Dedicated Locations Usage Report.
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Note: Based on the number of days for which locations are unused in a
warehouse, the Dedicated Locations Usage Report displays one or more of the
following columns:

Figure 48. Dedicated Locations Usage Report
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v No. of Locations Unused for more than 7 days
v No. of Locations Unused for more than 15 days
v No. of Locations Unused for more than 30 days
v No. of Locations Unused for more than 90 days

Field Description

Zone ID

A unique description of the zone.

No. of Dedicated Locations

The total number of dedicated locations.

Click this to view the Dedicated Locations Summary Report.

No. of Locations Unused for more than 7 days

The total number of locations that have not been used for more than seven
days.

Click this to view the Dedicated Locations Unused for More Than 7 Days,
which displays the details of the locations which have not been used for
more than 7 days.

No. of Locations Unused for more than 15 days

The total number of locations which have not been used for more than
fifteen days.

Click this to view Dedicated Locations Unused for More Than 15 Days,
which displays the details of the locations which have not been used for
more than 15 days.

No. of Locations Unused for more than 30 days

The total number of locations which have not been used for more than
thirty days.

Click this to view Dedicated Locations Unused for More Than 90 Days,
which displays the details of the locations which have not been used for
more than 30 days.

No. of Locations Unused for more than 90 days

The total number of locations which have not been used for more than
ninety days.

Click this to view Dedicated Locations Unused for More Than 30 Days,
which displays the details of the locations which have not been used for
more than 90 days.

The Dedicated Locations Usage Report appears in portrait layout.

Dedicated Locations Summary Report Layout
The Dedicated Locations Summary Report explains the number of active locations
and the number of locations used at different intervals.
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Field Description

Figure 49. Dedicated Locations Summary Report
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Regions of this color indicates the number of locations that are unused for
more than 30 days.

In the above example, the number of locations that are unused for more
than 30 days is 1.

Regions of this color indicates the number of locations that are unused for
more than 7 days.

In the above example, the number of locations that are unused for more
than 7 days is 1.

Regions of this color indicates the number of locations that are unused for
more than 90 days.

In the above example, number of locations that are unused for more than
90 days is 1.

The Dedicated Locations Summary Report appears in portrait layout.

Group and Sort Criteria

The Dedicated Locations Summary Report has no group criteria and sort criteria.

Page Break Criteria

The Dedicated Locations Summary Report has no page break criteria.

Dedicated Locations Unused for More Than 7 Days
This report provides details about the dedicated locations which are unused for
more than 7 days.

The fields, layout, group and sort criteria and page break criteria of this report are
similar to the Dedicated Locations Unused for More Than 30 Days.

Dedicated Locations Unused for More Than 15 Days
This report provides details about the dedicated locations which are unused for
more than 15 days.

The fields, layout, group and sort criteria and page break criteria of this report are
similar to the Dedicated Locations Unused for More Than 30 Days.

Dedicated Locations Unused for More Than 30 Days
This report provides details about the dedicated locations which are unused for
more than 90 days.

Report Layout

This section describes the layout of the Dedicated Locations Unused for Different
Intervals.
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Field Description

Last Activity Date

Figure 50. Dedicated Locations Unused for More Than 30 Days
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The date on which the activity was last performed.

Location ID

The identifier of the location where the items are placed.

Item ID

The identifier of the item.

Item Description

The description of the item.

PC

The product class to which the item belongs

UOM

The unit of measure for the item.

Inventory Organization Code

The Inventory Organization Code.

The Dedicated Locations Unused For More Than 30 Days appears in portrait
layout.

Group and Sort Criteria

This report is grouped by Last Activity Date, Location ID, Item ID, and Item
Description.

Last Activity Date and Location ID are sorted in ascending order. Within Location
ID, the Item ID and Item Description are sorted in ascending order.

Page Break Criteria

This report has no page break criteria.

Dedicated Locations Unused for More Than 90 Days
This report provides details about the dedicated locations which are unused for
more than 30 days.

The fields, layout, group and sort criteria and page break criteria of this report are
similar to the Dedicated Locations Unused for More Than 30 Days.

Dedicated Locations Activity Report
The Dedicated Locations Activity Report provides visibility into locations that are
dedicated for certain Stock Keeping Units (SKUs). The activity report categorizes
the locations based on the number of times that the location is replenished.

Intended Audience

Warehouse managers, inbound supervisors, inventory supervisors, and outbound
supervisors use this report to track locations that are dedicated to certain Stock
Keeping Units. To access this report, the user must belong to the data security
group representing warehouse managers.
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Generate Dedicated Locations Activity Report
About this task

To generate the Dedicated Locations Activity Report:

Procedure
1. Navigate to Inventory > Dedicated Locations Activity Report. The Dedicated

Locations Activity Report criteria screen appears. For more information about
the Dedicated Locations Activity Report criteria screen, see "Dedicated
Locations Activity Report Criteria".

2. Enter the criteria and click Generate Report. The Dedicated Locations Activity
Report appears. For more information about the Dedicated Locations Activity
Report, see "Dedicated Locations Activity Report Layout".

Dedicated Locations Activity Report Criteria
The Dedicated Locations Activity Report criteria screen enables you to enter the
criteria for which the Dedicated Locations Activity Report generates.

Table 17. Dedicated Locations Activity Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report
is generated.

The current node
of the user.

Yes

Zone Enter the zone for which the
report is generated.

You can also click to
choose the zone.

Click to enter more zones.
These zones are taken into
consideration while
generating the report.

Click to remove a specific
zone.

Blank. No

Display
Replenishment for
Past Days

Enter the number of past days
to display replenishment.

90. Yes

Figure 51. Dedicated Locations Activity Report Criteria Screen
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Group and Sort Criteria

The Dedicated Locations Activity Report is grouped by zone.

The zone is sorted in ascending order.

Page Break Criteria

The Dedicated Locations Activity Report has no page break criteria.

Additional Setup Required

There is no additional setup required to generate this report.

Dedicated Locations Activity Report Layout
This section describes the layout of the Dedicated Locations Activity Report.
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Field Description

Zone

Figure 52. Dedicated Locations Activity Report

Chapter 4. Inventory Reports 115



The zone where the items are present.

No. Of Dedicated Locations

The total number of dedicated locations.

Click this to see the Dedicated Locations Activity Summary Report, which
displays the summary of all the locations dedicated for certain SKUs.

No. of Locations with Replenishment 1-5

The number of locations with replenishments between 1 and 5.

Click this to see the Dedicated Location Activity Detail Report, Locations
With Replenishment 1-5, which provides details of the locations with
replenishment between 1 and 5.

No. of Locations with Replenishment 6-10

The number of locations with replenishments between 6 and 10.

Click this to see the Dedicated Location Activity Detail Report, Locations
With Replenishment 6-10, which provides details of the locations with
replenishment between 6 and 10.

No. of Locations with Replenishment 11-25

The number of locations with replenishments between 11 and 25.

Click this to see the Dedicated Location Activity Detail Report, Locations
With Replenishment 11-25, which provides details of the locations with
replenishment between 11 and 25.

No. of Locations with Replenishment > 25

The number of locations with replenishments greater than 25.

Click this to see the Dedicated Location Activity Detail Report, Locations
With Replenishment >25, which provides details of the locations with
replenishment greater than 25.

The Dedicated Locations Activity Report appears in portrait layout.

Dedicated Locations Activity Summary Report
The Dedicated Locations Activity Summary Report provides details of the number
of locations that have replenishments in different ranges.

Report Layout

This section describes the layout of the Dedicated Locations Activity Summary
Report.
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Field Description

Location ID

Figure 53. Dedicated Locations Activity Summary Report
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The identifier of the location.

Available Volume

The volume available for the items to be placed in a particular location
within a particular zone.

Volume UOM

The unit of measure of volume.

Available Weight

The difference between the maximum weight that the location can
withstand and the total weight of the items present in that location.

Weight UOM

The unit of measure of weight.

Enterprise

The enterprise for which the report is generated.

Item ID

The identifier of the item.

Item Description

The description of the item.

UOM

The unit of measure for the item.

PC

The product class to which the item belongs.

The Dedicated Locations Activity Summary Report appears in portrait layout

Group and Sort Criteria

The Dedicated Locations Activity Summary Report is grouped by Location ID.

The Location ID is sorted in ascending order.

Page Break Criteria

The Dedicated Locations Activity Summary Report has no page break criteria.

Dedicated Location Activity Detail Report, Locations With
Replenishment 1-5

The Dedicated Locations Activity Report, Locations With Replenishment 1-5
provides details of the locations that have replenishments in the range of 1-5.

Report Layout

This section describes the layout of the Dedicated Locations Activity Detail Report,
Locations With Replenishment 1-5.
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Field Description

Location ID

Figure 54. Dedicated Locations Activity Detail Report, Locations With Replenishment 1-5
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The identifier of the location.

Enterprise

The enterprise for which the report is generated.

Item ID

The identifier of the item.

Item Description

The description of the item.

PC

The product class to which the item belongs.

UOM

The unit of measure for the item.

The Dedicated Locations Activity Detail Report, Locations With Replenishment 1-5
appears in portrait layout.

Group and Sort Criteria

The Dedicated Locations Activity Report, Locations With Replenishment 1-5 is
grouped by Location ID.

The Location ID is sorted in ascending order.

Page Break Criteria

The Dedicated Locations Activity Report, Locations With Replenishment 1-5 has no
page break criteria.

Dedicated Location Activity Detail Report, Locations With
Replenishment 6-10

The Dedicated Locations Activity Report, Locations With Replenishment 6-10
provides details of the locations that have replenishments in the range of 6-10.

The fields, layout, group and sort criteria, and page break criteria of this report are
similar to the Dedicated Location Activity Detail Report, Locations With
Replenishment 1-5.

Dedicated Location Activity Detail Report, Locations With
Replenishment 11-25

The Dedicated Locations Activity Report, Locations With Replenishment 11-25
provides details of the locations that have replenishments in the range of 11-25.

The fields, layout, group and sort criteria, and page break criteria of this report are
similar to the Dedicated Location Activity Detail Report, Locations With
Replenishment 1-5.
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Dedicated Location Activity Detail Report, Locations With
Replenishment >25

The Dedicated Locations Activity Report, Locations With Replenishment > 25
provides details of the locations that have replenishments in the range > 25.

The fields, layout, group and sort criteria, and page break criteria of this report are
similar to the Dedicated Location Activity Detail Report, Locations With
Replenishment 1-5.

Empty Location Report
The Empty Location Report displays the list of empty locations in the warehouse.
This report can also be accessed as a sub-report from the Space Utilization Report.

Intended Audience

Warehouse managers and inventory supervisors use Empty Location Report to
check for any changes in the inventory due to transactions. The report is generated
manually.

Generate an Empty Location Report
About this task

To generate an Empty Location Report:

Procedure
1. Navigate to Inventory > Empty Location Report. The Empty Location Report

criteria screen appears. For more information about the Empty Location Report
criteria screen, see "Empty Location Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The Empty
Location Report appears. For more information about the Empty Location
Report layout, see "Empty Location Report Layout".

Empty Location Report Criteria
The Empty Location Report criteria screen enables you to enter the criteria for
which the Empty Location Report generates.

Figure 55. Empty Location Report Criteria screen

Chapter 4. Inventory Reports 121



Table 18. Empty Location Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report
is generated.

The current node
of the user.

Yes

Zone Enter the zone for which the
report is generated.

You can also click to
choose the zone.

Click to enter more zones.
These zones are taken into
consideration while
generating the report.

Click to remove the
specific zone.

Blank. No

Location Size
Code

Enter the size code of the
location.

Click to enter more
location size codes. These size
codes are taken into
consideration while
generating the report.

Click to remove a specific
size code.

Blank. No

Group and Sort Criteria

The Empty Location Report is grouped by Location Type.

The report is sorted by Location Type, Location ID, and Location Size Code in
ascending order.

Page Break Criteria

The Empty Location Report has no page break criteria.

Additional Setup Required

There is no additional setup required to generate this report.
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Empty Location Report Layout
This section describes the layout of the Empty Location Report.

Figure 56. Empty Location Report
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Field Definition

Location Type

The type specified for a location which indicates the purpose the location
serves.

Location ID

The identifier of the location.

Location Size Code

The code which represents the storage capacity of the location.

Aisle Number

The number of the aisle in which the empty locations exist.

Level Number

The number of the level in which the empty locations exist.

Bay Number

The number of the bay in which the empty locations exist.

Current Available Volume

The volume of the location available for usage.

Pend In Volume

Volume of items awaited in the near future for that particular location.

Net Available Volume

The actual volume available for usage.

The Empty Location Report appears in portrait layout.

Inventory Aging Report
The Inventory Aging Report provides the inventory age identified by its receipt
date. In case the receipt date information is lost, the inventory age cannot be
ascertained and is therefore classified as "Inventory with Unknown Age". The
number of columns in the report varies with the number of items in the inventory
based on their age.

Intended Audience

Warehouse managers and inventory supervisors use this report to identify the age
of the inventory by its receipt date. To access this report, the user must belong to
the data security group representing warehouse managers.

Generate an Inventory Aging Report
To generate the Inventory Aging Report

About this task

Procedure
1. Navigate to Inventory > Inventory Aging Report. The Inventory Aging Report

criteria screen appears. For more information about The Inventory Aging
Report criteria screen, see "Inventory Aging Report Criteria".
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2. Enter the criteria and click Generate Report to generate the report. The
Inventory Aging Report appears. For more information about the layout of the
Inventory Aging Report, see "Inventory Aging Report Layout".

Inventory Aging Report Criteria
The Inventory Aging Report criteria screen enables you to enter the criteria for
which the Inventory Aging Report generates.

Table 19. Inventory Aging Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report
is generated.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Figure 57. Inventory Aging Report Criteria Screen
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Table 19. Inventory Aging Report Criteria Screen (continued)

Field Description Default Value Mandatory

Product Class The product class of the item.

You can select the product
class from the drop-down
menu.

Click to enter more
product class. These product
class are taken into
consideration while
generating the report.

Click to remove the
specific product class.

Blank. No

Product Line The product line of the item.

You can select the product
line from the drop-down
menu.

Click to enter more
product line. These product
line are taken into
consideration while
generating the report.

Click to remove the
specific product line.

Blank. No

Note: If this report has been executed using the default report criteria parameters,
there may be a delay in fetching data. Therefore, it is recommended that you
update the report criteria such that only the required data is fetched.

Group and Sort Criteria

The Inventory Aging Report is grouped by Cost currency, Product line, Item ID,
UOM and Product Class.

The Cost Currency, Product Line, Item ID, UOM and Product Class are sorted in
ascending order.

Page Break criteria

The Inventory Aging Report has no page break criteria.

Inventory Aging Report Layout
This section describes the layout of the Inventory Aging Report.
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Note: Based on the age of the inventories available in the warehouse, the
Inventory Aging Report displays one or more of the following columns:
v Inventory Age Less than 1 Month

Figure 58. Inventory Aging Report
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v Inventory Age More than 1 Month
v Inventory Age More than 2 Months
v Inventory Age More than 3 Months
v Inventory Age Unknown

Field Description

Currency

The currency in which the item is priced.

Product Line

The product line in which the item is present.

Item ID

The identifier of the item.

Item Description

The description of the item.

PC

The product class to which the item belongs.

UOM

The unit of measure for the item.

Field Description

Quantity

The quantity of inventory aging less than 1 month.

Click this to view the Inventory Aging Detail Report for Inventory Aging
Less than One Month.

Value

The value of the item.

# of Locations

The number of locations for an item in the inventory.

Field Description

Quantity

The quantity of inventory aging more than 1 month.

Click this to view the Inventory Aging Detail Report for Inventory Aging
More Than One Month.

Value

The value of the item.

# of Locations

The number of locations for an item in the inventory.

Field Description

Quantity

The quantity of inventory with unknown age.
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Click this to view the Inventory Aging Detail Report for Unknown
Inventory Age.

Value

The value of the item.

# of Locations

The number of locations for an item in the inventory.

Field Description

Quantity

The quantity of total inventory.

Value

The value of the item.

# of Locations

The number of locations for an item in the inventory.

The Inventory Aging Report appears in portrait layout.

Inventory Aging Detail Report for Inventory Aging Less than
One Month

The Inventory Aging Detail Report for Inventory Aging Less than 1 Month
explains in detail about the Inventory Aging less than a month.

Report Layout

This section describes the layout of the Inventory Aging Report.
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Field Description

Receipt Date

Figure 59. Inventory Aging Detail Report for Inventory Aging Less than 1 month
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The date on which the item was received.

Item ID

The identifier of the item.

Item Description

The description of the item.

Product Class

The product class to which the item belongs.

UOM

The unit of measure for the item.

Location ID

A unique description of the location.

Quantity

The quantity of the item within that location.

The Inventory Aging Report for Inventory Aging Less than 1 Month appears in
portrait layout.

Group and Sort Criteria

The Inventory Aging Report for Inventory Aging Less than 1 Month is grouped by
Receipt Date, Item ID, UOM, Short Description, and Location ID.

The Receipt Date is sorted in descending order.

Page Break Criteria

The Inventory Aging Report for Inventory Aging Less than 1 Month has no page
break criteria.

Additional Setup Required

There is no additional setup required to generate this report.

Inventory Aging Detail Report for Inventory Aging More Than
One Month

The Inventory Aging Detail Report for Inventory Aging More than 1 Month Report
explains in detail about the items in the inventory whose age is more than 1
month.

The fields, layout, group and sort criteria and page break criteria of this report are
similar to the Inventory Aging Detail Report for Inventory Aging Less than One
Month.

Inventory Aging Detail Report for Unknown Inventory Age
The Inventory Aging Detail report for Unknown Inventory Age report explains in
detail about the items in the inventory whose age is unknown.
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The fields, layout, group and sort criteria and page break criteria of this report are
similar to the Inventory Aging Detail Report for Inventory Aging Less than One
Month.

Inventory Audit Report
The Inventory Audit Report enables you to track inventory changes resulting from
the execution of tasks in the warehouse. This report helps you track changes to
item or location inventory, inventory changes done by a user, or a combination of
these.

Intended Audience

Warehouse managers and inventory supervisors use the Inventory Audit Report to
check for any changes in the inventory due to transactions. The report is generated
manually.

Generate an Inventory Audit Report
About this task

To generate the Inventory Audit Report:

Procedure
1. Navigate to Inventory > Inventory Audit Report. The Inventory Audit Report

criteria screen appears. For more information about the Inventory Audit Report
criteria screen, see "Inventory Audit Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The
Inventory Audit Report appears. For more information about the Inventory
Audit Report layout, see "Inventory Audit Report Layout".

Inventory Audit Report Criteria
The Inventory Audit Report criteria screen enables you to enter the criteria for
which the Inventory Audit Report generates.
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Table 20. Inventory Audit Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report is
generated.

The current node
of the user.

Yes

Enterprise Choose this to generate the report
for a specific enterprise and select
the enterprise name from the
drop-down list.

Note: It is mandatory to select any
one of the radio buttons to execute
the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Figure 60. Inventory Audit Report Criteria Screen
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Table 20. Inventory Audit Report Criteria Screen (continued)

Field Description Default Value Mandatory

Across
Enterprises

Choose this to generate the report
considering all the enterprises in
which the user participates.

Note: It is mandatory to select any
one of the radio buttons to execute
the report.

Selected. No

Audit Date Enter the start date, end date and
the time period for which the report
is generated.

You can also click the and
icons to choose the date range and
time.

The current date.

The time is
00:00:00 and
23:59:59.

Yes

Zone Enter the zone for which the report
is generated.

You can also click to choose
zone.

Click to enter more zones. These
zones are taken into consideration
while generating the report.

Click to remove a specific zone.

Blank. No

Location Enter the location for which the
report is generated.

You can also click to choose
location.

Click to enter more locations.
These locations are taken into
consideration while generating the
report.

Click to remove a specific
location.

Blank. No

Item ID Enter the identifier of the item.

You can also click to choose Item
ID.

Click to enter more Item IDs.
These Item IDs are taken into
consideration while generating the
report.

Click to remove a specific Item
ID.

Blank. No
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Table 20. Inventory Audit Report Criteria Screen (continued)

Field Description Default Value Mandatory

Product Class Select the product class.

Click to enter more product
classes. These product classes are
taken into consideration when
generating the report.

Click to remove a specific
product class.

Blank. No

Unit Of
Measure

Enter the unit of measure of the
item.

You can also select the UOM from
the drop-down menu.

Blank No

User ID The identifier of the user who has
made the changes to the inventory.

You can also click to choose User
ID.

Click to enter more User IDs.
These User IDs are taken into
consideration while generating the
report.

Click to remove a specific User
ID.

Blank. No

Activity Type Select Return to generate the report
for the returned shipment.

Select Receipt to generate the report
for the received shipment.

Select Shipment to generate the
report for the outbound shipment.

Select Adjustment to generate report
for the inventory adjusted in the
warehouse.

Blank. No

Audit Type Select the audit type from the
drop-down menu.

Blank. No

Task Type Select the task type from the
drop-down menu.

Blank. No

Adjustment
Reason Code

Enter the reason for the adjustment
of the inventory.

You can also click to choose
reason code.

Click to enter more reason codes.
These reason codes are taken into
consideration while generating the
report.

Click to remove the specific
reason code.

Blank. No
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Group and Sort Criteria

The Inventory Audit Report is grouped by Enterprise Code, Transaction Date and
Location ID.

The Enterprise Code, Transaction Date, and Location ID are sorted in ascending
order. Within a specific Location ID, the items are sorted by Item ID, in ascending
order.

Page Break Criteria

For each new enterprise, the report starts in a new table on another page. The
name of the enterprise is printed at the top of the table.

Additional Setup Required

There is no additional setup required to generate this report.
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Inventory Audit Report Layout
This section describes the report layout of the Inventory Audit Report.

Figure 61. Inventory Audit Report
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Field Description

Transaction Date

The date of the transaction.

Location ID

The identifier of the location of transaction.

Item ID

The identifier of the item.

Item Description

The description of the item.

UOM

The unit of measure for the item.

PC

The product class of the item.

Activity Type

The type of transaction.

User ID

The identifier of the user.

Quantity

The quantity of the item in the location.

Container Type

The type of container used to pack the items of the shipment.

The typical container type is case or pallet.

Container No

The number of the container in which the item is stored.

Reason Code

The reason code for the adjustment made.

The Inventory Audit Report appears in portrait layout.

Inventory Balance Report
The Inventory Balance Report is used to balance the opening and closing quantity
of the inventory for an item, within a specified date range. The opening balance
and closing balance are printed, along with the receipts, returns, adjustments, and
shipments made within the specified date range. This report provides a high-level
view of the Item velocity at the shipment and receipt levels.

Intended Audience

The warehouse managers, inventory supervisors, and enterprise users use the
Inventory Balance Report to reconcile inventory by comparing it with the
transactions for the day. To access this report, the user must belong to the data
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security group representing warehouse managers, inventory supervisors, or
enterprise users.

Generate an Inventory Balance Report
About this task

To generate the Inventory Balance Report:

Procedure
1. Navigate to Inventory > Inventory Balance Report. The Inventory Balance

Report criteria screen appears. For more information about the Inventory
Balance Report criteria screen, see "Inventory Balance Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The
Inventory Balance Report appears. For more information about the Inventory
Balance Report layout, see "Inventory Balance Report Layout".

Results

Inventory Balance Report Criteria

The Inventory Balance Report criteria screen enables you to enter the criteria for
which the Inventory Balance Report generates.

Table 21. Inventory Balance Report Criteria Screen

Fields Description Default Value Mandatory

Node The node for which the
report is generated.

If you are an enterprise
user, select the appropriate
node from the drop-down
list. For other users, the
current node of the user
appears.

The current node
of the user.

Yes

Figure 62. Inventory Balance Report Criteria Screen
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Table 21. Inventory Balance Report Criteria Screen (continued)

Fields Description Default Value Mandatory

Enterprise Chose this to generate the
report for a specific
enterprise and select the
enterprise name from the
drop-down list.

Note: It is mandatory to
select any one of the radio
buttons to execute the
report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the default
enterprise.

No

Across
Enterprises

Choose this to generate the
report considering all
enterprises in which the
user participates.

Note: It is mandatory to
select any one of the radio
buttons to execute the
report.

Selected. No

Date Range Enter the start date and the
end date for which the
report is generated.

You can also click the
icons to choose the date
range.

The current date. Yes

Item ID Enter the identifier of the
item.

You can click to choose
the Item ID.

Click to enter more Item
IDs. These Item IDs are
taken into consideration
while generating the report.

Click to remove a
specific Item ID.

Blank. No

Product Line Enter the product line to
which the item belongs.

You can also select the
product line from the
drop-down menu.

Click to enter more
product lines. These product
lines are taken into
consideration while
generating the report.

Click to remove a
specific product line.

Blank. No

Group and Sort Criteria
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This report is grouped by Date and Node.

Date is sorted in descending order and Node is sorted in ascending order. Within a
specific Node, the items are sorted by Item ID, in ascending order.

Page Break Criteria

For each new enterprise, the report starts in a new table on another page. The
name of the enterprise is printed at the top of the table.

Additional Setup Required

There is no additional setup required to generate this report.

Inventory Balance Report Layout
This section describes the layout of the Inventory Balance Report. In the following
figure, the supply type is ONHAND.
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Fields Description

Date

The date when the receipt or shipment was made.

Node

The node where the receipt or shipment was made.

Figure 63. Inventory Balance Report
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Item ID

The identifier of the item that was received or shipped out.

Item Description

The description of the item.

PC

The product class of the item.

UOM

The unit of measure for the item.

Supply Type

Indicates the availability of the inventory.

Segment Type

The segment types are:

MTC: Made To Customer

MTO: Made To Order

Segment

Inventory set aside to fulfill orders from a specific customer.

Ship By Date

The date by which shipment needs to be shipped from the warehouse.

Tag No.

The tag identifier of the item.

Opening Balance(Qty)

The quantity of the item at the beginning of the day.

Receipts

The quantity of the item received during the day.

Shipments

The quantity of the item shipped during the day.

Adjustments

The quantity of the item adjusted during the day.

Returns

The quantity of the item returned during the day.

Closing Balance(Qty)

The quantity of the item at the end of the day.

The Closing Balance is calculated as follows:

Closing Balance = Opening Balance + Receipts + Adjustments + Returns
- Shipments

The Inventory Balance Report only displays items having at least one transaction
during the day.
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The Inventory Balance Report is displayed in portrait layout.

Inventory Hold Report
The Inventory Hold Report lists the item and location details for all items that are
on hold due to QC activities or Count variances, and locations that are frozen for
Picking or Putaway.

Intended Audience

Warehouse managers and inventory supervisors use the Inventory Hold Report to
get a list of all inventory that is in "HELD" status. The report is generated
manually.

Generate an Inventory Hold Report
About this task

To generate the Inventory Hold Report:

Procedure
1. Navigate to Inventory > Inventory Hold Report. The Inventory Hold Report

criteria screen appears. For more information about the Inventory Hold Report
criteria screen, see "Inventory Hold Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The
Inventory Hold Report appears. For more information about the Inventory
Hold Report layout, see "Inventory Hold Report Layout".

Inventory Hold Report Criteria
The Inventory Hold Report criteria screen enables you to enter the criteria for
which the Inventory Hold Report generates.

Figure 64. Inventory Hold Report Criteria Screen
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Table 22. Inventory Hold Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report
is generated.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons to
execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as the
user’s default
enterprise.

No

Across
Enterprises

Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons to
execute the report.

Selected. No

Zone Enter the zone for which the
report is generated.

You can also click to choose
the zone.

Click to enter more zones.
These zones are taken into
consideration while generating
the report.

Click to remove a specific
zone.

Blank. No

Inventory Status Enter the inventory status of
the items.

You can also select the
inventory status from the
drop-down list.

Blank. No

Inventory Hold
Type For QC
Activities

Check this box to generate a
report for items that are on
hold due to QC activities.

Selected No

Inventory Hold
Type Due to
Count Variance

Check this box to generate a
report for items that are on
hold due to count variance.

Selected No

Inventory Hold
Type On Freeze
for Picking

Check this box to generate a
report for items that are on
freeze for picking.

Selected No

Note: The user must choose at least one Inventory Hold Type for the report to be
generated.

Group and Sort Criteria

The Inventory Hold Report is grouped by Enterprise Code, Zone, and Location.
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The Enterprise Code, Zone, and Location are sorted in ascending order. Within a
specific Location, the items are sorted by Item ID, in ascending order.

Page Break Criteria

The Inventory Hold Report has no page break criteria.

Additional Setup Required

There is no additional setup required to generate this report.
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Inventory Hold Report Layout
This section describes the layout of the Inventory Hold Report.

Figure 65. Inventory Hold Report, For QC Activities
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Field Description

Zone

The zone for which the report is generated.

Location

The location of the items on hold.

Item ID

The identifier of the item which is on hold.

Item Description

The description of the item.

PC

The product class to which the item belongs.

UOM

The unit of measure for the item.

Inventory Status

Status associated with an inventoried item.

Quantity

The quantity of the item on hold.
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Field Description

Zone

The zone for which the report is generated.

Figure 66. Inventory Hold Report, Due to Count Variance
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Location

The location of the items on hold.

Item ID

The identifier of the item which is on hold.

Item Description

The description of the item.

PC

The product class to which the item belongs.

UOM

The unit of measure for the item.

Inventory Status

Status associated with an inventoried item.

Quantity

The quantity of the item on hold.
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Field Description

Zone

The zone for which the report is generated.

Figure 67. Inventory Hold Report, On Freeze for Picking
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Location

The location of the items on hold.

Item ID

The identifier of the item which is on hold.

Item Description

The description of the item.

PC

The product class to which the item belongs.

UOM

The unit of measure for the item.

Inventory Status

Status associated with an inventoried item.

Quantity

The quantity of the item on hold.

The Inventory Hold Report appears in portrait layout.

Item Inventory Across Nodes Report
The Item Inventory Across Nodes Report is used to track the inventory of items
across nodes for either all or selected enterprises. The report can be generated only
for those enterprises to which the user has access.

Note: This report only displays the inventory details of items that are on hand.
Only items with supply type is 'Onhand' are considered.

Intended Audience

Enterprise users use the Item Inventory Across Nodes Report to verify inventory in
a node or across nodes. To access this report, the user must belong to the data
security group representing enterprise users.

Note: This report is accessible only to enterprise users and does not display in the
menu for other users.

Generate an Item Inventory Across Nodes Report
About this task

To generate an Item Inventory Across Nodes Report:

Procedure
1. Navigate to Inventory > Item Inventory Across Nodes Report. The Item

Inventory Across Nodes Report criteria screen appears. For more information
about the Item Inventory Across Nodes Report criteria screen, see "Item
Inventory Across Nodes Criteria".
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2. Enter the criteria and click Generate Report to generate the report. The Item
Inventory Across Nodes Report appears. For more information about the Item
Inventory Across Nodes Report layout, see "Item Inventory Across Nodes
Report Layout".

Item Inventory Across Nodes Report Criteria
The Item Inventory Across Nodes Report criteria screen enables you to enter the
criteria for which the Item Inventory Across Nodes Report generates.

Table 23. Item Inventory Across Nodes Criteria Screen

Field Description Default Value Mandatory

Enterprise Choose this to generate the
report for the user’s default
enterprise.

Note: It is mandatory to
select any one of the radio
buttons to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to
select any one of the radio
buttons to execute the report.

Selected. No

Figure 68. Item Inventory Across Nodes Criteria Screen
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Table 23. Item Inventory Across Nodes Criteria Screen (continued)

Field Description Default Value Mandatory

Node The node for which the
report is generated.

You can also click to
choose the node.

Click to enter more nodes.
These nodes are taken into
consideration while
generating the report.

Click to remove a specific
node.

Blank. Yes

Item ID Enter the identifier of the
item.

You can also click to
choose the Item ID.

Click to enter more Item
IDs. These Item IDs are taken
into consideration while
generating the report.

Click to remove a specific
Item ID.

Blank. No

Product Class Select the product class from
the drop-down list.

Blank No

Product Line Select the product line from
the drop-down list.

Blank No

Group and Sort Criteria

The Item Inventory Across Nodes Report is grouped by Enterprise Code, Item ID,
and Node.

The Enterprise Code, Item ID and Node are sorted in ascending order.

Page Break Criteria

For each new enterprise, the report starts in a new table on another page. The
name of the enterprise is printed at the top of the table.

Additional Setup Required

There is no additional setup required to generate this report.
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Item Inventory Across Nodes Report Layout
This section describes the layout of the Item Inventory Across Nodes Report.

Field Description

Item ID

The identifier of the item.

Item Description

The description of the item.

PC

The product class to which the item belongs.

UOM

The unit of measure for the item.

Node

The selected node or the node to which the items belong.

On Hand Quantity

The current inventory with supply type Onhand.

Allocated Quantity

The quantity of the item allocated for a shipment.

Figure 69. Item Inventory Across Nodes Report
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Available Quantity

The difference between On Hand Quantity and Allocated Quantity.

Unit Cost

The total value of the item.

Value

The total value of the item.

This is computed as the product of Available Quantity and Unit Cost.

Currency

The currency in which the cost and value of the item displays.

Group Total for Item

The total On Hand Quantity, Available Quantity, Value, and Cost Currency
for a particular item.

Group Total for Enterprise

The total On Hand Quantity and Available Quantity for a particular
enterprise.

The Item Inventory Across Nodes Report appears in the landscape layout.

Item Inventory Report
The Item Inventory Report lists the details of the item inventory at the node. You
can drill down to location level and container level reports from this report.

Intended Audience

Warehouse managers and inventory supervisors use the Item Inventory Report to
search inventory details at the node. To access this report, the user must belong to
the data security group representing warehouse managers, or inventory
supervisors.

Generate an Item Inventory Report
About this task

To generate the Item Inventory Report

Procedure
1. Navigate to Inventory > Item Inventory Report. The Item Inventory Report

criteria screen appears. For more information about the Item Inventory Report
criteria screen, see "Item Inventory Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The Item
Inventory Report appears. For more information about the Item Inventory
Report layout, see "Item Inventory Report Layout".

Item Inventory Report Criteria
The Item Inventory Report criteria screen enables you to enter the criteria for
which the Item Inventory Report generates.
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Table 24. Item Inventory Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the
report is generated.

The current node of
the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise
name from the drop-down
list.

Note: It is mandatory to
select any one of the radio
buttons to execute the report.

Not Selected.

On selecting this, the
current enterprise of
the user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to
select any one of the radio
buttons to execute the report.

Selected. No

Item ID Enter the identifier of the
item.

You can also click to
choose the Item ID.

Blank. No

Unit Of Measure Select the UOM of the item
from the drop-down menu.

Blank. No

Product Class Select the product class from
the drop-down menu.

Blank. No

Group and Sort Criteria

The Item Inventory Report is grouped by Enterprise Code.

The Enterprise Code is sorted in ascending order.

Figure 70. Item Inventory Report Criteria Screen
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Within an enterprise, the Item ID is sorted in ascending order.

Page Break Criteria

For each new enterprise, the report starts in a new table on another page. The
name of the enterprise is printed at the top of the table.

Additional Setup Required

There is no additional setup required to generate this report.
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Item Inventory Report Layout
This section describes the layout of the Item Inventory Report.

Field Description

Item ID

Figure 71. Item Inventory Report
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The identifier of the item for the selected location.

Click the Item ID to view the Location Inventory Summary Report.

Item Description

The description of the item.

PC

The product class to which the item belongs.

UOM

The unit of measure for the item.

Inventory Status

Status associated with an inventoried item.

Quantity

The quantity of the item in the warehouse.

The Item Inventory Report appears in portrait layout.

Item Tag No. Report
The Item Tag No. Report lists all item transactions for the given tag number. The
report displays the transactions in three categories: Inbound, Inventory, and
Outbound.

Intended Audience

Warehouse managers, inbound supervisors, outbound supervisors, and inventory
supervisors use the Item Tag No. Report to check on transactions for a particular
tag number. The report is generated manually.

Generate an Item Tag No. Report
About this task

To generate the Item Tag No. Report:

Procedure
1. Navigate to Inventory > Item Tag No. Report. The Item Tag No. Report criteria

screen appears. For more information about the Item Tag No. Report criteria
screen, see "Item Tag No Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The Item
Tag No. Report appears. For more information about the Item Tag No. Report
layout, see "Item Tag No Report Layout".

Item Tag No. Report Criteria
The Item Tag No. Report criteria screen enables you to enter the criteria for which
the Item Tag No. Report generates.
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Table 25. Item Tag No. Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report
is generated.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Item ID Enter the identifier of the
item.

You can also click to
choose the Item ID.

Blank. No

Unit Of Measure Select the UOM of the item
from the drop-down menu.

Blank. No

Tag No. Enter the tag number of the
item.

Blank. No

Figure 72. Item Tag No. Report Criteria Screen
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Table 25. Item Tag No. Report Criteria Screen (continued)

Field Description Default Value Mandatory

Identify_Tag If the item selected is tagged,
click this to display the
Tag-Identifier area which
allows the user to enter the
item attributes.

Blank. No

Tag Identifiers This area enables the user to
enter the tag attribute of the
tag- tracked item. The field is
displayed for the items
tracked with tag attributes.

In the given example, the item
Tag-L-001 is lot- tracked.
Hence the Lot # is displayed
in tag identifier.

Blank. No

Group and Sort Criteria

The Item Tag No. Report, Inbound Report is grouped by Enterprise Code,
Shipment No, Expected Deliver Date, Item ID, and Tag No.

The Enterprise code, Shipment No, Expected Delivery Date, and Item ID are sorted
ascending order.

The Item Tag No. Report, Inventory Report is grouped by Enterprise Code,
Location ID, Item ID, and Tag No.

The Enterprise code, Location ID and Item ID are sorted in ascending order.

The Item Tag No. Report, Outbound Report is grouped by Enterprise Code,
Shipment No, Actual Shipment Date, and Item ID.

The Enterprise code, Shipment No and Item ID are sorted in ascending order and
Actual Shipment Date is sorted in descending order.

Page Break Criteria

For each new enterprise, the report starts in a new table on another page. The
name of the enterprise is printed at the top of the table.

Additional Setup Required

There is no additional setup required to generate this report.
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Item Tag No. Report Layout
This section describes the layout of the Item Tag No. Report.

Figure 73. Item Tag No. Report, Inbound Report
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Field Description

Shipment No.

The shipment number of the inbound shipment.

Expected Delivery Date

The expected date of delivery of the inbound shipment.

Seller

The organization from where the items are shipped.

Item ID

The identifier of the item that is received.

Item Description

The description of the item.

PC

The product class to which the item belongs.

UOM

The unit of measure for the item.

Quantity

The quantity of the item specific to the shipment number.

Tag No.

The tag identifier of the item.
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Field Description

Location ID

Figure 74. Item Tag No. Report, Inventory Report
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The identifier of the locations in the warehouse that have the input tag
number.

Item ID

The identifier of the item.

Item Description

The description of the item.

PC

The product class to which the item belongs.

UOM

The unit of measure for the item.

Quantity

The quantity of the item specific to the shipment number.

Tag No.

The tag identifier of the item.
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Field Description

Shipment No

Figure 75. Item Tag No. Report, Outbound Report
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The shipment number of the outbound shipment.

Actual Ship Date

The actual date of shipment.

Seller

The organization from where the items are shipped.

Item ID

The identifier of the item that is shipped out.

Item Description

The description of the item.

PC

The product class to which the item belongs.

UOM

The unit of measure for the item.

Quantity

The quantity of the item specific to the shipment number.

Tag No.

The tag identifier of the item.

The Item Tag No. Report appears in portrait layout.

Item Velocity Report
Due to changes in demand, seasonal variations, and product lifecycle
characteristics, the item velocity changes over time. The Item Velocity Report
captures the item velocity, as measured by the number of outbound shipments that
the item is featured in, during the selected date range.

Intended Audience

Warehouse managers and inventory supervisors use this report to check if the
items have the right item velocities and change the velocity code, if necessary. This
report is generated manually.

Generate an Item Velocity Report
About this task

To generate the Item Velocity Report:

Procedure
1. Navigate to Inventory > Item Velocity Report. The Item Velocity Report criteria

screen appears. For more information about the Item Velocity Report criteria
screen, see "Item Velocity Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The Item
Velocity Report appears. For more information about the Item Velocity Report
layout, see "Item Velocity Report Layout".
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Item Velocity Report Criteria
The Item Velocity Report criteria screen enables you to enter the criteria for which
the Item Velocity Report generates.

Table 26. Item Velocity Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report
is generated.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Actual Ship Date Enter the start date and the
end date for which the report
is generated.

You can click the icons to
choose the date range.

The current date. Yes

Group and Sort Criteria

The Item Velocity Report is grouped by Enterprise Code, Velocity Code, and
Range.

The Enterprise code, Velocity Code and Range are sorted in ascending order.

Figure 76. Item Velocity Report Criteria Screen
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Page Break Criteria

For each new enterprise, the report starts in a new table on another page. The
name of the enterprise is printed at the top of the table.

Additional Setup Required

There is no additional setup required to generate this report.

Item Velocity Report Layout
This section describes the layout of the Item Velocity Report.
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Field Description

No. of Shipments Featured In

Figure 77. Item Velocity Report
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The shipments containing the items of a particular velocity code. The
shipments are in the range of 1-25, 26-50, 51-75, and Over 76.

A count of the number of items with the specified velocity code is
displayed against the number of shipments containing the items of that
particular velocity code, below the No. Shipments of Featured In.

Click the item count to view the Item Velocity Detail Report.

Velocity Code A

This indicates all the shipments with velocity code A.

Velocity Code B

This indicates all the shipments with velocity code B.

Velocity Code C

This indicates all the shipments with velocity code C.

Not Setup

This indicates the number of items with no velocity code set up.

The Item Velocity Report appears in portrait layout.

Item Velocity Detail Report
This provides the details of the items belonging to a particular velocity code.

Report Layout

This section describes the layout of the Item Velocity Detail Report.
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Field Description

Item ID

Figure 78. Item Velocity Detail Report
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The identifier of the item.

Item Description

The description of the item.

PC

The product class to which the item belongs.

UOM

The unit of measure for the item.

The Item Velocity Detail Report appears in portrait layout.

Group and Sort Criteria

The Item ID is sorted in ascending order.

Page Break Criteria

The Item Velocity Detail Report has no page break criteria.

Location Inventory Detail Report
The Location Inventory Detail Report is used to track the inventory of items and
locations in the warehouse at the item, case, pallet, status, and other item attributes
levels.

Intended Audience

Warehouse managers and inventory supervisors use this report to search inventory
details for zone, location, or item. To access this report, the user must belong to the
data security group representing warehouse managers or inventory supervisors.

Generate a Location Inventory Detail
About this task

To generate the Location Inventory Detail Report:

Procedure
1. Navigate to Inventory > Location Inventory Detail Report. The Location

Inventory Detail Report criteria screen appears. For more information about the
Location Inventory Detail Report criteria screen, see "Location Inventory Detail
Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The Location
Inventory Detail Report appears. For more information about the Location
Inventory Detail Report layout, see "Location Inventory Detail Report Layout".

Location Inventory Detail Report Criteria
The Location Inventory Detail Report criteria screen enables you to enter the
criteria for which the Location Inventory Detail Report generates.
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Table 27. Location Inventory Detail Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report
is generated.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Figure 79. Location Inventory Detail Report Criteria Screen
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Table 27. Location Inventory Detail Report Criteria Screen (continued)

Field Description Default Value Mandatory

Zone Enter the zone for which the
report is generated.

You can also click to
choose the zone.

Blank. No

Location Enter the location for which
the report is generated.

You can also click to
choose the location.

Blank. No

Item ID The identifier of the item.

You can also click to
choose the Item ID.

Blank. No

Unit Of Measure Select the UOM of the item
from the drop-down menu.

Blank. No

Product Class Select the Product Class from
the drop-down menu.

Blank. No

Tag No. The tag number of the items. Blank. No

Identify_Tag If the item selected is tagged,
click this to display the
Tag-Identifier area which
allows the user to enter the
item attributes.

Blank. No

Tag Identifiers This area enables the user to
enter the tag attribute of the
tag- tracked item. The field is
displayed for the items
tracked with tag attributes.

In the given example, the item
Tag-B-001 is batch tracked.
Hence the Batch # is
displayed in tag identifier.

Blank. No

Note: If this report has been executed using the default report criteria parameters,
there may be a delay in fetching data. Therefore, it is recommended that you
update the report criteria such that only the required data is fetched.

Group and Sort Criteria

The Location Inventory Detail Report is grouped by Enterprise Code, Zone ID,
Location ID, Container Type, and Container ID.

The Enterprise code, Zone ID and Location ID are sorted in ascending order.

Page Break Criteria

For each new enterprise, the report starts in a new table on another page. The
name of the enterprise is printed at the top of the table.
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Additional Setup Required

There is no additional setup required to generate this report.
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Location Inventory Detail Report Layout
This section describes the report layout of the Location Inventory Detail Report.

Figure 80. Location Inventory Detail Report
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Field Description

Zone ID

The identifier of the zone in the warehouse.

Location ID

The identifier of the location in the warehouse.

Container Type

The type of container used to pack the items of the shipment.

The typical container type is case or pallet.

Container ID

The identifier of the container in which the item is stored.

Item ID

The identifier of the item.

Item Description

The description of the items.

PC

The product class of the item.

UOM

The unit of measure for the item.

Quantity

The quantity of the items in the location.

Inventory Status

Status associated with an inventoried item.

Tag No.

The tag number of the items.

Serial No.

The serial number of the items.

Quantity

The number of units of the item.

The Location Inventory Detail Report appears in portrait layout.

Location Inventory Summary Report
The Location Inventory Summary Report is used to track the inventory of items
and locations in the warehouse at the item or location level.

Intended Audience

Warehouse managers and inventory supervisors use this report to search inventory
details for zone, location, or item. To access this report, the user must belong to the
data security group representing warehouse managers and inventory supervisors.
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Generate a Location Inventory Summary Report
About this task

To generate the Location Inventory Summary Report:

Procedure
1. Navigate to Inventory > Location Inventory Summary Report. The Location

Inventory Summary Report criteria screen appears. For more information about
the Location Inventory Summary Report criteria screen, see "Location Inventory
Summary Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The Location
Inventory Summary Report appears. For more information about the Location
Inventory Summary Report layout, see "Location Inventory Summary Report
Layout".

Location Inventory Summary Report Criteria
The Location Inventory Summary Report criteria screen enables you to enter the
criteria for which the Location Inventory Summary Report generates.

Table 28. Location Inventory Summary Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report
is generated.

The current node
of the user.

Yes

Figure 81. Location Inventory Summary Report Criteria Screen
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Table 28. Location Inventory Summary Report Criteria Screen (continued)

Field Description Default Value Mandatory

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Zone Enter the zone for which the
report is generated.

You can also click to
choose the zone.

Blank. No

Location Enter the location for which
the report is generated.

You can also click to
choose the location.

Blank. No

Item ID The identifier of the item.

You can also click to
choose the Item ID.

Blank. No

Unit Of Measure Select the UOM of the item
from the drop-down menu.

Blank. No

Product Class Select the product class of the
item from the drop-down list.

Blank. No

Location Inventory Summary Report Layout
This section describes the report layout of the Location Inventory Summary Report.
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Field Description

Zone ID

Figure 82. Location Inventory Summary Report
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The zone for which the report is generated.

Location ID

The location of the item in the warehouse.

Click the hyperlink to view the Location Inventory Detail Report appears.

Item ID

The identifier of the item for which the report is generated.

Item Description

The description of the item.

PC

The product class to which the item belongs.

UOM

The unit of measure for the item.

Quantity

The quantity of the items in the location.

The Location Inventory Summary Report appears in portrait layout.

Group and Sort Criteria

The Location Inventory Summary Report is grouped by Enterprise Code, Zone ID,
Location ID, and Item ID.

The Enterprise code, and Zone ID are sorted in ascending order.

Page Break Criteria

For each new enterprise, the report starts in a new table on another page. The
name of the enterprise is printed at the top of the table.

Additional Setup Required

There is no additional setup required to generate this report.

Location/SKU Velocity Mismatch Report
The Location/SKU Velocity Mismatch Report matches the Location Velocity to the
Item Velocity to identify locations that have a mismatch. The warehouse can use
this report to reorganize item locations to optimize the utilization of locations.

Intended Audience

Warehouse managers and inventory supervisors use this report to reorganize
inventory in the warehouse. This report is generated manually every month.

Generate a Location/SKU Velocity Mismatch Report
About this task

To generate the Location/SKU Velocity Mismatch Report:
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Procedure
1. Navigate to Inventory > Location/SKU Velocity Mismatch Report. The

Location/SKU Velocity Mismatch Report criteria screen appears. For more
information about the Location/SKU Velocity Mismatch Report criteria screen,
see "Location/SKU Velocity Mismatch Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The
Location/SKU Velocity Mismatch Report appears. For more information about
the Location/SKU Velocity Mismatch Report layout, see "Location/SKU
Velocity Mismatch Report Layout".

Location/SKU Velocity Mismatch Report Criteria
The Location/SKU Velocity Mismatch Report criteria screen enables you to enter
the criteria for which the Location/SKU Velocity Mismatch Report generates.

Table 29. Location/SKU Velocity Mismatch Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report
is generated.

The current node
of the user.

Yes

Zone The zone for which the report
is generated.

You can also click to
choose the zone.

Click to enter more zones.
These zones are taken into
consideration while
generating the report.

Click to remove a specific
zone.

Blank. No

Group and Sort Criteria

The Location/SKU Mismatch Report is grouped by Zone ID, Location Velocity and
Item velocity.

The Zone ID, Location Velocity, and Item Velocity are sorted in ascending order.

Page Break Criteria

The Location/SKU Mismatch Report has no page break criteria.

Figure 83. Location/SKU Velocity Mismatch Criteria Screen
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Additional Setup Required

There is no additional setup required to generate this report.

Location/SKU Velocity Mismatch Report Layout
This section describes the layout of the Location/SKU Velocity Mismatch Report.
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Field Description

Zone ID

Figure 84. Location/SKU Velocity Mismatch Report
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The zone for which the report is generated.

Location Velocity

Code which identifies the frequency of demand of the items in that
particular location.

Item Velocity

A count of the number of locations with the specified Location Velocity
Code existing in the specified Zone. These locations contain items with the
specified Item Velocity.

For example, in the previous figure, BULK-ZONE1 with locations of
Location Velocity Code C, contains two locations with items of item
velocity code Not Setup, four locations with items of item velocity code A,
and two locations with items of item velocity code B.

Click the item count to view the Location/SKU Velocity Mismatch Detail
Report.

The Location/SKU Mismatch Report appears in portrait layout.

Location/SKU Velocity Mismatch Detail Report
The Location/SKU Mismatch Detail Report provides details of the location and the
items in that particular location.

Report Layout

This section describes the layout of the Location/SKU Velocity Mismatch Detail
Report.
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Field Description

Location

Figure 85. Location/SKU Velocity Mismatch Detail Report
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The location of the item in the warehouse.

Item ID

The identifier of the item.

Item Description

The description of the item.

PC

The product class to which the item belongs.

UOM

The unit of measure for the item.

Quantity

The quantity of the item with the same Item ID.

The Location/SKU Velocity Mismatch Detail Report appears in portrait layout.

Group and Sort Criteria

The Location/SKU Velocity Mismatch Detail Report is grouped by Location and
Item ID.

The Location and Item ID are sorted in ascending order.

Page Break Criteria

The Location/SKU Velocity Mismatch Detail Report has no page break criteria.

Node Inventory Valuation Report
The Node Inventory Valuation Report lists the item, quantity, and valuation details
for a node. This report is useful in determining the inventory valuation in a node.

Intended Audience

Warehouse managers and inventory supervisors, as well as enterprise users use
this report to check the value of the inventory in the warehouse. To access this
report, the user must belong to the data security group representing warehouse
managers and the inventory supervisors.

Generate a Node Inventory Valuation Report
About this task

To generate the Node Inventory Valuation report:

Procedure
1. Navigate to Inventory > Node Inventory Valuation Report. The Node Inventory

Valuation Report criteria screen appears. For more information about the Node
Inventory Valuation Report criteria screen, see "Node Inventory Valuation
Report Criteria".
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2. Enter the criteria and click Generate Report to generate the report. The Node
Inventory Valuation Report appears. For more information about the Node
Inventory Valuation Report layout, see "Node Inventory Valuation Report
Layout".

Node Inventory Valuation Report Criteria
The Node Inventory Valuation Report criteria screen enables you to enter the
criteria for which the Node Inventory Valuation Report generates.

Table 30. Node Inventory Valuation Report Criteria Screen

Field Description Default Value Mandatory

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Node The node for which the report
is generated.

If you are an enterprise user,
select the appropriate node
from the drop-down list. For
other users, the current node
of the user appears.

The current node
of the user.

Yes

Product Class Select the product class from
the drop-down menu.

Blank. No

Product Line Select the product line from
the drop-down menu.

Blank. No.

Figure 86. Node Inventory Valuation Report Criteria Screen
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Group and Sort Criteria

The Node Inventory Valuation Report is grouped by Enterprise Code, Node, and
Item ID.

The Enterprise code, Node and Item ID are sorted in ascending order.

Page Break Criteria

For each new enterprise, the report starts in a new table on another page. The
name of the enterprise is printed at the top of the table.

Additional Setup Required

There is no additional setup required to generate this report.
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Node Inventory Valuation Report Layout
This section describes the layout of the Node Inventory Valuation Report.

Figure 87. Node Inventory Valuation Report
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Field Description

Node

The node to which the item belongs.

Item ID

The identifier of the item in the inventory.

Item Description

The description of the item.

PC

The product class to which the item belongs.

UOM

The unit of measure for the item.

Quantity

The Quantity of the inventory.

Value

The value of the item.

The value of the item is computed as a product of unit cost and quantity.

Cost Currency

The currency in which the cost of the inventory displays.

Total

The total value of the inventory of the node for a particular enterprise.

The Node Inventory Valuation Report appears in portrait layout.

Participant List Report
The Participant List Report provides a count of the number of participants defined
in the participant model with the role details.

Intended Audience

Warehouse managers, inbound supervisors, inventory supervisors, and outbound
supervisors, and enterprise users, use the Participant List Report to get a count of
the participants with role details. The report is generated manually.

Generate a Participant List Report
About this task

To generate the Participant List Report:

Procedure
1. Navigate to Inventory > Participant List Report. The Participant List Report

criteria screen appears. For more information about the Participant List Report
criteria screen, see "Participant List Report Criteria".
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2. Enter the criteria and click Generate Report to generate the report. The
Participant List Report appears. For more information about the Participant List
Report layout, see "Participant List Report Layout".

Participant List Report Criteria
The Participant List Report criteria screen enables you to enter the criteria for
which the Participant List Report generates.

Table 31. Participant List Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report
is generated.

If you are an enterprise user,
select the appropriate node
from the drop-down list. For
other users, the current node
of the user appears.

The current node
of the user.

Yes

Participant Active
As On Date

Enter the date for which the
report is generated.

You can also click the icon
to select the date.

The current date. Yes

Group and Sort Criteria

The Participant List Report is grouped by Participant Roles.

The Participant Roles is sorted in descending order.

Page Break Criteria

The Participant List Report has no page break criteria.

Additional Setup Required

There is no additional setup required to generate this report.

Participant List Report Layout
This section describes the layout of the Participant List Report.

Figure 88. Participant List Report Criteria Screen
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Field Definition

Enterprises

Figure 89. Participant List Report
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The total number of enterprises defined in the participant model of the
hub organization until the date specified in the criteria.

Click the count to view the Participant Detail Report, Enterprise.

Buyers

The total number of buyers defined in the participant model of the hub
organization until the date specified in the criteria.

Click the count to view the Participant Detail Report, Buyer.

Sellers

The total number of sellers defined in the participant model of the hub
organization until the date specified in the criteria.

Click the count to view the Participant Detail Report, Seller.

Nodes

The total number of nodes defined in the participant model of the hub
organization until the date specified in the criteria.

Click the count to view the Participant Detail Report, Nodes.

Carriers

The total number of carriers defined in the participant model of the hub
organization until the date specified in the criteria.

Click the count to view the Participant Detail Report, Carrier.

The Participant List Report appears in portrait layout.

Participant Detail Report, Enterprise
The Participant Detail Report, Enterprise displays the list of participants in the
Enterprise role.

Report Layout

This section describes the layout of the Participant Detail Report, Enterprise.
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Field Description

Organization Code

Figure 90. Participant Detail Report, Enterprise
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The unique code for each enterprise.

The Participant Enterprise Detail Report appears in portrait layout.

Group and Sort Criteria

The Participant Enterprise Detail Report is grouped by Organization Code.

The Organization Code is sorted in ascending order.

Page Break Criteria

The Participant Enterprise Detail Report has no page break criteria.

Participant Detail Report, Buyer
The Participant Detail Report, Buyer displays the list of participants in the buyer
role.

Report Layout

This section describes the layout of the Participant Detail Report, Buyer.
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Field Description

Organization Code

Figure 91. Participant Detail Report, Buyer
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The unique code for each seller.

The Participant Detail Report, Buyer appears in portrait layout.

Group and Sort Criteria

The Participant Detail Report, Buyer is grouped by Organization Code.

The Organization Code is sorted in ascending order.

Page Break Criteria

The Participant Detail Report, Buyer has no page break criteria.

Participant Detail Report, Seller
The Participant Detail Report, Seller displays the list of participants in the seller
role.

Report Layout

This section describes the layout of the Participant Detail Report, Seller.
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Field Description

Organization Key

Figure 92. Participant Detail Report, Seller
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The unique code for each carrier.

The Participant Detail Report, Seller appears in portrait layout.

Group and Sort Criteria

The Participant Detail Report, Seller is grouped by Organization Code.

The Organization Code is sorted in ascending order.

Page Break Criteria

The Participant Detail Report, Seller has no page break criteria.

Participant Detail Report, Nodes
The Participant Detail Report, Nodes displays the list of nodes in the participant
model.

Report Layout

This section describes the layout of the Participant Detail Report, Nodes.
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Field Description

Organization Code

Figure 93. Participant Detail Report, Nodes
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The unique code for each nodes.

The Participant Detail Report, Nodes appears in portrait layout.

Group and Sort Criteria

The Participant Detail Report, Nodes is grouped by Organization Code.

The Organization Code is sorted in ascending order.

Page Break Criteria

The Participant Detail Report, Nodes has no page break criteria.

Participant Detail Report, Carrier
The Participant Detail Report, Carrier displays the list of participants in the carrier
role.

Report Layout

This section describes the layout of the Participant Detail Report, Carrier.
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Field Description

Organization Code

Figure 94. Participant Detail Report, Carrier
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The unique code for each carrier.

The Participant Detail Report, Carrier appears in portrait layout.

Group and Sort Criteria

The Participant Detail Report, Carrier is grouped by Organization Code.

The Organization Code is sorted in ascending order.

Page Break Criteria

The Participant Detail Report, Carrier has no page break criteria.

Space Consolidation Report
The Space Consolidation Report provides item-wise information about the location
capacity utilization. This helps in identifying space consolidation opportunities.

Note: The Space Consolidation Report can be generated only for locations with
finite capacity.

Intended Audience

Warehouse managers and inventory supervisors use this report to check the
capacity of the location for an item.

Generate a Space Consolidation Report
About this task

To generate the Space Consolidation Report:

Procedure
1. Navigate to Inventory > Space Consolidation Report. The Space Consolidation

Report criteria screen appears. For more information about the Space
Consolidation Report criteria screen, see "Space Consolidation Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The Space
Consolidation Report appears. For more information about the Space
Consolidation Report layout, see "Space Consolidation Report Layout".

Space Consolidation Report Criteria
The Space Consolidation Report criteria screen enables you to enter the criteria for
which the Space Consolidation Report generates.
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Table 32. Space Consolidation Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report
is generated.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Zone Enter the zone for which the
report is generated.

You can also click to
choose the zone.

Click to enter more zones.
These zones are taken into
consideration while
generating the report.

Click to remove a specific
zone.

Blank. No

Figure 95. Space Consolidation Report Criteria Screen
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Table 32. Space Consolidation Report Criteria Screen (continued)

Field Description Default Value Mandatory

Product Class Enter the product class of the
item.

You can select the product
class from the drop-down
menu.

Click to enter more
product class. These are taken
into consideration while
generating the report.

Click to remove a specific
product class.

Blank. No

Location(s) with%
Utilization <=

Enter the percentage of the
capacity of the location
utilized for the item.

50 Yes

Note: If this report has been executed using the default report criteria parameters,
there may be a delay in fetching data. Therefore, it is recommended that you
update the report criteria such that only the required data is fetched.

Group and Sort Criteria

The Space Consolidation Report is grouped by Enterprise Code, Zone ID, and Item
ID.

The Enterprise code, Zone ID and Item ID are sorted in ascending order.

Page Break Criteria

The Space Consolidation Report has no page break criteria.

Additional Setup Required

There is no additional setup required to generate this report.
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Space Consolidation Report Layout
This section describes the layout of the Space Consolidation Report.

Figure 96. Space Consolidation Report
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Field Description

Item ID

The identifier of the item.

Item Description

The description of the item.

PC

The product class to which the item belongs.

UOM

The unit of measure for the item.

Zone ID

The zone ID of the zone.

Location ID

The location id of the item.

Location Size Code

The code representing the storage capacity of the location.

Quantity

The quantity of the item in the location.

Capacity Utilization

The percentage of the capacity of the location utilized for the item.

The Space Consolidation Report appears in portrait layout.

Space Utilization Report
The Space Utilization Report provides information on location capacity utilization
in terms of percentage.

Intended Audience

Warehouse managers, and inventory supervisors use the Space Utilization Report
to check the capacity of the location for an item.

Generate a Space Utilization Report
About this task

To generate the Space Utilization Report:

Procedure
1. Navigate to Inventory > Space Utilization Report. The Space Utilization Report

criteria screen appears. For more information about the Space Utilization
Report criteria screen, see "Space Utilization Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The Space
Utilization Report appears. For more information about the Space Utilization
Report layout, see "Space Utilization Report Layout".
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Space Utilization Report Criteria
The Space Utilization Report criteria screen enables you to enter the criteria for
which the Space Utilization Report generates.

Table 33. Space Utilization Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report
is generated.

The current node
of the user.

Yes

Zone Enter the zone for which the
report is generated.

You can also click to
choose the zone.

Click to enter more zones.
These zones are taken into
consideration while
generating the report.

Click to remove a specific
zone.

Blank. No

Location Size
Code

Enter the size code of the
location.

Click to enter more size
codes. These size codes are
taken into consideration while
generating the report.

Click to remove a specific
size code.

Blank. No

Group and Sort Criteria

The Space Utilization Report is grouped by Zone ID and Location Size Code.

The Zone ID and Location Size Code are sorted in ascending order.

Page Break Criteria

The Space Utilization Report has no page break criteria.

Figure 97. Space Utilization Report Criteria Screen
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Additional Setup Required

There is no additional setup required to generate this report.

Space Utilization Report Layout
This section describes the layout of the Space Utilization Report.
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Field Description

Zone ID

Figure 98. Space Utilization Report
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Displays the ID of the zone.

Location Size Code

The code representing the storage capacity of the location.

Total No. of Locations

Displays the total number of locations for the particular location size code.

Click the hyperlink to view the Space Utilization Summary Report.

Total No. of Empty Locations

Displays the total number of empty locations for the particular location
size code.

Click the hyperlink to view the Empty Location(s) Detail Report.

Total No. of Full Locations

Displays the total number of locations full for the particular location size
code.

Click the hyperlink to view the Completely Full Location(s) Detail Report.

Total No. of Partially Full Locations

Displays the total number of locations partially full for the particular
location size code.

Click the hyperlink to view the Partially Full Location(s) Detail Report.

Location Utilization%

The percentage of the location that is full.

Volume Utilization

The percentage of the volume of the location that is utilized for storage.

The Space Utilization Report appears in portrait layout.

Space Utilization Summary Report
The Space Utilization Summary Report gives a graphical display of the percentage
of location utilized.

Report Layout

This section describes the layout of the Space Utilization Summary Report.
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Field Description

The regions of this color indicate the percentage of the location completely
full.

Figure 99. Space Utilization Summary Report
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The regions of this color indicate the percentage of the location partially
full.

The regions of this color indicate the percentage of the location empty.

Location(s)

The location capacity utilization.

The Space Utilization Summary Report appears in portrait layout.

Group and Sort Criteria

The Space Utilization Summary Report has no group criteria and sort criteria.

Page Break Criteria

The Space Utilization Report has no page break criteria.

Empty Locations Detail Report
The Empty Location(s) Detail Report provides a detail report on the location which
does not have any inventory.

Report Layout

This section describes the layout of the Empty Location(s) Detail Report.

216 Sterling Warehouse Management System: Reports Guide



Field Description

Location Type

Figure 100. Empty Location(s) Detail Report
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The type specified for a location which indicates the purpose the location
serves.

Location ID

The ID of the location for which the report is generated.

Aisle Number

The number of the aisle where the shipment is located.

Level Number

The number of the level where the shipment is located.

Bay Number

The number of the bay where the shipment is located

Current Available Volume

The volume of the location available for usage.

Pend In Volume

Items awaited in the near future for that particular location.

Net Available Volume

The actual volume available for usage.

The Empty Location(s) Detail Report appears in portrait layout.

Group and Sort Criteria

The Empty Location(s) Detail Report is grouped by Location Type.

The Location Type is sorted in ascending order.

Page Break Criteria

Empty Location(s) Detail Report has no page break criteria.

Completely Full Locations Detail Report
The Completely Full Location(s) Detail Report provides a detail report on the
locations which have no available volume for usage.

Report Layout

This section describes the layout of the Completely Full Location(s) Detail Report.
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Field Description

Location Type

Figure 101. Completely Full Location(s) Detail Report

Chapter 4. Inventory Reports 219



The type specified for a location which indicates the purpose the location
serves.

Location ID

The ID of the location for which the report is generated.

Aisle Number

The number of the aisle where the shipment is located.

Level Number

The number of the level where the shipment is located.

Bay Number

The number of the bay where the shipment is located

Current Available Volume

The volume of the location available for usage.

Pend In Volume

Items awaited in the near future for that particular location.

Net Available Volume

The actual volume available for usage.

The Completely Full Location(s) Detail Report appears in portrait layout.

Group and Sort Criteria

The Completely Full Location(s) Detail Report is grouped by Location Type.

The Location Type is sorted in ascending order.

Page Break Criteria

The Completely Full Location(s) Detail Report has no page break criteria.

Partially Full Locations Detail Report
The Partially Full Location(s) Detail Report provides a detail report on the
locations which are partially available on the system for that particular node.

Report Layout

This section describes the layout of the Partially Full Location(s) Detail Report.
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Field Description

Location Type

Figure 102. Partially Full location(s) Detail Report
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The type specified for a location which indicates the purpose the location
serves.

Location ID

The ID of the location for which the report is generated.

Aisle Number

The number of the aisle where the shipment is located.

Level Number

The number of the level where the shipment is located.

Bay Number

The number of the bay where the shipment is located

Current Available Volume

The volume of the location available for usage.

Pend In Volume

Items awaited in the near future for that particular location.

Net Available Volume

The actual volume available for usage.

The Partially Full Location(s) Detail Report appears in portrait layout.

Group and Sort Criteria

The Partially Full Location(s) Detail Report is grouped by Location Type.

The Location Type is sorted in ascending order.

Page Break Criteria

The Partially Full Location(s) Detail Report has no page break criteria.
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Chapter 5. VAS Reports

Work Order Report
The Work Order Report displays all the work orders for the node, in different
stages of completion. This report is used to review open work orders.

Intended Audience

The warehouse manager and inventory supervisor uses the Work Order Report to
identify the different stages of completion of work orders. The open work orders
can be reviewed using this report.

Generate a Work Order Report
About this task

To generate the Work Order Report:

Procedure
1. Navigate to VAS > Work Order Report. The Work Order Report criteria screen

appears. For more information about the Work Order Report criteria screen, see
"Work Order Report Criteria".

2. Enter the criteria and click Generate Report. The Work Order Report appears.
For more information about the Work Order Report layout, see "Work Order
Report Layout".

Work Order Report Criteria
The Work Order Report criteria screen enables you to enter the criteria for which
the Work Order Report generates.
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Table 34. Work Order Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report
is generated.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Start No Earlier
Than

Enter the start date and the
end date for which the report
is generated.

You can also click the and

icons to choose the date
range and time.

The current date.

The time is
00:00:00 and
23:59:59.

Yes

Service Item
Group

The value of Service Item
Group indicates whether the
report is for Inventory
Compliance, De Kitting,
Inventory Changes, or Kitting.

Figure 103. Work Order Report Criteria Screen
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Table 34. Work Order Report Criteria Screen (continued)

Field Description Default Value Mandatory

Inventory
Compliance

Select this to view the "Work
Order Report" for the
Inventory Compliance service
item group.

Selected. Yes

De Kitting Select this to view the "Work
Order Report" for the De
Kitting service item group.

Not Selected. Yes

Inventory Changes Select this to view the "Work
Order Report" for the
Inventory Changes service
item group.

Not Selected. Yes

Kitting Select this to view the "Work
Order Report" for the Kitting
service item group.

Not Selected. Yes

Work Order Status Enter the status of the work
order between the dates
specified.

Work Order
Created.

Yes

Group and Sort Criteria

The Work Order Report is grouped by Enterprise Code, Work Order No., Work
Order Status, and Item ID.

Enterprise Code, and Work Order No are sorted in ascending order. Within a Work
Order number, the Work Order Status and Item ID are sorted in ascending order.

Page Break Criteria

For each new enterprise, the report starts in a new table, on another page. The
name of the enterprise is printed at the top of the table.

Additional Setup Required

There is no additional setup required to generate this report.

Work Order Report Layout
The Work Order Report displays the work orders in different stages of completion
and also aids in reviewing the open work orders.

This section describes the layout of the Work Order Report.

Note: The value of Service Item Group indicates whether the report is for
Inventory Compliance, De Kitting, Inventory Changes, or Kitting.
v In the Work Order Report for Inventory Compliance, the value of Service Item

Group is Inventory Compliance.
v In the Work Order Report for De Kitting, the value of Service Item Group is De

Kitting.
v In the Work Order Report for Inventory Changes, the value of the Service Item

Group is Inventory Changes.
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v In the Work Order Report for Kitting, The value of the Service Item Group is
Kitting.
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Field Description

Work Order No

Figure 104. Work Order Report
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The number of the work order.

Work Order Status

The status of the work order.

Container Type

The type of the container.

Container No.

The identifier number of the container.

Item ID

The identifier of the item.

Item Description

The description of the item.

PC

The product class to which the item belongs.

UOM

The unit of measure for the item.

Quantity Allocated

The quantity of items allocated for a specific work order.

Quantity Completed

The quantity of items that met the work order requirements.

Quantity Remaining

The quantity of items remaining that did not meet the work order
requirements.

The Work Order Report is displayed in portrait layout.
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Chapter 6. Outbound Reports

BOL Total Weights Report
The BOL Total Weights Report lists the number of cartons or pallets, and the total
weight details against each Bill Of Lading (BOL). The report lists all details for
BOLs shipped for the selected carrier or date range.

Intended Audience

Warehouse managers and outbound supervisors use this report to track the
TL/LTL shipments that are shipped. It is also useful to the warehouse in
reconciling TL/LTL billings based on the shipped weights.

Generate a BOL Total Weights Report
About this task

To generate the BOL Total Weights Report:

Procedure
1. Navigate to Outbound > BOL Total Weights Report. The BOL Total Weights

Report criteria screen appears. For more information about the BOL Total
Weights Report criteria screen, see "BOL Total Weights Report Criteria".

2. Enter the criteria and click Generate Report to generate the Report. The BOL
Total Weights Report appears. For more information about the BOL Total
Weights Report layout, see "BOL Total Weights Report Layout".

BOL Total Weights Report Criteria
The BOL Total Weights Report criteria screen enables you to enter the criteria for
which the BOL Weights Report generates.

Figure 105. BOL Total Weights Report Criteria Screen
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Table 35. BOL Total Weights Report Criteria Screen

Field Description Default Value Mandatory

Document Type Select the document type for
which the report is generated.

For outbound reports, the
document types displayed are
Transfer Order and Sales
Order.

Sales Order. Yes

Node The node for which the report
is generated.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Actual Departure
Date

Enter the start date and the
end date for which the report
is generated.

You can also click the
icons to choose the date
range.

The current date. Yes

Carrier Enter the carrier
corresponding to the
shipment.

Click to choose the carrier
for the report to be generated.

Blank. No

Group and Sort Criteria

The BOL Total Weights Report is grouped by Carriers.

Carriers are sorted in ascending order.

Within a specific Carrier, the Actual Departure Date and BOL No. are sorted in
descending order.

Page Break Criteria

The BOL Total Weights Report has no page break criteria.

230 Sterling Warehouse Management System: Reports Guide



Additional Setup Required

There is no additional setup required to generate this report.

BOL Total Weights Report Layout
This section describes the layout of the BOL Total Weights Report. In the following
figure, WWAT is the carrier.
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Field Description

Carrier

The carrier through which the load has been shipped.

Actual Departure Date

The date on which the shipment was shipped.

Figure 106. BOL Total Weights Report
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BOL No.

The Bill of Lading number.

No. of Cases

The number of cases in a particular BOL.

No. of Pallets

The number of pallets in a particular BOL.

Weight

The weight of that particular BOL.

Total Weight UOM

The total weight in terms of UOM.

Group Total For Carrier

The total number of cases and pallets in a BOL for a particular carrier.

Group Total For Enterprise

The total number of cases and pallets in a BOL for all carriers.

The BOL Total Weights Report appears in portrait layout.

Container Volume Monthly Report
The Container Volume Monthly Report shows the number of containers shipped
each month. For the current month, it only shows the total number of cartons
shipped till date.

Intended Audience

Warehouse managers, outbound supervisors, and as well as enterprise users, use
this report to track the number of containers that are shipped on a monthly basis.

Generate a Container Volume Monthly Report
About this task

To generate the Container Volume Monthly Report:

Procedure
1. Navigate to Outbound > Container Volume Monthly Report. The Container

Volume Monthly Report Criteria screen appears. For more information about
the Container Volume Monthly Report criteria screen, see "Container Volume
Monthly Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The
Container Volume Monthly Report appears. For more information about the
Container Volume Monthly Report layout, see "Container Volume Monthly
Report Layout".

Container Volume Monthly Report Criteria
The Container Volume Monthly Report criteria screen enables you to enter the
criteria for which the Container Volume Monthly Report generates.
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Table 36. Container Volume Monthly Report Criteria screen

Field Description Default Value Mandatory

Document Type Select the document type for
which the report is generated.

For outbound reports, the
document types displayed are
Transfer Order and Sales
Order.

Sales Order. Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Node The node for which the report
is generated.

If you are an enterprise user,
select the appropriate node
from the drop-down list. For
other users, the current node
of the user appears.

The current node
of the user.

Yes

Figure 107. Container Volume Monthly Report Criteria Screen
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Table 36. Container Volume Monthly Report Criteria screen (continued)

Field Description Default Value Mandatory

Actual Ship Date Enter the start date and the
end date for which the report
is generated.

You can also click the
icons to choose the date
range.

The date three
months prior to
the current date
and the current
date.

Yes

Group and Sort Criteria

The Container Volume Monthly Report is grouped by Month.

Month is sorted in descending order.

Page Break Criteria

The Container Volume Monthly Report has no page break criteria.

Additional Setup Required

There is no additional setup required to generate this report.
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Container Volume Monthly Report Layout
This section describes the layout of the Container Volume Monthly Report.

Figure 108. Container Volume Monthly Report
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Field Description

No. of containers shipped

The number of containers or cartons shipped.

Ship Month

The month in which the shipments are shipped, within a specified date
range.

This is grouped by Enterprise Code.

For each month the total number of containers shipped is printed on top of the bar
representing the shipment shipped in a month.

The Container Volume Monthly Report appears in portrait layout.

Daily Shipment Report
The Daily Shipment Report provides high-level visibility into shipment activity in
the warehouse, on a daily basis, for a specified date range. This report provides
daily information on new shipments awaiting shipping on that day, shipments
shipped on that day, shipments pending from previous days, and shipments
carried over to the next day.

Intended Audience

Warehouse managers and outbound supervisors use this report to get an update
on the total number of shipments shipped and pending on a daily basis.

Generate a Daily Shipment Report
About this task

To generate the Daily Shipment Report:

Procedure
1. Navigate to Outbound > Daily Shipment Report. The Daily Shipment Report

criteria screen appears. For more information about the Daily Shipment Report
criteria screen, see "Daily Shipment Report Criteria".

2. Enter the criteria and click Generate Report. The Daily Shipment Report
appears. For more information about the Daily Shipment Report layout, see
"Daily Shipment Report Layout".

Daily Shipment Report Criteria
The Daily Shipment Report criteria enables you to enter the criteria for which the
Daily Shipment Report generates.
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Table 37. Daily Shipment Report Criteria Screen

Field Description Default Value Mandatory

Document Type Select the document type for
which the report is generated.

For outbound reports, the
document types displayed are
Transfer Order and Sales
Order.

Sales Order. Yes

Node The node for which the report
is generated.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Figure 109. Daily Shipment Report Criteria Screen
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Table 37. Daily Shipment Report Criteria Screen (continued)

Field Description Default Value Mandatory

Statistics Date Enter the start date and the
end date for which the report
is generated.

You can also click the
icons to choose the date
range.

The current date. Yes

Shipment Mode Select the specific mode of
shipment from the drop-down
menu.

Blank. No

Seller Enter the seller organization.

You can also click to select
the seller organization.

Blank. No

Carrier Enter the carrier.

You can also click to select
the carrier for a specific
enterprise.

Blank. No

Group and Sort Criteria

The Daily Shipment Report is grouped by Date.

Date is sorted in descending order.

Page Break Criteria

For each new enterprise, the report starts in a new table on another page. The
name of the enterprise is printed at the top of the table.

Additional Setup Required

To populate the data required for the Daily Shipment Report, run the
COLLECT_SHIPMENT_STATISTICS agent.

The COLLECT_SHIPMENT_STATISTICS agent mines the data required for the
Daily Shipment Report from the Shipment transactions and populates the
YFS_SHIPMENT_STATISTICS table.
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Daily Shipment Report Layout
This section describes the layout of the Daily Shipment Report.

Figure 110. Daily Shipment Report
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Field Description

Date

The date on which the data for the shipment was created.

Shipments Expected to be Shipped

The number of shipments expected to be shipped for a specific date.

Shipments Pending from Previous Day(s)

The number of shipments pending from the previous days until this
particular date.

Shipments Shipped

The number of shipments shipped until that particular date.

Pending Shipments Shipped

The number of shipments pending until that date and shipped on that
date.

Shipments shipped on Time

The number of shipments shipped at the expected time of shipment.

Shipments Shipped Early

The number of shipments shipped earlier than the expected date of
shipment.

Containers Shipped

The total number of cartons shipped for all the shipments on that date.

Units Shipped

The total number of items shipped on that date.

Shipments Carried Over

The number of shipments that were not shipped on that date and were
carried over to the next date.

The Daily Shipment Report appears in portrait layout.

Dock Pickup Schedule Report
The Dock Pickup Schedule Report provides visibility into appointments taken for
one or more shipping docks, for a range of dates.

Intended Audience

Warehouse managers and outbound supervisors use this report to keep track of
dock appointments.

Generate a Dock Pickup Schedule Report
To generate the Dock Pickup Schedule Report:
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About this task

Procedure
1. Navigate to Outbound > Dock Pickup Schedule Report. The Dock Schedule

Report criteria screen displays.
2. Enter the criteria and click Generate Report to generate the report. The Dock

Schedule Report displays. For more information about the Dock Schedule
Report layout, see "Delivery Dock Schedule Report" under the ’Inbound
Reports’ topic.

Results

The report criteria, report layout, group and sort criteria, page break criteria, and
additional setup required for this report is similar to the Delivery Dock Schedule
Report.

Generic Shipper Report
The Generic Shipper Report gives details of shipments that are either to be shipped
or were shipped using each carrier that the warehouse uses. The warehouse can
use this report to understand the carrier usage patterns.

Intended Audience

Warehouse managers and outbound supervisors use the Generic Shipper Report to
check the shipment details. The report is generated manually.

Generate a Generic Shipper Report
About this task

To generate the Generic Shipper Report:

Procedure
1. Navigate to Outbound > Generic Shipper Report. The Generic Shipper Report

criteria screen appears. For more information about the Generic Shipper Report
criteria screen, see "Generic Shipper Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The Generic
Shipper Report appears. For more information about the Generic Shipper
Report layout, see "Generic Shipper Report Layout".

Generic Shipper Report Criteria
The Generic Shipper Report criteria screen enables you to enter the criteria for
which the Generic Shipper Report generates.
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Table 38. Generic Shipper Report Criteria Screen

Field Description Default Value Mandatory

Document Type Select the document type for
which the report is generated.

For this report, the document
types displayed are Transfer
Order and Sales Order.

Sales Order. Yes

Node The node for which the report
is generated.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Figure 111. Generic Shipper Report Criteria Screen
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Table 38. Generic Shipper Report Criteria Screen (continued)

Field Description Default Value Mandatory

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Expected
Shipment Date

Enter the start date and end
date for which the report is
generated.

You can also click the
icons to choose the date
range.

The current date. Yes

Buyer Enter the buyer to whom the
shipment is shipped.

You can also click to
choose the buyer.

Blank. No

Carrier Enter the carrier of the
shipment.

You can also click to
choose the carrier.

Blank. No

Shipment Mode Enter this to select a specific
mode of shipment from the
drop- down list.

Blank. No

Load No. Enter the load number of the
shipment.

Blank. No

Receiving Node Enter the receiving node of
the shipment.

You can also click to
choose the receiving node.

Blank. No

Status Status of the shipment Shipment Created
to Shipment
Shipped.

Yes

Group and Sort Criteria

The Generic Shipper Report is grouped by Enterprise Code, Requested Ship Date,
Load No., and Shipment No.

The Enterprise Code, Requested Ship Date, Load No., and Shipment No. are sorted
in ascending order.

Page Break Criteria

For each new enterprise, the report starts in a new table on another page. The
name of the enterprise is printed at the top of the table.

244 Sterling Warehouse Management System: Reports Guide



Additional Setup Required

There is no additional setup required to generate this report.
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Generic Shipper Report Layout
This section describes the layout of the Generic Shipper Report.

Figure 112. Generic Shipper Report
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Field Description

Enterprise Code

This report is grouped by Enterprise Code.

Expected Shipment Date

The date on which the shipment is expected to reach the destination.

Load No.

The load number of the load shipped.

Shipment No.

The shipment number of the shipment shipped.

Status

The status of the shipped shipment.

Seller

The organization which ships the shipment.

Buyer

The buyer to whom the shipment is shipped.

Receiving Node

The node to which the shipment is shipped.

Destination

The destination of the shipment.

Carrier/Service

The carrier used for the shipment.

Ship Mode

The mode of delivery of the shipment.

Weight

The total weight of the shipment.

Weight UOM

The unit of measure for the weight of the shipment.

Volume

The volume of the shipment.

Volume UOM

The unit of measure for the volume of the shipment.

The Generic Shipper Report appears in portrait layout.

Hot Inventory Report
The Hot Inventory Report helps identify the inbound shipments that should be
unloaded by priority based on the hot items in the container. Hot items are items
that are on backorder for the warehouse.
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The information of the backordered items is available in DOM, or in shortages in
outbound shipments for the node.

Intended Audience

Warehouse managers and outbound supervisors use this report to prioritize
inventory by comparing it with the transactions for the day. To access this report,
the user must belong to the data security group representing warehouse manager
and the outbound supervisor.

Generate a Hot Inventory Report
About this task

To generate the Hot Inventory Report:

Procedure
1. Navigate to Outbound > Hot Inventory Report. The Hot Inventory Report

criteria screen appears. For more information about the Hot Inventory Report
criteria screen, see "Hot Inventory Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The Hot
Inventory Report appears. For more information about the Hot Inventory
Report layout, see "Hot Inventory Report Layout".

Hot Inventory Report Criteria
The Hot Inventory Report criteria screen enables you to enter the criteria for which
the Hot Inventory Report generates.

Table 39. Hot Inventory Report Criteria Screen

Field Description Default Value Mandatory

Document Type Select the document type for
which the report is generated.

For this report, the document
types displayed are Blind
Return, Blind Order, Transfer
Order and Purchase Order.

Purchase Order. Yes

Figure 113. Hot Inventory Report Criteria Screen
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Table 39. Hot Inventory Report Criteria Screen (continued)

Field Description Default Value Mandatory

Node The node for which the report
is generated.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Requested Ship
Date

Enter the requested ship date
to see all hot inventory for all
shipments due until that
particular date.

You can also click the icon
to select the ship date.

The current date. Yes

Group and Sort Criteria

The Hot Inventory Report is grouped by Enterprise Code, Item ID, and Back
Ordered Quantity.

The Enterprise Code and Item ID is sorted in ascending order.

Page Break Criteria

For each new enterprise, the report starts in a new table on another page. The
name of the enterprise is printed at the top of the table.

Additional Setup Required

There is no additional setup required to generate this report.
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Hot Inventory Report Layout
This section describes the layout of the Hot Inventory Report.

Figure 114. Hot Inventory Report
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Field Description

Item ID

The identifier of the item which is in demand.

Item Description

The description of the item.

PC

The product class to which the item belongs.

UOM

The unit of measure for the item.

Shortage Quantity

The quantity of the items on backorder for the warehouse or in shortage
for the outbound shipment.

Inbound Shipment No.

The shipment number of the inbound shipment.

Expected Delivery Date

The expected date of delivery of the inbound shipment into the warehouse.

Shipment Status

The description of the status of the inbound shipment.

Shipment Quantity

The quantity of inbound shipments.

The Hot Inventory Report appears in portrait layout.

On Time Shipment Report
The On Time Shipment Report captures the number of shipments shipped at the
scheduled time. It also categorizes the delayed shipments into buckets of delays by
one, two, or more days.

Intended Audience

Warehouse managers, outbound supervisors, as well as enterprise user, use this
report to capture the number of shipments that are shipped as planned or delayed
by one, two, three, or more than three days.

Generate an On Time Shipment Report
About this task

To generate the On Time Shipment Report:

Procedure
1. Navigate to Outbound > On Time Shipment Report. The On Time Shipment

Report criteria screen appears. For more information about the On Time
Shipment Report criteria screen, see "On Time Shipment Report Criteria".
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2. Enter the criteria and click Generate Report to generate the report.The On Time
Shipment Report appears. For more information about the On Time Shipment
Report layout, see "On Time Shipment Report Layout".

On Time Shipment Report Criteria
The On Time Shipment Report criteria screen enables you to enter the criteria for
which the On Time Shipment Report generates.

Table 40. On Time Shipment Report Criteria Screen

Field Description Default Value Mandatory

Document Type Select the document type for
which the report is generated.

For this report, the document
types Transfer Order and
Sales Order.

Sales Order. Yes

Node The node for which the report
is generated.

If you are an enterprise user,
select the appropriate node
from the drop-down list. For
other users, the current node
of the user appears.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

.
Figure 115. On Time Shipment Report Criteria Screen

252 Sterling Warehouse Management System: Reports Guide



Table 40. On Time Shipment Report Criteria Screen (continued)

Field Description Default Value Mandatory

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Actual Ship Date Enter the start date and the
end date for which the report
is generated.

You can also click the
icons to choose the date
range.

The current date. Yes

Group and Sort Criteria

The On Time Shipment Report is grouped by Enterprise Code and Actual Ship
Date.

The Enterprise Code is sorted in ascending order. Within a specific Node, the
Actual Ship Date is sorted in descending order.

Page Break Criteria

For each new enterprise, the report starts in a new table on another page. The
name of the enterprise is printed at the top of the table.

Additional Setup Required

There is no additional setup required to generate this report.
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On Time Shipment Report Layout
This section describes the layout of the On Time Shipment Report.

Figure 116. On Time Shipment Report
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Field Description

Node

The node for which the report is generated.

Actual Ship Date

The actual date of shipment.

No. of Shipments

The number of shipments on a particular date.

No. Shipments Shipped as Scheduled

Number of shipments shipped as per the schedule.

No. Shipments Delayed by 1 Day

Number of shipments delayed by 1 day.

No. Shipments Delayed by 2 Days

Number of shipments delayed by 2 days.

No. Shipments Delayed by 3 Days

Number of shipments delayed by 3 days.

No. Shipments Delayed by more than 3 Days

Number of shipments delayed by more than 3 days.

The On Time Shipment Report appears in portrait layout.

Order Billing Summary Report
The Order Billing Summary Report lists the transaction details for all types of
orders handled by the warehouse. This report helps to track the matrix of
information for transactions, such as the number of orders or order lines shipped
or received.

Intended Audience

Enterprise users use the Order Billing Summary Report to track the transactions
made for particular date range. The report is generated manually.

Note: This report is accessible only to enterprise users and does not display in the
menu of other users.

Generate an Order Billing Summary Report
About this task

To generate the Order Billing Summary Report:

Procedure
1. Navigate to Order > Order Billing Summary Report. The Order Billing

Summary Report criteria screen appears. For more information about the Order
Billing Summary Report criteria screen, see "Order Billing Summary Report
Criteria".
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2. Enter the criteria and click Generate Report to generate the report. The Order
Billing Summary Report appears. For more information about the Order Billing
Summary Report layout, see "Order Billing Summary Report Layout".

Order Billing Summary Report Criteria
The Order Billing Summary Report criteria screen enables you to enter the criteria
for which the Order Billing Summary Report generates.

Table 41. Order Billing Summary Report Criteria Screen

Field Description Default Value Mandatory

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Order Date Enter the start date and end
date for which the report is
generated.

You can also click the
icons to choose the date
range.

The date one
month prior to the
current date and
the current date.

Yes

Group and Sort Criteria

The Order Billing Summary Report is grouped by Enterprise Code and Date.

The Enterprise Code is sorted in ascending order, and the Date is sorted in
descending order.

Figure 117. Order Billing Summary Report Criteria Screen
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Page Break Criteria

The Order Billing Summary Report does not have any page break criteria.

Additional Setup Required

Run the CLOSE_ORDER agent to close the orders. These closed orders are displayed
by the Order Billing Summary Report.

Order Billing Summary Report Layout
This section describes the layout of the Order Billing Summary Report.

Field Description

Figure 118. Order Billing Summary Report
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Date

The date of transaction for all orders in the warehouse.

No. of Inbound Orders

The number of inbound orders.

Click this to view the Inbound Order Billing Detail Report.

No. of Inbound Order Lines

The number of inbound order Lines.

Click this to view the Inbound Order Lines Billing Detail Report.

No. of Outbound Orders

The number of outbound orders.

Click this to view the Outbound Order Billing Detail Report.

No. of Outbound Order Lines

The number of outbound order Lines.

Click this to view the Outbound Order Lines Billing Detail Report.

Total for E1

The data is summarized by enterprise for all orders.

Grand Total

The total number of orders across all enterprises.

The Order Billing Summary Report appears in portrait layout.

Inbound Order Billing Detail Report
The report lists the details of the inbound orders.

Report Layout

This section describes the layout of the Inbound Order Billing Detail Report.
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Field Description

Document Type

Figure 119. Inbound Order Billing Detail Report
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The document type of the inbound orders.

Order No.

The order numbers of the item.

No data is displayed in the report screen if no order exists for the item.

Order Date

The date on which the order is created.

Order Type

The type of order.

Buyer

The buyer to whom the shipment is shipped.

Seller

The seller organization.

The Inbound Order Billing Detail Report appears in portrait layout.

Group and Sort Criteria

The Inbound Order Billing Detail Report is grouped by Document Type and Order
No.

The Document Type and Order No. are sorted in ascending order.

Page Break Criteria

The Inbound Order Billing Detail Report has no page break criteria.

Inbound Order Lines Billing Detail Report
The Inbound Order Lines Billing Detail Report lists the order numbers of the
inbound orders and their order lines.

Report Layout

This section describes the layout of the Inbound Order Lines Billing Detail Report.
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Field Description

Document Type

Figure 120. Inbound Order Lines Billing Detail Report
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The document type of the inbound orders.

Order No.

The order number of the item.

No data is displayed in the report screen if no order exists for the item.

Order Date

The date on which the order is created.

Order Type

The type of order.

Buyer

The buyer to whom the shipment is shipped.

Seller

The seller organization.

Prime Line No.

The order line of the order.

Sub Line No.

The sub line number of the component of the item.

The Inbound Order Lines Billing Detail Report appears in portrait layout.

Group and Sort Criteria

The Inbound Order Lines Billing Detail Report is grouped by Document Type and
Order No.

The Document Type and Order No. are sorted in ascending order.

Page Break Criteria

The Inbound Order Lines Billing Detail Report has no page break criteria.

Outbound Order Billing Detail Report
The Outbound Order Billing Detail Report lists the order numbers of the outbound
orders.

Report Layout

This section describes the layout of the Outbound Order Billing Detail Report.
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Field Description

Document Type

Figure 121. Outbound Order Billing Detail Report
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The document type of the outbound orders.

Order No.

The order number of the item.

No data is displayed in the report screen if no order exists for the item.

Order Date

The date on which the order is created.

Order Type

The type of order.

Buyer

The buyer to whom the shipment is shipped.

Seller

The seller organization.

The Outbound Order Billing Detail Report appears in portrait layout.

Group and Sort Criteria

The Outbound Order Billing Detail Report is grouped by Document Type and
Order No.

The Document Type and Order No. are sorted in ascending order.

Page Break Criteria

The Outbound Order Billing Detail Report has no page break criteria.

Outbound Order Lines Billing Detail Report
The Outbound Order Lines Billing Detail Report lists the order numbers of the
outbound orders and their order lines.

Report Layout

This section describes the layout of the Outbound Order Lines Billing Detail
Report.
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Field Description

Document Type

Figure 122. Outbound Order Lines Billing Detail Report
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The document type of the outbound orders.

Order No.

The order number of the item.

No data is displayed in the report screen if no order exists for the item.

Order Date

The date on which the order is created.

Order Type

The type of order.

Buyer

The buyer to whom the shipment is shipped.

Seller

The seller organization.

Prime Line No.

The order line number of the order.

Sub Line No.

The sub line number of the component of the item.

The Outbound Order Lines Billing Detail Report appears in portrait layout.

Group and Sort Criteria

The Outbound Order Lines Billing Detail Report is grouped by Document Type
and Order No.

The Document Type and Order No. are sorted in ascending order.

Page Break Criteria

The Outbound Order Lines Billing Detail Report has no page break criteria.

Order Cycle Time KPI Report
The Order Cycle Time KPI Report is used to measure the turnaround cycle time on
all outbound shipments or orders. Cycle time is defined as the time that elapsed
between the release of a shipment or order to a warehouse and the time it is
shipped.

Intended Audience

Warehouse managers, outbound supervisors, and as well as enterprise users, use
the Order Cycle Time KPI Report to measure the pick-pack-ship efficiency of the
warehouse. The report is generated manually.

Generate an Order Cycle Time KPI Report
About this task

To generate the Order Cycle Time KPI Report:
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Procedure
1. Navigate to Outbound > Order Cycle Time KPI Report. The Order Cycle Time

KPI Report criteria screen appears. For more information about the Order Cycle
Time KPI Report criteria screen, see "Order Cycle Time KPI Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The Order
Cycle Time KPI Report appears. For more information about the Order Cycle
Time KPI Report layout, see "Order Cycle Time KPI Report Layout".

Order Cycle Time KPI Report Criteria
The Order Cycle Time KPI Report criteria screen enables you to enter the criteria
for which the Order Cycle Time KPI Report generates.

Table 42. Order Cycle Time KPI Report Criteria Screen

Field Description Default Value Mandatory

Document Type Select the document type for
which the report is generated.

For this report, the document
types Transfer Order and
Sales Order.

Sales Order. Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Figure 123. Order Cycle Time KPI Report Criteria Screen
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Table 42. Order Cycle Time KPI Report Criteria Screen (continued)

Field Description Default Value Mandatory

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Node The node for which the report
is generated.

If you are an enterprise user,
select the appropriate node
from the drop-down list. For
other users, the current node
of the user appears.

The current node
of the user.

Yes

Actual Shipment
Date

Enter the start date and the
end date for which the report
is generated.

You can also click the and

icons to choose the date
range and time.

For Date:The
current date.

For Time: 00:00:00
and 23:59:59.

Yes

Shipment Mode Select the mode of the
shipment from the drop-
down list.

Blank. No

Carrier Enter the carrier of the
shipment.

You can also click the icon
to select the carrier.

Blank. No

Cycle Time (in
Hrs)

Enter the amount of time that
elapsed between the release of
a shipment or order to a
warehouse and the time it is
shipped.

8 Yes

Group and Sort Criteria

The Order Cycle Time KPI Report is grouped by Enterprise Code, Node, and Ship
Date.

The Enterprise Code is sorted in ascending order and Ship Date is sorted in
descending order.

Page Break Criteria

For each new enterprise, the report starts in a new table. The name of the
enterprise is printed at the top of the table.

Additional Setup Required

There is no additional setup required to generate this report.
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Order Cycle Time KPI Report Layout
This section describes the layout of the Order Cycle Time KPI Report.

Field Description

Figure 124. Order Cycle Time KPI Report
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Node

The node of the enterprise for which the report is generated.

Ship Date

The date the shipments are shipped from the warehouse.

Carrier

The carrier service used for shipping the shipments.

Ship Mode

The mode of shipping the shipments.

No. of Shipments Shipped

Displays the total number of shipments shipped from the node.

Click this to view the Order Cycle Time Detail Report Detail Report, which
displays the total number of shipments shipped.

Shipments Shipped within X hrs

Displays the number of shipments shipped within the given time interval.

Click this to view the Order Cycle Time Report Within X hours, which
displays the list of shipments shipped within X hrs.

Shipments Shipped within 2X hrs

Displays the number of shipments shipped within twice the given time
interval.

Click this to view the Order Cycle Time Report Within 2X hours, which
displays the list of shipments shipped within 2X hrs.

Shipments Shipped beyond 2X hrs

Displays the number of shipments shipped after twice the given time
interval.

Click this to view the Order Cycle Time Report Beyond 2X hours, which
displays the list of shipments shipped beyond 2X hrs.

Total number of shipments shipped.

The number of shipments shipped within x hours.

The number of shipments shipped within 2x hours.

The number of shipments shipped beyond 2x hours.

The Order Cycle Time KPI Report appears in portrait layout.

Order Cycle Time Detail Report
This report gives the list of all the outbound shipments and their details for a
particular warehouse.
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Report Layout

This section describes the layout of the Order Cycle Time Detail Report.
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Field Description

Node

Figure 125. Order Cycle Time Detail Report
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The node to where the shipment is shipped.

Shipment No.

The shipment number of the shipment shipped.

Ship Date

The date the shipments are shipped from the warehouse.

Carrier

The organization from where the items are shipped.

Ship Mode

The mode of shipping the shipments.

Cycle Time

The time between the release of elapsed from when an order to a
warehouse and to the time it is shipped.

The Order Cycle Time Detail Report appears in portrait layout.

Group and Sort Criteria

This report is grouped by Enterprise Code and Node.

The Enterprise Code, Node, and Shipment Number are sorted in ascending order.

Page Break Criteria

For each new enterprise, the report starts in a new table. The name of the
enterprise is printed at the top of the table.

Order Cycle Time Report Within X hours
This report gives the details of all the shipments shipped within X hrs.

The fields, layout, group and sort criteria and page break criteria of this report are
similar to the Order Cycle Time Detail Report.

Order Cycle Time Report Within 2X hours
This report gives the details of all the shipments shipped within 2X hrs.

The fields, layout, group and sort criteria and page break criteria of this report are
similar to the Order Cycle Time Detail Report.

Order Cycle Time Report Beyond 2X hours
This report gives the details of all the shipments shipped beyond 2X hrs.

The fields, layout, group and sort criteria and page break criteria of this report are
similar to the Order Cycle Time Detail Report.

Order Shipment Report
The Order Shipment Report provides the details of the shipments shipped against
the orders.
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This report helps to identify all shipments made against an order, as there are
many cases where an order is fulfilled in multiple shipments.

Intended Audience

Warehouse managers and outbound supervisors use the Order Shipment Report to
track all the shipments made against for an order. This report is generated
manually.

Generate an Order Shipment Report
About this task

To generate the Order Shipment Report:

Procedure
1. Navigate to Outbound > Order Shipment Report. The Order Shipment Report

criteria screen appears. For more information about the Order Shipment Report
criteria screen, see "Order Shipment Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The Order
Shipment Report appears. For more information about the Order Shipment
Report layout, see "Order Shipment Report Layout".

Order Shipment Report Criteria
The Order Shipment Report criteria screen enables you to enter the criteria for
which the Order Shipment Report generates.

Figure 126. Order Shipment Report Criteria Screen
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Table 43. Order Shipment Report Criteria Screen

Field Description Default Value Mandatory

Document Type Select the document type for
which the report is generated.

For this report, the document
types displayed are Transfer
Order and Sales Order.

Sales Order. Yes

Node The node for which the report
is generated.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Actual Ship Date Enter the start date and the
end date for which the report
is generated.

You can also click the icons
to choose the date range.

The current date. Yes

Order No Enter the order number of the
shipment.

You can click to search for
the order number.

Blank. No

Buyer Enter the name of the buyer.

You can click to search for
the buyer.

Blank. No

Group and Sort Criteria

The Order Shipment Report is grouped by Enterprise Code, Order No., and Ship
Date.

The Enterprise Code and Order No. are sorted in ascending order and Ship Date is
sorted in descending order.

Page Break Criteria

For each new enterprise, the report starts in a new table. The name of the
enterprise is printed at the top of the table.
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Additional Setup Required

There is no additional setup required to generate this report.
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Order Shipment Report Layout
This section describes the layout of the Order Shipment Report.

Figure 127. Order Shipment Report
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Field Description

Order No.

The order number for which the shipment is shipped.

Ship Date

The date on which the shipment is shipped.

Shipment No.

The number of the shipment that is shipped.

Seller

The organization that ships the shipment.

Buyer

The organization to which the shipment is shipped.

Item ID

The identifier of the item.

Item Description

The description of the item.

PC

The product class to which the item belongs.

UOM

The unit of measure for the item.

Quantity Ordered

The quantity of the item the customer has requested.

Quantity Shipped

The quantity of the item shipped to the customer.

The Order Shipment Report appears in portrait layout.

Outbound Labor Requirements Report
The Outbound Labor Requirements Report is used to determine the labor
requirements for waves or shipments that are to be picked, packed, and shipped
on a future date. This report is useful to plan resource requirements for outbound
activities.

Intended Audience

Warehouse managers and outbound supervisors use this report to plan resources
for picking.This report also helps them to decide whether to reduce shipments,
move people from other operations, or add more shipments when resources are
available.

Generate an Outbound Labor Requirements Report
About this task

To generate the Outbound Labor Requirements Report:
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Procedure
1. Navigate to Outbound > Outbound Labor Requirements Report. The Outbound

Labor Requirements criteria screen appears. For more information about the
Outbound Labor Requirements Report criteria screen, see "Outbound Labor
Requirements Report Criteria".

2. Enter the criteria and click Generate Report. The Outbound Labor
Requirements Report appears. For more information about the Outbound Labor
Requirements Report layout, see "Outbound Labor Requirements Report
Layout".

Outbound Labor Requirements Report Criteria
The Outbound Labor Requirements Report criteria screen enables you to enter the
criteria for which the Outbound Labor Requirements Report generates.

Table 44. Outbound Labor Requirements Report Criteria Screen

Field Description Default Value Mandatory

Document Type Select the document type for
which the report is generated.

For outbound reports, the
document types displayed are
Transfer Order and Sales
Order.

Sales Order. Yes

Node The Node for which the
report is generated.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Figure 128. Outbound Labor Requirements Report Criteria Screen
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Table 44. Outbound Labor Requirements Report Criteria Screen (continued)

Field Description Default Value Mandatory

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Date Range Enter the start date and the
end date for which the report
is generated.

You can also click the

icons to choose the date
range.

The previous
day’s and current
date.

Yes

Group and Sort Criteria

The Outbound Labor Requirements Report is sorted by Expected Ship Date.

The Expected Ship Date is sorted in descending order.

Page Break Criteria

For each new enterprise, the report starts in a new table. The name of the
enterprise is printed at the top of the table.

Outbound Labor Requirements Report Layout
This section describes the layout of the Outbound Labor Requirements Report.
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Field Description

Expected Shipment Date

Figure 129. Outbound Labor Requirements Report
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The date on which the shipment is expected to ship from the warehouse.

No. of Shipments

The number of shipments on that particular date.

No. of Shipment Lines

The number of shipment lines for all shipments on that particular date.

No. of Units

The total number of units shipped for all shipments on a particular date.

No. of Cases

The total number of cases shipped for all shipments on a particular date.

Person Hours Reqd

The person hours required for shipping all shipments with expected ship
date listed against the person hours.

Person Hours Reqd is calculated as follows:

Note: Person Hours Reqd = [ (No. of Shipments * SAM Per Productivity
Batch) + (No. of Shipment Lines * SAM per Item) + (No. of Units *
SAM per Unit) + (No. of Cases * SAM per Case) ] / 60

The Outbound Labor Requirements Report appears in portrait layout.

Set Up the OUTBOUND_LABOR Productivity Type
To compute the Person Hours Required, the Outbound Labor Requirements Report
depends upon the values set up in the OUTBOUND_LABOR productivity type.

About this task

To set up the OUTBOUND_LABOR productivity type:

Procedure
1. Launch the Applications Manager.
2. Navigate to Applications > Warehouse Management.
3. From the tree in the application rules side panel, choose Task Management >

Productivity > Productivity Types. The Productivity Types window appears.
4. In the Productivity Types window, select OUTBOUND_LABOUR. The

Productivity Type Details window appears.
The Sterling Warehouse Management System Reference Implementation
provides Standard Allowable Minutes (SAM) values as displayed in the
following figure.
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5. In the SAM Definition tab, for fields that do not contain zero values, enter the
appropriate SAM values. These values are used to compute the Person Hours
Required.

6. Click .

Pack and Hold Shipment Report
The Pack and Hold Shipment Report lists all shipments that are currently in the
‘pack and hold’ status, along with their location and shipper details. This report is
useful to the warehouse supervisor when reviewing pack and hold shipments.

Intended Audience

Warehouse managers and outbound supervisors use this report to keep a track of
pack and hold shipment. This report is also useful when viewing the shipments
that are near or have reached the ship date.

Generate a Pack and Hold Shipment Report
About this task

To generate the Pack and Hold Shipment Report:

Figure 130. Productivity Type Details Window, Outbound Labor
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Procedure
1. Navigate to Outbound > Pack and Hold Shipment Report. The Pack and Hold

Shipment Report criteria screen appears. For more information about the Pack
and Hold Shipment Report criteria screen, see "Pack and Hold Shipment Report
Criteria".

2. Enter the criteria and click Generate Report. The Pack and Hold Shipments
Report appears. For more information about the Pack and Hold Shipment
Report layout, see "Pack and Hold Shipment Report Layout".

Pack and Hold Shipment Report Criteria
The Pack and Hold Shipment Report criteria screen enables you to enter the
criteria for which the Pack and Hold Shipment Report generates.

Table 45. Pack and Hold Shipment Criteria Screen

Field Description Default Value Mandatory

Document Type Select the document type for
which the report is generated.

For outbound reports, the
document types displayed are
Transfer Order and Sales
Order.

Sales Order. Yes

Node The Node for which the
report is generated.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Figure 131. Pack and Hold Shipment Criteria Screen
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Table 45. Pack and Hold Shipment Criteria Screen (continued)

Field Description Default Value Mandatory

Across Enterprises Choose this to generate the
report considering all the
enterprise in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Expected Ship
Date

Enter the expected ship date. The current date. Yes

Carrier Enter the carrier of the
shipment.

You can also click to select
the carrier.

Blank. No

Group and Sort Criteria

The Pack and Hold Shipment Report is grouped by Expected Ship Date and
Shipment No.

Expected Ship Date is sorted in descending order.

Page Break Criteria

The Pack and Hold Shipment Report has no page break criteria.

Additional Setup Required

There is no additional setup required to generate this report.
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Pack and Hold Shipment Report Layout
This section describes the layout of the Pack and Hold Shipment Report.

Figure 132. Pack and Hold Shipment Report
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Field Description

Expected Ship Date

The expected date for shipment.

Shipment No.

A unique identity for shipment.

Seller

The organization that ships the shipment.

Buyer

The organization to which the shipment is shipped.

Number of Cases

The number of cases for a specific shipment.

Number of Pallets

The number of pallets for a specific shipment.

Scheduled Dock Door

The dock door scheduled for shipping the shipment.

The Pack and Hold Shipments Report appears in portrait layout.

Parcel Manifest Report
The Parcel Manifest Report lists the Parcel manifest details in terms of shipment
details, number of containers, weight, and other details for the selected manifest
date, or carrier and service.

Intended Audience

Warehouse managers and outbound supervisors use this report to estimate the
manifest.To access this report, the user must belong to the data security group
representing warehouse managers.

Generate a Parcel Manifest Report
About this task

To generate the Parcel Manifest Report:

Procedure
1. Navigate to Outbound > Parcel Manifest Report. The Parcel Manifest Report

criteria screen appears. For more information about the Parcel Manifest Report
criteria screen, see "Parcel Manifest Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The Parcel
Manifest Report appears. For more information about the Parcel Manifest
Report layout, see "Parcel Manifest Report Layout".

Parcel Manifest Report Criteria
The Parcel Manifest Report criteria screen enables you to enter the criteria for
which the Parcel Manifest Report generates.
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Table 46. Parcel Manifest Report Criteria Screen

Field Description Default Value Mandatory

Document Type Select the document type for
which the report is generated.

For outbound reports, the
document types displayed are
Transfer Order and Sales
Order.

Sales Order. Yes

Node The node for which the report
is generated.

The current node
of the user.

Yes

Manifest Date Enter the start date and the
end date of manifesting for
which the report is generated.

You can also click the
icons to choose the date
range.

The current date. Yes

Carrier Enter the carrier.

You can also click icon to
select the carrier for this
enterprise.

Blank. No

Note: If this report has been executed using the default report criteria parameters,
there may be a delay in fetching data. Therefore, it is recommended that you
update the report criteria such that only the required data is fetched.

Group and Sort Criteria

The Parcel Manifest Report is grouped by Manifest Date and Carrier.

Manifest Date is sorted in descending order.

Page Break Criteria

The Parcel Manifest Report has no page break criteria.

Figure 133. Parcel Manifest Report Criteria Screen
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Additional Setup Required

There is no additional setup required to generate this report.
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Parcel Manifest Report Layout
This section describes the layout of the Parcel Manifest Report.

Figure 134. Parcel Manifest Report
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Field Description

Carrier/Service

The carrier for this manifest.

Manifest Date

The date of manifest.

Weight

The actual weight of the shipment container.

Weight UOM

The actual weight in terms of UOM.

No. of Parcels

Total number of packages shipped using the carrier service.

Basic Freight Charge

The basic freight charges for the packages shipped using the carrier
service.

Special Service Surcharge

The charges for the packages shipped using the carrier service.

Charge Currency

The currency in which the charges display.

Total for Carrier/Service

The total of the Basic Freight Charge and Special Service Surcharge for a
particular carrier or service.

Summary

The total of the Basic Freight Charge and Special Service Surcharge across
all carriers or services.

The Parcel Manifest Report appears in portrait layout.

Replenishment Status Report
The Replenishment Status Report helps the monitoring of replenishment activities
in the warehouse. The report provides information about the replenishment status
and highlights shortages or overages of replenishment quantities.

Intended Audience

In the Replenishment Status Report, the Replenishment Quantities mode helps the
outbound supervisors, inventory supervisors, and warehouse managers when
generating the replenishment tasks for those locations whose item quantity needs
to be increased.

Generate a Replenishment Status Report
About this task

To generate the Replenishment Status Report:
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Procedure
1. Navigate to Outbound > Replenishment Status Report. The Replenishment

Status Report criteria screen appears. For more information about the
Replenishment Status Report criteria screen, see "Replenishment Status Report
Criteria".

2. Enter the criteria and click Generate Report to generate the report. The
Replenishment Status Report appears. For more information about the
Replenishment Status Report layout, see "Replenishment Status Report Layout".

Replenishment Status Report Criteria
The Replenishment Status Report criteria screen enables you to enter the criteria
for which the Replenishment Status Report generates.

Table 47. Replenishment Status Report Criteria Screen

Field Description Default Value Mandatory

Node The Node for which the
report is generated.

The current node
of the user.

Yes

Zone Enter the zone for which the
report is generated.

You can also click to
choose the zone.

Click to enter more zones.
These zones are taken into
consideration while
generating the report.

Click to remove a specific
zone.

Selected. No

Wave No. Enter the Wave number for
which the report is generated.

Selected. No

Figure 135. Replenishment Status Report Criteria Screen
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Table 47. Replenishment Status Report Criteria Screen (continued)

Field Description Default Value Mandatory

Display
Replenishment By
Quantity

Check this box to generate the
report for the locations that
currently have less than
location capacity
replenishment quantities. This
includes the pend-in quantity.

Note: It is mandatory to select
any one of the check boxes to
execute the report.

Selected. No

Display
Replenishment By
Location Capacity

Check this box to generate the
report for the locations that
have on-hand quantity that is
more than the location
capacity. This includes the
pend-in quantity.

Note: It is mandatory to select
any one of the check boxes to
execute the report.

Selected. No

Group and Sort Criteria

The Replenishment Status Report is grouped by Location ID.

The Location ID is sorted in ascending order.

Page Break Criteria

The Replenishment Status Report has no page break criteria.

Additional Setup Required

There is no additional setup required to generate this report.
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Replenishment Status Report Layout
This section describes the layout of the Replenishment Status Report.

Figure 136. Replenishment Status Report
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Field Description

Location ID

The identifier of the location for which the report is generated.

Item ID

The identifier of the item.

Item Description

The description of the item.

PC

The product class of the item.

UOM

The unit of measure for the item.

Demand Quantity

The quantity of items that are in demand.

On Hand Quantity

The available quantity of the items in the location.

Pend In Quantity

The quantity of items expected at the location.

Field Description

Location ID

The identifier of the location for which the report is generated.

Item ID

The identifier of the item.

Item Description

The description of the item.

PC

The product class of the item.

UOM

The unit of measure for the item.

On Hand Quantity

The available quantity of the items in the location.

Pend In Quantity

The quantity of items expected at the location.

Pend Out Quantity

The quantity of items that are in demand.

Location Size Code

The size code which indicates the capacity of the location.

Location Capacity (x)
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The volume of the location.

Capacity Needed

The capacity needed in multiples of current volume.

The Replenishment Status Report appears in portrait layout.

Same Day Pick Pack Ship Percentage Report
The Same Day Pick Pack Ship Percentage Report gives a measure of the number of
shipments picked, packed, and shipped on the same day. The criterion for any
shipment to be counted is that the pick date is the same as the actual ship date.

Intended Audience

Warehouse managers and outbound supervisors use this report to track the
percentage of items that are picked, packed, and shipped on a monthly basis.

Generate a Same Day Pick Pack Ship Percentage Report
About this task

To generate the Same Day Pick Pack Ship Percentage Report:

Procedure
1. Navigate to Outbound > Same Day Pick Pack% Report. The Same Day Pick

Pack Percentage Report criteria screen appears. For more information about the
Same Day Pick Pack Ship Percentage Report criteria screen, see "Same Day Pick
Pack Ship Percentage Report Criteria".

2. Enter the criteria and click Generate Report. The Same Day Pick Pack Ship
Percentage Report appears. For more information about the Same Day Pick
Pack Ship Percentage Report layout, see "Same Day Pick Pack Ship Percentage
Report Layout".

Same Day Pick Pack Ship Percentage Report Criteria
The Same Day Pick Pack Ship Percentage Report enables you to enter the criteria
for which the Same Day Pick Pack Ship Percentage Report generates.
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Table 48. Same Day Pick Pack Percentage Report Criteria Screen

Field Description Default Value Mandatory

Document Type Select the document type for
which the report is generated.

For outbound reports, the
document types displayed are
Transfer Order and Sales
Order.

Sales Order. Yes

Node The node for which the report
is generated.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Actual Ship Date Enter the start date and end
date for which the report is
generated.

You can also click the
icons to choose the date
range.

Selected. Yes

Figure 137. Same Day Pick Pack Percentage Report Criteria Screen
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Group and Sort Criteria

The Same Day Pick Pack Percentage Report has no group or sort criteria.

Page Break Criteria

The Same Day Pick Pack Percentage Report has no page break criteria.

Additional Setup Required

There is no additional setup required to generate this report.

Same Day Pick Pack Ship Percentage Report Layout
This section describes the layout of the Same Day Pick Pack Ship Percentage
Report.
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Field Description

Percentage of Shipments Shipped on Same Day

Figure 138. Same Day Pick Pack Ship Percentage Report
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The percentage of shipments shipped on the same day in a particular
month.

Month

The month in which the item was picked packed and shipped.

The Same Day Pick Pack Percentage Report appears in portrait layout.

Shipment Billing Summary Report
The Shipment Billing Summary Report displays the number of outbound
shipments and outbound shipment lines shipped from the warehouse, and the
number of receipts and receipt lines received. The number of receipts and receipt
lines received indicates the number of inbound shipments that are in the Closed
status, and the corresponding number of inbound shipment lines received in the
warehouse. This report also lists the transaction details for the transactions in the
details report.

Intended Audience

Inventory supervisors, outbound supervisors, and as well as enterprise users, use
the Shipment Billing Summary Report to track the transactions made for a
particular date range.

Generate a Shipment Billing Summary Report
About this task

To generate the Shipment Billing Summary Report:

Procedure
1. Navigate to Outbound > Shipment Billing Summary Report. The Shipment

Billing Summary Report criteria screen appears. For more information about
the Shipment Billing Summary Report criteria screen, see "Shipment Billing
Summary Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The
Shipment Billing Summary Report appears. For more information about the
Shipment Billing Summary Report layout, see "Shipment Billing Summary
Report Layout".

Shipment Billing Summary Report Criteria
The Shipment Billing Summary Report criteria screen enables you to enter the
criteria for which the Shipment Billing Summary Report generates.
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Table 49. Shipment Billing Summary Report Criteria screen

Field Description Default Value Mandatory

Node The node for which the report
is generated.

If you are an enterprise user,
select the appropriate node
from the drop-down list. For
other users, the current node
of the user appears.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Ship Date Enter the start date and the
end date for which the report
is generated.

You can also click the
icons to choose the date
range.

The date one
month prior to the
current date and
the current date.

Yes

Group and Sort Criteria

The Shipment Billing Summary Report is grouped by Enterprise Code, Node, and
Date.

The Enterprise Code and Node are sorted in ascending order, and Date is sorted in
descending order.

Figure 139. Shipment Billing Summary Report Criteria Screen

Chapter 6. Outbound Reports 301



Page Break Criteria

For each new enterprise, the report starts in a new table on another page. The
name of the enterprise is printed at the top of the table.

Additional Setup Required

Run the CLOSE_SHIPMENT agent to close the shipments. These closed shipments are
displayed by the Shipment Billing Summary Report.
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Shipment Billing Summary Report Layout
This section describes the layout of the Shipment Billing Summary Report.

Figure 140. Shipment Billing Summary Report
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Field Description

Node

The node of the enterprise for which the report is generated.

Date

The date when the transaction is made.

No. of Inbound Shipments

The number of inbound shipments.

Click this to view the Inbound Shipment Billing Detail Report screen.

No. of Inbound Shipment Lines

The number of inbound shipment lines.

Click this to view the Inbound Shipment Lines Billing Detail Report screen.

No of Outbound Shipments

The number of outbound shipments.

Click this to view the Outbound Shipment Billing Detail Report screen.

No of Outbound Shipment Lines

The number of outbound shipment lines.

Click this to view the Outbound Shipment Lines Billing Detail Report
screen.

Total for E1

The total number of transactions for the enterprise, within a specified date
range.

Grand Total

The grand total of the transactions for multiple enterprises, within a
specified date range.

The Shipment Billing Summary Report appears in portrait layout.

Inbound Shipment Billing Detail Report
The Inbound Shipment Billing Detail Report lists the shipment number, seller, and
buyer of the inbound shipment.

Report Layout

This section describes the layout of the Inbound Shipment Billing Detail Report.
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Field Description

Document Type

Figure 141. Inbound Shipment Billing Detail Report
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Displays the document type of the inbound shipment.

Shipment No.

The shipment number of the shipment.

Seller

The organization which ships the shipment.

Buyer

The organization to which the shipment is shipped.

The Inbound Shipment Billing Detail Report appears in portrait layout.

Group and Sort Criteria

The Inbound Shipment Billing Detail Report is grouped by Document Type and
Shipment No.

The Document Type and Shipment No. are sorted in ascending order.

Page Break Criteria

The Inbound Shipment Billing Detail Report has no page break criteria.

Inbound Shipment Lines Billing Detail Report
The Inbound Shipment Lines Billing Detail Report lists the details of the items in
the shipment.

Report Layout

This section describes the report layout of the Inbound Shipment Lines Billing
Detail Report.
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Field Description

Document Type

Figure 142. Inbound Shipment Lines Billing Detail Report
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Displays the document type of the inbound shipment.

Shipment No.

The shipment number of the shipment.

Seller

The organization that ships the shipment.

Buyer

The organization to which the shipment is shipped.

Prime Line No.

The shipment line of the shipment.

Sub Line No.

The sub line number of the component of the item.

The Inbound Shipment Lines Billing Detail Report appears in portrait layout.

Group and Sort Criteria

The Inbound Shipment Lines Billing Detail Report is grouped by Document Type
and Shipment No.

The Document Type and Shipment No. are sorted in ascending order.

Page Break Criteria

The Inbound Shipment Lines Billing Detail Report has no page break criteria.

Outbound Shipment Billing Detail Report
The Outbound Shipment Billing Detail Report lists the shipment numbers of the
outbound shipment.

Report Layout

This section describes the layout of the Outbound Shipment Billing Detail Report.
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Field Description

Document Type

Figure 143. Outbound Shipment Billing Detail Report
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Displays the document type of the outbound shipments.

Shipment No.

The shipment number of the shipments shipped during the day.

Seller

The organization that ships the shipment.

Buyer

The organization to which the shipment is shipped.

The Outbound Shipment Billing Detail Report appears in portrait layout.

Group and Sort Criteria

The Outbound Shipment Billing Detail Report is grouped by Document Type and
Shipment No.

The Document Type and Shipment No. are sorted in ascending order.

Page Break Criteria

The Outbound Shipment Billing Detail Report has no page break criteria.

Outbound Shipment Lines Billing Detail Report
The Outbound Shipment Lines Billing Detail Report lists the shipment line number
for the shipment number of the outbound shipment.

Report Layout

This section describes the layout of the Outbound Shipment Lines Billing Detail
Report.
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Field Description

Document Type

Figure 144. Outbound Shipment Lines Billing Detail Report
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Displays the document type of the outbound shipments.

Shipment No.

The shipment number of the shipments shipped during the day.

Seller

The organization that which ships the shipment.

Buyer

The organization to which the shipment is shipped.

Prime Line No.

The shipment line of the shipment.

Sub Line No.

The sub line number of the component of the item.

The Outbound Shipment Lines Billing Detail Report appears in portrait layout.

Group and Sort Criteria

The Outbound Shipment Lines Billing Detail Report is grouped by Document Type
and Shipment No.

The Document Type and Shipment No. are sorted in ascending order.

Page Break Criteria

The Outbound Shipment Lines Billing Detail Report has no page break criteria.

Shipment Fill Rate Monthly Report
The Shipment Fill Rate Monthly Report shows the percentage of complete
shipments shipped by the warehouse. The percentage is calculated as the ratio of
the complete shipments shipped to the total number of shipments shipped by the
node.

Intended Audience

Warehouse managers and outbound supervisors use the Shipment Fill Rate
Monthly Report to track the percentage of complete shipments shipped. The report
is generated manually.

Generate a Shipment Fill Rate Monthly Report
About this task

To generate the Shipment Fill Rate Monthly Report:

Procedure
1. Navigate to Outbound > Shipment Fill Rate Monthly Report. The Shipment Fill

Rate Monthly Report criteria Screen appears. For more information about the
Shipment Fill Rate Monthly Report criteria screen, see "Shipment Fill Rate
Monthly Report Criteria".
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2. Enter the criteria and click Generate Report to generate the report. The
Shipment Fill Rate Monthly Report appears. For more information about the
Shipment Fill Rate Monthly Report layout, see "Shipment Fill Rate Monthly
Report Layout".

Shipment Fill Rate Monthly Report Criteria
The Shipment Fill Rate Monthly Report criteria screen enables you to enter the
criteria for which the Shipment Fill Rate Monthly Report generates.

Table 50. Shipment Fill Rate Monthly Report Criteria Screen

Field Description Default Value Mandatory

Document Type Select the document type for
which the report is generated.

For this report, the document
types displayed are Transfer
Order and Sales Order.

Sales Order. Yes

Node The node for which the report
is generated.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Figure 145. Shipment Fill Rate Monthly Report Criteria Screen
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Table 50. Shipment Fill Rate Monthly Report Criteria Screen (continued)

Field Description Default Value Mandatory

Date Range Enter the start date and the
end date for which the report
is generated.

You can also click the
icons to choose the date
range.

The current date. Yes

Group and Sort Criteria

The Shipment Fill Rate Monthly Report is grouped by node.

Page Break Criteria

The Shipment Fill Rate Monthly Report has no page break criteria.

Additional Setup Required

There is no additional setup required to generate this report.
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Shipment Fill Rate Monthly Report Layout
This section describes the layout of the Shipment Fill Rate Monthly Report.

Figure 146. Shipment Fill Rate Monthly Report
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Field Description

Months Grouped By Enterprise Code

The months during which complete shipments are shipped by the
warehouse.

This is grouped by Enterprise Code.

Percentage Of Complete Shipments

The percentage of complete shipments shipped for the particular month.

For each month the percentage of complete shipments shipped is printed on top of
the bar representing the shipment shipped in a month.

The Shipment Fill Rate Monthly Report appears in portrait layout.

Shipments Near or Past Cancel Date Report
The Shipments Near or Past Cancel Date Report lists unshipped shipments that are
near or past the selected order cancel date range. This report is useful to track the
shipments that are due and manage resources to generate the same.

Intended Audience

Warehouse managers and outbound supervisors use this report to ensure that all
shipments approaching the order cancel dates are processed and shipped as
scheduled.

Generate a Shipments Near or Past Cancel Date Report
About this task

To generate the Shipments Near or Past Cancel Date Report:

Procedure
1. Navigate to Outbound > The Shipments Near or Past Cancel Date Report

criteria screen appears. For more information about the Shipments Near or Past
Cancel Date Report criteria screen, see "Shipments Near or Past Cancel Date
Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The
Shipments Near or Past Cancel Date Report appears. For more information
about the Shipments Near or Past Cancel Date Report layout, see "Shipments
Near or Past Cancel Date Report Layout".

Shipments Near or Past Cancel Date Report Criteria
The Shipments Near or Past Cancel Date Report criteria screen enables you to
enter the criteria for which the Shipments Near or Past Cancel Date Report
generates.
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Table 51. Shipments Near or Past Cancel Date Report Criteria Screen

Field Description Default Value Mandatory

Document Type Select the document type for
which the report is generated.

For this report, the document
types displayed are Transfer
Order and Sales Order.

Sales Order. Yes

Node The node for which the report
is generated.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Look for Cancel
Dates Upto

Enter the number of days. 2. Yes

Figure 147. Shipments Near or Past Cancel Date Report Criteria Screen
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Table 51. Shipments Near or Past Cancel Date Report Criteria Screen (continued)

Field Description Default Value Mandatory

Show Shipments
with Cancel Date
in the Past

Choose yes to display the
shipments with past cancel
dates.

Choose No to avoid the
display.

Selected. Yes

Customer Enter the customer.

You can also click to
choose the customer.

Blank. No

Group and Sort Criteria

The Shipments Near or Past Cancel Date Report is grouped by Shipment No.

Shipment No. is sorted in ascending order.

Page Break Criteria

For each new enterprise, the report starts in a new table. The name of the
enterprise is printed at the top of the table.

Additional Setup Required

There is no additional setup required to generate this report.

Shipments Near or Past Cancel Date Report Layout
This section describes the layout of the Shipments Near or Past Cancel Date
Report.
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Field Description

Cancel Date

The cancel date for a specific shipment.

Shipment No.

A unique identifier for the shipment.

Shipment Status

The status of the shipment.

Figure 148. Shipments Near or Past Cancel Date Report
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Expected Shipment Date

The expected date of the shipment.

Order No.

A unique identifier for the order.

Buyer

The buyer organization.

The Shipments Near or Past Cancel Date Report appears in portrait layout.

Shipment Shortage Report
The Shipment Shortage Report lists all shipped shipments that have item
shortages. This helps warehouse managers to manage exceptions.

Intended Audience

Warehouse managers and outbound supervisors use this report to manage
exceptions which helps them to take the appropriate action if shortages are
detected earlier in the shipment life cycle.

Generate a Shipment Shortage Report
About this task

To generate the Shipment Shortage Report:

Procedure
1. Navigate to Outbound > Shipment Shortage Report. The Shipment Shortage

Report criteria screen appears. For more information about the Shipment
Shortage Report criteria screen, see "Shipment Shortage Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The
Shipment Shortage Report appears. For more information about the Shipment
Shortage Report layout, see "Shipment Shortage Report Layout".

Shipment Shortage Report Criteria
The Shipment Shortage Report criteria screen enables you to enter the criteria for
which the Shipment Shortage Report generates.
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Table 52. Shipment Shortage Report Criteria Screen

Field Description Default Value Mandatory

Document Type Select the document type for
which the report is generated.

For outbound reports, the
document types displayed are
Transfer Order and Sales
Order.

Sales Order. Yes

Node The node for which the report
is generated.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all the
enterprises in which the user
participates.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Actual Ship Date Enter the start date and the
end date of shipment for
which the report is generated.

You can also click the
icons to choose the date
range.

The current date. Yes

Figure 149. Shipment Shortage Report Criteria Screen
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Shipment Shortage Report Layout
This section describes the layout of the Shipment Shortage Report.

322 Sterling Warehouse Management System: Reports Guide



Field Description

Ship Date

Figure 150. Shipment Shortage Report
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The date of shipment.

Shipment No.

A unique description for shipment.

Seller

The organization which ships the shipment.

Item ID

The identifier of the item.

Item Description

The description of the item.

PC

The product class to which the item belongs.

UOM

The unit of measure.

Original Quantity

The quantity of the items requested by the customer.

Shipment Quantity

The actual quantity of items being shipped to the customer.

Shortage Quantity

The total shortage quantity of the items, within a specific node.

The Shipment Shortage Report appears in portrait layout.

Group and Sort Criteria

The Shipment Shortage Report is grouped by Enterprise Code, Ship Date,
Shipment No., and Item ID.

Enterprise Code, Shipment No., and Ship Date are sorted in ascending order.

Page Break Criteria

For each new enterprise, the report starts in a new table on another page. The
name of the enterprise is printed at the top of the table.

Additional Setup Required

There is no additional setup required to generate this report.

Staging Locations Report
Warehouses have limited staging locations. This may become a bottleneck if not
managed properly. This report provides a means to identify the locations that may
be occupying space with shipments that are either not loaded or are awaiting
containers.

Note: The staging locations that are considered by this report are the shipment
sort locations that are used to sort the shipment containers before shipping them.
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Intended Audience

Outbound supervisors use the Staging Locations Report to track the percentage of
complete shipments shipped. The report is generated manually.

Generate a Staging Locations Report
About this task

To generate the Staging Locations Report

Procedure
1. Navigate to Outbound > Staging Locations Report. The Staging Locations

Report criteria Screen appears. For more information about the Staging
Locations Report criteria screen, see "Staging Locations Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. Depending
on the selection, that particular Staging Locations Report screen appears.
For more information about the Staging Locations Report, Sort By Location, see
"Staging Locations Report, Sort By Location Layout".
For more information about the Staging Locations Report, Sort By Time, see
"Staging Locations Report, Sort By Time Layout".

Staging Locations Report Criteria
The Staging Locations Report criteria screen enables you to enter the criteria for
which the Staging Locations Report generates.

Figure 151. Staging Locations Report Criteria Screen
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Table 53. Staging Locations Report Criteria Screen

Field Description Default Value Mandatory

Document Type Select the document type for
which the report is generated.

For this report, the document
types displayed are Transfer
Order and Sales Order.

Sales Order. Yes

Node The node for which the report
is generated.

The current node
of the user.

Yes

Zone Enter the zone for which the
report is generated.

You can also click to
choose the zone.

Blank. No

Wave No. Enter the wave number for
which the report is generated.

Blank. No

Sort By Locations Choose this to view the
Staging Locations Report, Sort
By Location.

Selected. Yes

Sort By Time Since
Last Activity

Choose this to view the
Staging Locations Report, Sort
By Time.

Not Selected. Yes

Staging Locations Report, Sort By Location Layout
The Staging Locations Report, Sort By Location provides the report based on the
locations staged.

This section describes the layout of the Staging Locations Report, Sort By Location.

326 Sterling Warehouse Management System: Reports Guide



Field Description

Location ID

Figure 152. Staging Locations Report, Sort By Location
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The location identifier of the shipments staged in the location.

Shipment No.

The shipment number of the shipment in the location.

Seller

The organization that ships the shipment.

No. Of Cases

The number of cases of the shipment being shipped.

No. Of Pallets

The number of pallets of the shipment being shipped.

Wave No.

The unique number of a wave for the warehouse.

% Complete (Quantity)

The percentage of the shipment quantity that has been staged in the
staging location.

Time Since Last Activity(Days:Hrs)

The time elapsed since the last shipment was staged in the location.

The Staging Locations Report, Sort By Location appears in portrait layout.

Group and Sort Criteria

The Staging Locations Report, Sort By Location has no group and sort criteria.

Page Break Criteria

The Staging Locations Report, Sort By Location has no page break criteria.

Additional Setup Required

There is no additional setup required to generate this report.

Staging Locations Report, Sort By Time Layout
The Staging Locations Report, Sort By Time provides the report based on the time.

This section describes the layout of the Staging Locations Report, Sort By Time.
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Field Description

Time Since Last Activity(Days:Hrs)

Figure 153. Staging Locations Report, Sort By Time
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The time elapsed since the last shipment was staged in the location.

Shipment No.

The shipment number of the shipment.

Seller

The organization that ships the shipment.

No of Cases

The number of cases of the shipment being shipped.

No of Pallets

The number of pallets of the shipment being shipped.

Wave No.

The unique number of a wave for the warehouse.

% Complete (Quantity)

The percentage of the shipment quantity that has been staged in the
staging location.

Location ID

The location identifier of the shipments staged in the location.

The Staging Locations Report, Sort By Time appears in portrait layout.

Group and Sort Criteria

The Staging Locations Report, Sort By Time has no group and sort criteria.

Page Break Criteria

The Staging Locations Report, Sort By Time has no page break criteria.

Additional Setup Required

There is no additional setup required to generate this report.
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Chapter 7. Task Reports

In-Progress Container Summary Report
The In-Progress Container Summary Report shows the current status of the
pick-pack-ship process. The default Container Summary view shows two graphs:
Container Dashboard by statuses and Container by Carriers.

Intended Audience

Warehouse managers, inbound supervisors, inventory supervisors, and outbound
supervisors use this report to track containers in different statuses. To access this
report, the user must belong to the data security group representing warehouse
managers, inbound supervisors, inventory supervisors, or outbound supervisors.

Generate an In-Progress Container Summary Report
To generate the In-Progress Container Summary Report:

About this task

Procedure
1. Navigate to Task > In-Progress Container Summary Report. The In-Progress

Container Summary Report criteria screen appears. For more information about
the In-Progress Container Summary Report criteria screen, see "In-Progress
Container Summary Report Criteria".

2. Enter the criteria and click Generate Report. The In-Progress Container
Summary Report appears. For more information about the In-Progress
Container Summary Report layout, see "In-Progress Container Summary Report
Layout".

In-Progress Container Summary Report Criteria
The In-Progress Container Summary Report criteria screen enables you to enter the
criteria for which the In-Progress Container Summary Report generates.

© Copyright IBM Corp. 2005, 2012 331



Table 54. In-Progress Container Summary Report Criteria Screen

Field Description Default Value Mandatory

Document Type The document type for which
the report is generated.

For this report, the document
types displayed are Transfer
Order and Sales Order.

Sales Order. Yes

Node The node for which the report
is generated.

If you are an enterprise user,
select the appropriate node
from the drop-down list. For
other users, the current node
of the user appears.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all
enterprises.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Figure 154. In-Progress Container Summary Report Criteria Screen
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Table 54. In-Progress Container Summary Report Criteria Screen (continued)

Field Description Default Value Mandatory

Date Enter the date. The report lists
containers with expected ship
dates less than or equal to this
date.

You can also click the icon
to choose the date.

The current date. Yes

Shipment Mode Select the mode in which the
container is shipped.

Blank. No

Carrier Enter the carrier used to
transport the container.

You can also click the icon
to choose the carrier.

Blank. No

Group and Sort Criteria

The In-Progress Container Summary Report has no group or sort criteria.

Page Break Criteria

The In-Progress Container Summary Report has no page break criteria.

Additional Setup Required

There is no additional setup required to generate this report.

Note: On refreshing the In-Progress Container Summary Report screen, the
Sterling Warehouse Management System may prompt users to enter their specific
locale code, for example, a U.S user must enter en_US_EST as the locale code, and
click OK.

In-Progress Container Summary Report Layout
This section describes the layout of the In-Progress Container Summary Report.
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Note: Based on the status of containers available in the warehouse, the Status
column in the table that is displayed in the In-Progress Container Summary Report
displays one or more of the following statuses:
v Picked
v Packed
v Shipped
v Manifested

Field Description

No. of containers

The total number of containers in a certain status.

Status

The number of containers that are in a certain status.

The statuses can be either Picked, Packed, Manifested, or Shipped.

Status - Picked

The total number of shipments in the picked status.

Status - Packed

The total number of shipments in the packed status.

Status - Manifested

The total number of shipments in the manifested status.

Status - Shipped

Figure 155. In-Progress Container Summary Report
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The total number of the shipments in the shipped status.

Regions of this color indicate the number of containers that are in Packed,
Manifested, or Shipped status.

Regions of this color indicate the number of containers that are yet to be
Packed, Manifested, or Shipped.

Field Description

No. of containers

The number of containers transported by a certain carrier.

Carrier

The carrier selected by you in the criteria screen.

If you did not select any carrier in the criteria screen, each carrier used to
transport the containers appears in the graph, along with the number of
containers in various statuses.

Regions of this color indicate the number of containers in Manifested
status.

Regions of this color indicate the number of containers in Shipped status.

Field Description

Enterprise Code

The enterprise code of the enterprise that ships the containers.

Document Type

The document type of the shipment.

Carrier

The carrier that transports the container.

Shipment Mode

The mode of transportation for the container.

Status

The current status of the container.

The status can be Manifested, Packed, or Shipped.

Click Manifested to view the In-Progress Container Details Report, Packed,
which provides a detailed report for containers that are in Manifested
status.

Click Packed to view the In-Progress Container Details Report, Packed,
which provides a detailed report for containers that are in Packed status.

Click Shipped to view the In-Progress Container Details Report, Packed,
which provides a detailed report for containers that are in Shipped status.

Completed Containers
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The total number of containers that have been Packed, Manifested or
Shipped.

The In-Progress Container Summary Report appears in landscape layout.

In-Progress Container Details Report, Packed
This report provides details for containers that are in packed status.

Note: The value of Status indicates whether the In-Progress Container Details
Report is for containers that are in Packed status.

The value of status is Packed in the In-Progress Container Summary Report for
Packed.

Report Layout

This section describes the layout of the In-Progress Container Details Report for
packed status.

Field Description

Figure 156. In-Progress Container Details Report
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Container No.

The container number on the container.

Ship To

The node to which the container is shipped.

Carrier

The carrier that transports the containers.

Time Since Last Activity

The amount of elapsed time since the last activity was performed.

The In-Progress Container Details Report appears in landscape layout.

Group and Sort Criteria

The In-Progress Container Details Report, Packed has no group criteria or sort
criteria.

Page Break Criteria

The In-Progress Container Details Report, Packed has no page break criteria.

In-Progress Container Details Report, Manifested
This report provides details for containers that are in manifested status.

Note: The value of Status indicates whether the In-Progress Container Details
Report is for containers that are in Manifested status.

The value of status is Packed in the In-Progress Container Summary Report for
Manifested.

The fields, layout, group and sort criteria, and page break criteria of this report are
similar to the In-Progress Container Details Report, Packed.

In-Progress Container Details Report, Shipped
This report provides details for containers that are in shipped status.

Note: The value of Status indicates whether the In-Progress Container Details
Report is for containers that are in Shipped status.

The value of status is Packed in the In-Progress Container Summary Report for
Shipped.

The fields, layout, group and sort criteria, and page break criteria of this report are
similar to the In-Progress Container Details Report, Packed.

In-Progress Shipment Summary Report
The In-Progress Shipment Summary Report shows the current status of the
pick-pack-ship process. The default Shipment Summary view shows two graphs:
Shipments by Statuses and Shipments by Carriers.
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Intended Audience

Warehouse managers, inbound supervisors, inventory supervisors, and outbound
supervisors use this report to track shipments in different statuses. To access this
report, the user must belong to the data security group representing warehouse
managers, receiving supervisors, inventory supervisors, shipping supervisors, or
enterprise users.

Generate an In-Progress Shipment Summary Report
About this task

To generate the In-Progress Shipment Summary Report:

Procedure
1. Navigate to Task > In-Progress Shipment Summary Report. The In-Progress

Shipment Summary Report criteria screen appears.
2. Enter the criteria and click Generate Report to generate the report. The

In-Progress Shipment Summary Report Screen appears.

In-Progress Shipment Summary Report Criteria
The In-Progress Shipment Summary Report criteria screen enables you to enter the
criteria for which the In-Progress Shipment Summary Report generates.

Table 55. The In-Progress Shipment Summary Report Criteria Screen

Field Description Default Value Mandatory

Document Type Select the document type for
which the report is generated.

For this report, the document
types displayed are Transfer
Order and Sales Order.

Sales Order Yes

Figure 157. The In-Progress Shipment Summary Report Criteria Screen

338 Sterling Warehouse Management System: Reports Guide



Table 55. The In-Progress Shipment Summary Report Criteria Screen (continued)

Field Description Default Value Mandatory

Node The node for which the report
is generated.

If you are an enterprise user,
select the appropriate node
from the drop-down list. For
other users, the current node
of the user appears.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all
enterprises.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Ship Date Enter the date. The report lists
shipments with expected ship
dates less than or equal to this
date.

You can also click the Date
Range icon to choose the
date.

The current date. Yes

Shipment Mode Select the mode in which the
container is shipped from the
drop down menu list.

Blank. No

Carrier Enter the carrier used to
transport the container.

You can also click the Search
icon to choose the carrier.

Blank. No

Group and Sort Criteria

The In-Progress Shipment Summary Report has no Group and Sort Criteria.

Page Break Criteria

The In-Progress Shipment Summary Report has no page break criteria.

Additional Setup Required

There is no additional setup required to generate this report.
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Note: On refreshing the In-Progress Shipment Summary Report screen, the Sterling
Warehouse Management System may prompt users to enter their specific locale
code, for example, a U.S user must enter en_US_EST as the locale code, and click
OK.

In-Progress Shipment Summary Report Layout
This section describes about the layout of the In-Progress Shipment Summary
Report.

Note: Based on the status of containers available in the warehouse, the Status
column in the table that is displayed in the In-Progress Shipment Summary Report
displays one or more of the following statuses:
v Picked
v Packed
v Shipped
v Manifested

Field Description

No. of Shipments

The total number of shipments in a certain status.

Status

The number of shipments that are in a certain status.

The statuses can be either Picked, Packed, Manifested, or Shipped.

Status - Picked

Figure 158. In-Progress Shipment Summary Report
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The total number of shipments in the picked status.

Status - Packed

The total number of shipments in the packed status.

Status - Manifested

The total number of shipments in the manifested status.

Status - Shipped

The total number of shipments in the shipped status.

Regions of this color indicate the number of shipments that are in packed
or manifested status.

Regions of this color indicate the number of shipments that are yet to be
packed or manifested.

Field Description

No. of Shipments

The total number of shipments transported by a certain carrier.

Carrier

The carrier selected by you in the criteria screen.

If you did not select any carrier in the criteria screen, each carrier used to
transport the shipments appears in the graph, along with the number of
containers in various statuses.

Regions of this color indicate the number of shipments in Shipped status.

Regions of this color indicate the number of shipments in Manifested
status.

Field Description

Enterprise Code

The enterprise code of the enterprise that ships the shipments.

Document Type

The document type of the shipment.

Carrier

The carrier that transports the shipment.

Shipment Mode

The mode of transportation for the container.

Status

The current status of the shipment.

The status can be Packed or Manifested.
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Click Packed to view the In-Progress Shipment Details Report, Picked,
which provides a detailed report for containers that are in Packed status.

Click Manifested to view the In-Progress Shipment Details Report, Picked,
which provides a detailed report for containers that are in Manifested
status.

Completed Shipments

The total number of shipments that have been Packed as well as
Manifested.

The In-Progress Shipment Summary Report is displayed in landscape layout.

In-Progress Shipment Details Report, Picked
This report provides details for shipments that are in the Picked status.

Note: The value of Status indicates whether the In-Progress Shipment Details
Report is for shipments that are in Picked status.

The value of status is Picked in the In-Progress Shipment Summary Report for
Picked.

The value of Shipment Mode and Carrier is the same as that of the containers
whose status you click in the In-Progress Shipment Summary Report.

Report Layout

This section describes the layout of the In-Progress Shipment Details Report for the
Picked status.

Field Description

Shipment No.

The shipment number on the container.

Ship To

The node to which the container is shipped.

Figure 159. In-Progress Shipment Details Report
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Carrier

The carrier that transports the containers.

Time Since Last Activity

The amount of elapsed time since the last activity was formed.

The In-Progress Shipment Details Report appears in landscape layout.

Group and Sort Criteria

The In-Progress Shipment Details Report, Picked has no group criteria or sort
criteria.

Page Break Criteria

The In-Progress Shipment Details Report, Picked has no page break criteria.

In-Progress Shipment Details Report, Packed
This report provides details for shipments that are in Packed status.

Note: The value of Status indicates whether the In-Progress Shipment Details
Report is for shipments that are in Packed status.

The value of status is Packed in the In-Progress Shipment Summary Report for
Packed.

The value of Shipment Mode and Carrier is the same as that of the shipments
whose status you click in the In-Progress Shipment Summary Report.

The fields, layout, group and sort criteria, and page break criteria of this report are
similar to the In-Progress Shipment Details Report, Picked.

In-Progress Shipment Details Report, Manifested
This report provides details for shipments that are in Manifested status.

Note: The value of Status indicates whether the In-Progress Shipment Details
Report is for shipments that are in manifested status.

The value of status is Manifested in the In-Progress Shipment Summary Report for
manifested.

The value of Shipment Mode and Carrier is the same as that of the shipments
whose status you click in the In-Progress Shipment Summary Report.

The fields, layout, group and sort criteria, and page break criteria of this report are
similar to the In-Progress Shipment Details Report, Picked.

In-Progress Shipment Details Report, Shipped
This report provides details for shipments that are in Shipped status.

Note: The value of Status indicates whether the In-Progress Shipment Details
Report is for shipments that are in shipped status.
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The value of status is Shipped in the In-Progress Shipment Summary Report for
manifested.

The value of Shipment Mode and Carrier is the same as that of the shipments
whose status you click in the In-Progress Shipment Summary Report.

The fields, layout, group and sort criteria, and page break criteria of this report are
similar to the In-Progress Shipment Details Report, Picked.

User Productivity Daily Report
The User Productivity Daily Report provides user productivity information on a
daily basis, for a given date range.

Intended Audience

Warehouse managers, inbound supervisors, inventory supervisors, and outbound
supervisors use this report to calculate the efficiency of the users on a daily basis.

Generate a User Productivity Daily Report
About this task

To generate the User Productivity Daily Report:

Procedure
1. Navigate to Task > User Productivity Daily Report. The User Productivity Daily

Report criteria screen appears. For more information about the User
Productivity Daily Report criteria screen, see "User Productivity Daily Report
Criteria".

2. Enter the criteria and click Generate Report to generate the report. The User
Productivity Daily Report appears. For more information about the User
Productivity Daily Report layout, see "User Productivity Daily Report Layout".

User Productivity Daily Report Criteria
The User Productivity Daily Report criteria screen enables you to enter the criteria
for which the User Productivity Daily Report generates.
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Table 56. User Productivity Daily Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report
is generated.

The current node
of the user.

Yes

Date Range Enter the start date and the
end date for which the report
is generated.

You can also click the
icons to choose the date
range.

The current date. Yes

User ID Enter the identifier of the user
for whom the report is
generated.

You can also click to
choose the User ID.

Click to enter more User
IDs. These User IDs are taken
into consideration while
generating the report.

Click to remove a specific
User ID.

Blank No

Average Working
hours Per user Per
day

Enter the number of working
hours for each user each day
for which the report is
generated.

8 Yes

Group and Sort Criteria

The User Productivity Daily Report is grouped by User ID, User Name, and Date
of Execution.

User ID, User Name, and Date of Execution are sorted in ascending order.

Figure 160. User Productivity Daily Report Criteria Screen
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Page Break Criteria

The User Productivity Daily Report has no page break criteria.

Additional Setup Required

To obtain the data required for the User Productivity Daily Report, execute the
MINE_PRODUCTIVITY agent.
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User Productivity Daily Report Layout
This section describes the layout of the User Productivity Daily Report.

Figure 161. User Productivity Daily Report

Chapter 7. Task Reports 347



Field Description

Efficiency (in%)

The efficiency percentage of each user, when different users are considered.

Efficiency is calculated as follows:

Efficiency = (The minutes credited to user based on SAM for all
tasks performed on that day) / ( Average number of hours per user
per day provided as input to the report).

The percentage of efficiency is calculated as follows:

% Efficiency = (Efficiency) / 100

Date

The date for which the report is generated.

User ID (s)

Each user’s identifier is represented by a particular color.

For example, indicates the productivity of the RF User.

Field Description

User ID

The identifier of the user.

User Name

The name of the user.

Date

The date on which the report is generated.

Credited Hrs

Total number of working hours on that date.

Efficiency (in%)

The efficiency percentage of each user.

The User Productivity Daily Report appears in portrait layout.

User Productivity Weekly Report
The User Productivity Weekly Report provides user productivity information on a
weekly basis for a given date range.

Intended Audience

Warehouse managers, inbound supervisors, inventory supervisors, and outbound
supervisors use this report to calculate the efficiency of the users on a weekly
basis.

Generate a User Productivity Weekly Report
About this task

To generate the User Productivity Weekly Report:
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Procedure
1. Navigate to Task > User Productivity Weekly Report. The User Productivity

Weekly Report criteria screen appears. For more information about the User
Productivity Weekly Report criteria screen. see "User Productivity Weekly
Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The User
Productivity Weekly Report appears. For more information about the User
Productivity Weekly Report layout, see "User Productivity Weekly Report
Layout".

User Productivity Weekly Report Criteria
The User Productivity Weekly Report criteria screen enables you to enter the
criteria for which the User Productivity Weekly Report generates.

Table 57. User Productivity Weekly Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report
is generated.

The current node
of the user.

Yes

Date Range Enter the start date and the
end date for which the report
is generated.

You can also click the
icons to choose the date
range.

The previous
week’s date and
current day’s date.

Yes

Figure 162. User Productivity Weekly Report Criteria Screen
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Table 57. User Productivity Weekly Report Criteria Screen (continued)

Field Description Default Value Mandatory

User ID Enter the identifier of the user
for whom the report is
generated.

You can also click to
choose the User ID.

Click to enter more User
IDs. These User IDs are taken
into consideration while
generating the report.

Click to remove a specific
User ID.

Blank. No

Average Working
hours Per User
Per Day

Enter the number of working
hours for each user each day
for which the report is
generated.

8 Yes

Group and Sort Criteria

The User Productivity Weekly Report is grouped by User ID and User Name.

User ID and the User name are sorted in ascending order.

Page Break Criteria

The User Productivity Weekly Report has no page break criteria.

Additional Setup Required

To obtain the data required for the User Productivity Weekly Report, execute the
MINE_PRODUCTIVITY agent.
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User Productivity Weekly Report Layout
This section describes the layout of the User Productivity Weekly Report.

Figure 163. User Productivity Weekly Report
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Field Description

Efficiency (in%)

The efficiency percentage of each user, when different users are considered.

The efficiency is calculated as the number of hours worked divided by
total number of hours.

Year.Week of the Year

The year, and the week in that year, for which the report is generated.

User ID (s)

Each user’s productivity is represented by a particular color.

For example, represents the productivity of the user dc1e1.

Field Description

User ID

The user identifier of the user.

User Name

The name of the user.

Week Begin

The beginning of the week for which the report is generated.

Week End

The end of the week for which the report is generated.

Credited hours

Total number of working hours on that date.

Efficiency (in%)

The efficiency percentage of each user, when different users are considered.

The User Productivity Weekly Report appears in portrait layout.

User Productivity Monthly Report
The User Productivity Monthly Report provides user productivity information on a
monthly basis for a given date range.

Intended Audience

Warehouse managers, inbound supervisors, inventory supervisors, and outbound
supervisors use this report to calculate the efficiency of the users on a monthly
basis.

Generate a User Productivity Monthly Report
About this task

To generate the User Productivity Monthly Report:
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Procedure
1. Navigate to Task > User Productivity Monthly Report. The User Productivity

Monthly Report criteria screen appears. For more information about the User
Productivity Monthly Report criteria screen, see "User Productivity Monthly
Report Criteria".

2. Enter the criteria and click Generate Report to generate the report.The User
Productivity Monthly Report appears. For more information about the User
Productivity Monthly Report layout, see "User Productivity Monthly Report
Layout".

User Productivity Monthly Report Criteria
The User Productivity Monthly Report criteria screen enables you to enter the
criteria for which the User Productivity Monthly Report generates.

Table 58. User Productivity Monthly Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report
is generated.

The current node
of the user.

Yes

Date Range Enter the start date and the
end date for which the report
is generated.

You can also click the
icons to choose the date
range.

The previous
month’s date and
current day’s date.

Yes

Figure 164. User Productivity Monthly Report Criteria Screen
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Table 58. User Productivity Monthly Criteria Screen (continued)

Field Description Default Value Mandatory

User ID Enter the identifier of the user
for whom the report is
generated.

You can also click to
choose the User ID.

Click to enter more User
IDs. These User IDs are taken
into consideration while
generating the report.

Click to remove the
specific User ID.

Blank. No

Average Working
Hours Per User
Per Day

Enter the number of working
hours for each user day for
which the report is generated.

8 Yes

No of Working
Days Per Week

Enter the total number of
working days each week for
each user.

5 Yes

Group and Sort Criteria

The User Productivity Monthly Report is grouped by User ID and User Name.

The User ID and User Name are sorted by ascending order.

Page Break Criteria

The User Productivity Monthly Report has no page break criteria.

Additional Setup Required

To obtain the data required for the User Productivity Monthly Report, execute the
MINE_PRODUCTIVITY agent.
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User Productivity Monthly Report Layout
This section describes the layout of User Productivity Monthly Report.

Figure 165. User Productivity Monthly Report
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,

Field Description

Efficiency (in%)

The efficiency percentage of each user, when different users are considered.

The efficiency is calculated as the number of hours worked divided by
total number of hours.

Year.Month

The year, and the month in that year for which the report is generated.

User ID (s)

Each user’s productivity is represented by a particular color.

For example, represents the productivity of the user dc1e1.

Field Description

User ID

The user identifier of the user.

User Name

The name of the user.

Month Begin Date

The beginning of the month for which the report is generated.

Month End Date

The end of the month for which the report is generated.

Credited hours

Total number of working hours on that date.

Efficiency (in%)

The efficiency percentage of each user, when different users are considered.

The User Productivity Monthly Report appears in portrait layout.

Warehouse Activity Completion Report
The Warehouse Activity Completion Report provides a summary of the different
warehouse tasks that are in "Completed" status. The numbers change as more tasks
get completed. The user can also select only a specific set of task types to view the
activity report.

Intended Audience

Warehouse managers, inbound supervisors, inventory supervisors, and outbound
supervisors use this report to calculate the tasks that are complete. The report is
generated manually.

Generate a Warehouse Activity Completion Report
About this task

To generate the Warehouse Activity Completion Report:

356 Sterling Warehouse Management System: Reports Guide



Procedure
1. Navigate to Task > Warehouse Activity Completion Report. The Warehouse

Activity Completion Report criteria screen appears. For more information about
the Warehouse Activity Completion Report criteria screen, see "Warehouse
Activity Completion Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The
Warehouse Activity Completion Report appears. For more information about
the Warehouse Activity Completion Report layout, see "Warehouse Activity
Completion Report Layout".

Warehouse Activity Completion Report Criteria
The Warehouse Activity Completion Report criteria screen enables you to enter the
criteria for which the Warehouse Activity Completion Report generates.

Table 59. Warehouse Activity Completion Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report
is generated.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

On selecting this,
the current
enterprise of the
user appears as
the user’s default
enterprise.

No

Figure 166. Warehouse Activity Completion Report Criteria Screen
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Table 59. Warehouse Activity Completion Report Criteria Screen (continued)

Field Description Default Value Mandatory

Across Enterprises Choose this to generate the
report considering the user’s
primary enterprise.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Task Completion
Date

Enter the start date and the
end date for which the report
is generated.

You can also click the
icons to choose the date
range.

The current date. Yes

Task Type Check the appropriate task
type.

Check Task Type to check all
task types in the Task Type
area.

Selected. Yes

Group and Sort Criteria

The Warehouse Activity Completion Report is grouped by Task Type and Date.

Task Type is sorted in ascending order and Date is sorted in descending order.

Page Break Criteria

The Warehouse Activity Completion Report has no page break criteria.

Additional Setup Required

There is no additional setup required to generate this report.
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Warehouse Activity Completion Report Layout
This section describes the layout of the Warehouse Activity Completion Report.

Field Description

Task Type

The task for which the report is generated.

Number of Tasks

The number of tasks of the specified task type that is completed on a
particular date.

Quantity

The number of units of the items for which the task type is complete.

Note: The information that appears on this report depends upon the date range
entered in the criteria screen.

If completed task types exist for any date within the date range specified in the
criteria screen, this date, along with the number of task types completed on that
date and the number of units of the item, appear in the report.

The Warehouse Activity Completion Report appears in landscape layout.

Figure 167. Warehouse Activity Completion Report
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Putaway Location Override Report
The Putaway Location Override Report captures all the putaway location overrides
that were done by operators during Putaway. The report also lists the alternate
locations that were used to deposit.

It provides the receiving supervisors with a way to analyze the reasons for
overrides by physically checking the suggested location.

This report also allows the supervisor to analyze the exceptions.

Intended Audience

Receiving supervisor and Warehouse managers use this report to measure the
accuracy of Putaway. The report is generated manually.

Generate a Putaway Location Override Report
About this task

To generate the Putaway Location Override Report:

Procedure
1. Navigate to Task > Putaway Location Override Report. The Putaway Location

Override Report criteria screen appears. For more information about the
Warehouse Activity Completion Report criteria screen, see "Warehouse Activity
Completion Report Criteria".

2. Enter the criteria and click Generate Report to generate the report. The
Putaway Location Override Report appears. For more information about the
Putaway Location Override Report layout, see "Putaway Location Override
Report Layout".

Putaway Location Override Report Criteria
The Putaway Location Override Report criteria screen enables you to enter the
criteria for which the Putaway Location Override Report generates.
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Table 60. Putaway Location Override Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report
is generated.

The current node
of the user.

Yes

Zone Enter the zone for which the
report is generated.

You can also click to
choose the zone.

Click to enter more zones.
These zones are taken into
consideration while
generating the report.

Click to remove a specific
zone.

Blank. No

Execution Time Enter the start date and time
and the end date and time for
which the report is generated.

You can also click the
icons to choose the date range
and time.

Current Date Yes

User ID Enter the identifier of the user
for whom the report is
generated.

Blank No

Exception Code Enter the exception code for
which the report is generated.

Blank No

Figure 168. Putaway Location Override Criteria Screen
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Group and Sort Criteria

The Putaway Location Override Report is grouped by Zone and User Id and the
zone is sorted in ascending order.

For each zone report starts in a new table, the Zone ID is printed on the top of the
table.

Page Break Criteria

For each zone report starts in a new page and new table.

Additional Setup Required

A new Execution Exception Code “TARGET_LOCATION_OVERRIDE” has to be
defined for the Node for which report is generated. This is required as currently
the application allows users to deposit at a different Location with out mandating
the Exception Code. All such overrides have a default Exception Code
“TARGET_LOCATION_OVERRIDE”. So, if you define an Exception Code as
mentioned above and associate it with an appropriate description, the same will be
displayed in the report otherwise the Execution Description field will be empty for
such overrides.
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Putaway Location Override Report Layout
This section describes the layout of the Putaway Location Override Report.

Figure 169. Putaway Location Override Report
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Field Description

User Id

The identifier of the user who executed the task.

Original Deposit LocationId

The original deposit location suggested.

Actual Deposit LocationId

The actual location where the user deposited.

Execution Time

Time of execution.

Task Id

The identifier of the task.

Item Id

The identifier of the item.

Item Description

The description of the item.

LPN No

The identifier of the container.

LPN Type

Container type - Case or Pallet.

Exception Code

A unique code of the execution exception.

Exception Description

The description of the execution exception.

The Putaway Location Override Report appears in landscape layout.
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Chapter 8. Billing Activity Reporting Engine Reports

Billing Activity Report
The Billing Activity Report shows the billable activities performed in the
warehouse for an Enterprise, as captured by the Billing Activity Reporting Engine.

Intended Audience

Warehouse managers, inbound supervisors, outbound supervisors, and enterprise
users use this report to track the activities performed in the warehouse. To access
this report, the user must belong to the data security group representing
warehouse managers, inbound supervisors, outbound supervisors, or enterprise
users.

Generate a Billing Activity Report
About this task

To generate the Billing Activity Report:

Procedure
1. Navigate to ARE > Billing Activity Report. The Billing Activity Report criteria

screen appears. For more information about the Billing Activity Report criteria
screen, see "Billing Activity Report Criteria".

2. Enter the criteria and click Generate Report. The Billing Activity Report
appears. For more information about the Billing Activity Report layout, see
"Billing Activity Report Layout".

Billing Activity Report Criteria
The Billing Activity Report criteria screen enables you to enter the criteria for
which the Billing Activity Report generates.

Figure 170. Billing Activity Report Criteria Screen
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Table 61. Billing Activity Report Criteria Screen

Field Description Default Value Mandatory

Node The node for which the report
is generated.

If you are an enterprise user,
select the appropriate node
from the drop-down list. For
other users, the current node
of the user appears.

The current node
of the user.

Yes

Enterprise Choose this to generate the
report for a specific enterprise
and select the enterprise name
from the drop-down list.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Not Selected.

Upon selecting
this, the current
enterprise of the
user appears as
the default
enterprise.

No

Across Enterprises Choose this to generate the
report considering all
enterprises.

Note: It is mandatory to select
any one of the radio buttons
to execute the report.

Selected. No

Group ID Select the identifier of the
billing activity group from the
drop down menu list.

Selected. Yes

Activity Date
Range

Enter the date range for
which the billing activity
report is generated.

You can also click the icon
to choose the date.

The current date. Yes

Group and Sort Criteria

The Billing Activity Report has no group and sort criteria.

Page Break Criteria

The Billing Activity Report has no page break criteria.

Additional Setup Required

There is no additional setup required to generate this report.
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Billing Activity Report Layout
This section describes the layout of the Billing Activity Report.

Figure 171. Billing Activity Report
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Field Description

Activity Code

Indicates the unique code of the billing activity performed in the
warehouse.

Activity Name

Indicates the name of the billing activity performed in the warehouse.

Group ID

Indicates the identifier of the billing activity group to which the billing
activity belongs.

For example, Group ID can be Misc, Stor, Tran, and Hand.

Service Quantity

Indicates the quantity for which the billing activity was performed.

Service UOM

Indicates the unit of measure of the billing activity.

Service Charge

Indicates the service charged for performing the billing activity.

Currency

Indicates the currency in which the cost is recorded.

The Billing Activity Report appears in portrait layout.

368 Sterling Warehouse Management System: Reports Guide



Chapter 9. Using Report Studio

Report Studio
Cognos 8 BI 8.4 is a Cognos application that is used as a module in the Sterling
Selling and Fulfillment Foundation to produce and maintain user reports for
Web-based distribution, scheduling, and maintenance. This tool produces reports in
25 languages and seven formats.

Cognos 8 BI 8.4 has two areas for creating reports, Report Studio and Query
Studio. Query Studio is used for creating ad hoc reports that are used one time,
cannot be maintained and have no shelf life. Report Studio is used for reports that
remain in the system, is scheduled and routed, and are customizable and reusable.
This chapter contains information for users of Report Studio. Query Studio is
documented in the Cognos 8 BI 8.4 User Guide.

Selling and Fulfillment Foundation has provided fifteen reports for Sterling
Warehouse Management System that can be used "as is". These reports are used as
starter templates for developers fluent in creating and maintaining reports using
Cognos 8 BI 8.4.

This topic provides basic information for using Report Studio, utilizing the Sterling
Warehouse Management System reports and customizing those reports for your
application. Use the documentation set provided on the Cognos CD-ROM or at the
Cognos Web site at http://www.cognos.comwww.cognos.com for additional
information about creating and maintaining reports using the Cognos 8 BI 8.4
applications, including Report Studio, Query Studio, and Framework Manager.

Report Studio is used for creating, maintaining, scheduling, and routing reports
detailing every aspect of the Warehouse Management System. Specifications for a
report are created in Report Studio or Query Studio. When you need to edit saved
reports you must use Report Studio as Query Studio is not used for editing after a
report has been saved.

Report specifications are viewed from the Tools menu by selecting Show
Specifications. These specifications are an XML document. When you run a report,
information from the report specifications, the model metadata, and report
properties are combined. These three items define the content, format and
appearance of the resulting report.

Data displayed in a report is defined by the built in query the report runs. Report
Studio maintains a default query for each stored report. Additional data items are
combined with the default query. You can create additional queries in single report.
Calculations and Summaries can also be added to your report.

The authoring components of Query Studio and Report Studio, produce the
required specifications for a report. However, additional information is obtained
from other Cognos 8 BI 8.4 resources running in the background. The main content
of the report is generated from several data sources through the published model.
Additional information comes form calculations and background reports. Cognos 8
BI 8.4 also contributes a small amount of information for reports.
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Report output is produced when you run a report the first time. The results are
stored in Cognos 8 BI 8.4. This version of the report is used to create similar
reports multiple formats. Available formats include PDF, XML, HTML, XHTML,
XLS (Excel) or CSV. Report users with proper authority can create, save, and
schedule their own views of a report.

Sterling Reports
Selling and Fulfillment Foundation provides fifteen standard reports in the report
studio for the Sterling Warehouse Management System application. These reports
can be used "as is" or you can customize them using Report Studio. The reports
can also be used as templates for the creation of your own reports. To open a
Sterling Warehouse Management System report in Report Studio select Open from
the File menu. The Open dialog box displays. Select WMS. Double click on the
report you need and the report opens Report Studio.

View a Sterling Warehouse Management System Report
About this task

This procedure is used start up the Cognos Report Studio and then display a
Sterling Warehouse Management System report.

Procedure
1. Select Report Studio from the Sterling Analytics Connection screen. Report

Studio displays.

2. Select Open an Existing Report, the Open dialog box displays.

Figure 172. Welcome Dialog Box
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3. Select WMS, a list of WMS reports displays.

4. Double click on the report you need. The Report displays in Report Studio.

Figure 173. Open Dialog Box

Figure 174. WMS Report List
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Report Studio User Interface
The Report Studio user interface screen has a work area, an Explorer bar and two
side panes:
v Insert Objects Pane - This area contains objects that are used to create a report.

They include the model tab, query items and calculations.
v Properties Pane - This pane contains selectable object properties.
v Explorer Bar - Contains commands used to create and edit a report.
v Work Area - This is where you design a report.

Report Structure
Reports have two components, a layout component that defines the report
appearance and a query component that defines the data included in the report A
layout is used to present the data in an orderly fashion with respect to lists, charts
and crosstabs. The report should be laid out in a manner where the data is allowed
to flow freely from one page to the next page. Borders, color, and images are used
to enhance the appearance of the report but a greater importance should be placed
on the manner in which the data is viewed by the user.

Figure 175. Report Studio
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Pages contain the objects used to build a report. Pages should have, at a minimum,
a header, a body and a footer. When the amount of data in a report exceeds one
page, the primary page, the one you created, repeats for all additional data. You
control the flow from page to page.

Objects are lists, charts, text blocks, and other layout items that are added during
the creation of a page. Queries determine the data items that appear in the report.
Most data can be obtained by using the SELECT statement. You can also calculate
data and then display the calculation results, rather than the data columns used to
produce the calculation.

Creating a Report
Creating a report is actually the process of creating a specification. The
specification defines prompts and queries used to produce the data. The
specification defines the layout and style used to present the data.

When starting out, use the reports supplied by the Selling and Fulfillment
Foundation as a template, then make changes required and save the result using a
different name. This process simplifies the creation and saves time. Selling and
Fulfillment Foundation supplies a number of reports that are documented in the
manual.

Creating a report involves:
v Specifying a Package - The package used to produce reports are the models that

are created in Framework Manager. A model is a set of related query subjects
and other objects such as filters and calculations.

v Choosing a Template - You can select a predefined template that has been
formatted for a specific report type. You can also use one of the reports provided
by the Selling and Fulfillment Foundation.

v Adding Query Items - Adding data means selected query items that are required
to produce the report data.

v Saving a Report - A report can be save to an individual computer or to the
Cognos 8 BI 8.4 server

v Running the Report - Run a report to determine if the data you selected is the
data that is being returned. A report can also run from the Cognos connection.

Rules for Creating New Reports
v Do not modify the Sterling Analytics package standard in the Sterling

Warehouse Management System. This allows for upgrades to be applied to the
standard reports.

v To add new reports, open the Sterling Analytics package model in Framework
Manager. Rename the package name to something else like Sterling-
NEWNAME-Analytics. Save this package and publish it in the content
repository.

v After publishing the package you can see a new package folder named
Sterling-NEWNAME-Analytics along with the previous Sterling-Analytics on
Cognos Connection. All new reports should be added onto this new package.
Any changes to the model should also be made to this package. If you adds new
views or modify existing views, this is done in the new package
"Sterling-NEWNAME-Analytics" in Framework Manager.
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Save a Report
Procedure
1. Select Save from the File menu.
2. Select Save As to file the report under a different name, thus creating a second

report.
3. Specify where you want the report to exist.
4. Select Save.

Run a Report
Procedure
1. Open the report you want to run
2. Select Validate Report from the Tools menu
3. Read the message box that details report errors.
4. Select Run options from the RUn menu to set the options required.
5. Select a format from the Run menu

Results

The report runs in the Report Viewer window. When the report has finished
running you can rerun it in a different format if required.

Print a Report
Procedure
1. Select Page Setup from the File menu.
2. Set your page options.
3. Select Print from the File menu.
4. Select your print options.
5. Select OK.

Creating a Template
You can create your own custom template in Report Studio. Do this when you are
going to produce a number of reports of the same type. To create a report
template, create a new report. An existing report can also be used as a new
template.

A template contains the following items:
v Header
v Footer
v Text
v Images
v Variables such as date, page numbers
v Placeholders

Avoid using query items, calculations or filters in a template. These items are
package dependant and should not be used globally. Errors occur in reports that
are created with templates containing these items.

Managing Reports
After creating a few reports you are ready to manage the reports for distribution.
The following features are available in Cognos Connection for report management:
v Scheduling
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v Distribution printing
v Language changes
v Set prompts
v Report history maintenance
v Version control

Information detailing these tasks is maintained in the Cognos 8 BI 8.4 User Guide.
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The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
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incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

J46A/G4

555 Bailey Avenue

San Jose, CA 95141-1003

U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.
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This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© IBM 2012. Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. 2012.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at http://www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.
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Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are
trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise®, Gentran®,
Gentran®:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Realtime®, Gentran:Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce™, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks
of others.
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